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DISCLAIMER

CONSIDERABLE TIME, EFFORT AND EXPENSE HAVE GONE INTO THE
DEVELOPMENT AND DOCUMENTATION OF THIS SOFTWARE. HOWEVER,
THE USER ACCEPTS AND UNDERSTANDS THAT NO WARRANTY IS
EXPRESSED OR IMPLIED BY THE DEVELOPERS OR THE DISTRIBUTORS ON
THE ACCURACY OR THE RELIABILITY OF THIS PRODUCT.

THIS PRODUCT IS A PRACTICAL AND POWERFUL TOOL FOR STRUCTURAL
DESIGN. HOWEVER, THE USER MUST EXPLICITLY UNDERSTAND THE BASIC
ASSUMPTIONS OF THE SOFTWARE MODELING, ANALYSIS, AND DESIGN
ALGORITHMS AND COMPENSATE FOR THE ASPECTS THAT ARE NOT
ADDRESSED.

THE INFORMATION PRODUCED BY THE SOFTWARE MUST BE CHECKED BY
A QUALIFIED AND EXPERIENCED ENGINEER. THE ENGINEER MUST
INDEPENDENTLY VERIFY THE RESULTS AND TAKE PROFESSIONAL
RESPONSIBILITY FOR THE INFORMATION THAT IS USED.
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Chapter 1
Introduction

The design/check of steel frames is seamlessly integrated within the program.
Initiation of the design process, along with control of various design parame-
ters, is accomplished using the Design menu. Automated design at the object
level is available for any one of a number of user-selected design codes, as
long as the structures have first been modeled and analyzed by the program.
Model and analysis data, such as material properties and member forces, are
recovered directly from the model database, and are used in the design process
in accordance with the user defined or default design settings. As with all de-
sign applications, the user should carefully review all of the user options and
default settings to ensure that the design process is consistent with the user’s
expectations. The AISC 360-05/IBC 2006 steel frame design options include
the use of the Direct Analysis Method. The software is well suited to make use
of the Direct Analysis Method because it can capture the second-order P-Delta
and P-¢ effects, provided the user specifies that a nonlinear P-Delta analysis be
performed.

It should be noted that two design processes are available in CSiBridge: super-
structure design (on the Design/Rating tab) and design of the individual ele-
ments comprising the structure (the Advanced > Frame Design commands).
This manual addresses the second design process.

Chapter 2 addresses prerequisites related to modeling and analysis for a suc-
cessful design in accordance with "AISC 360-05/IBC 2006.” Chapter 3 pro-

1-1
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vides detailed descriptions of the specific requirements as implemented in
”AISC 360-05/IBC 2006.” Chapter 4 provides detailed descriptions of the spe-
cific requirements for seismic loading as required by the specification in AN-
SI/AISC 341-05 code. The appendices provide details on various topics
referenced in this manual. The user also should review the AISC Direct Analy-
sis Method Practical Guide.

Load Combinations and Notional Loads

The design is based on a set of user-specified loading combinations. However,
the program provides default load combinations for each supported design
code. If the default load combinations are acceptable, no definition of addition-
al load combinations is required. The Direct Analysis Method requires that a
notional load, N = 0.002Y; , where Y; is the gravity load acting at level i, be
applied to account for the destabilizing effects associated with the initial imper-
fections and other conditions that may induce sway not explicitly modeled in
the structure. The user must be aware that notional loads must be defined and
assigned by the user. Currently, the software creates design combinations that
include notional loads and gravity loads only. If the user needs notional loads
that include combinations containing lateral loads, the user must define such
combinations manually. The automation of combinations, including notional
loads, is currently limited to gravity loads only. Design load combinations of
notional loads acting together with lateral loads currently are NOT automated
by the software.

Stress Check

Steel frame design/check consists of calculating the flexural, axial, and shear
forces or stresses at several locations along the length of a member, and then
comparing those calculated values with acceptable limits. That comparison
produces a demand/capacity ratio, which typically should not exceed a value of
one if code requirements are to be satisfied. The program follows the same
review procedures whether it is checking a user-specified shape or a shape
selected by the program from a predefined list. The program also checks the
requirements for the beam-column capacity ratio, checks the capacity of the

Load Combinations and Notional Loads



Chapter 1 Introduction

panel zone, and calculates the doubler plate and continuity plate thickness, if
needed. The program does not do the connection design. However, it calculates
the design basis forces for connection design.

Program output can be presented graphically on the model, in tables for both
input and output data, or in calculation sheets prepared for each member. For
each presentation method, the output is in a format that allows the engineer to
quickly study the stress conditions that exist in the structure, and in the event
the member is not adequate, aid the engineer in taking appropriate remedial
measures, including altering the design member without re-running the entire
analysis.

The program supports a wide range of steel frame design codes, including
many national building codes. This manual is dedicated to the use of the menu
option "AISC 36005/IBC 2006.” This option covers the "ANSI/AISC 360-05
Specification for Structural Steel Buildings” (AISC 20054, b), and the "ANSI/
AISC 341-05 Seismic Provisions for Structural Steel Buildings Including Sup-
plement No. 1” (AISC 2005c) codes.

The implementation covers loading and load combinations from ”ASCE/SEI
705 Minimum Design Loads for Buildings and Other Structures” (ASCE
2005), and also special requirements from ”IBC 2006 International Building
Code” (IBC 2006). Both LRFD (Load and Resistance Factor Design) and ASD
(Allowable Strength Design) codes are included in this implementation under
the same ”AISC 360-05/IBC 2006 code name. The LRFD and ASD are avail-
able as two options in the program’s preferences feature. In both cases, the
strengths are calculated in the nominal levels. The phi (LRFD) and Omega
(ADS) factors are applied during calculation of demand/capacity ratios only.
The design codes supported under ”AlISC 360-05/IBC 2006 are written in Kip-
inch units. All the associated equations and requirements have been imple-
mented in the program in kip-in units. The program has been enabled with unit
conversion capability. This allows the users to enjoy the flexibility of choosing
any set of consistent units during creating and editing models, exporting and
importing the model components, and reviewing the design results.

Stress Check 1-3
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Direct Analysis Method vs. Effective Length
Method

The Direct Analysis Method described in AISC 360-05/IBC 2006, Appendix 7,
is substantially different from previous design methods supported by AISC.
The user should be knowledgeable about the Stability Analysis and Design
(Chapter C) requirements and the requirements pertaining to consideration of
the geometric imperfections, stiffness reductions, and the P-A and P-6 effects.
Several methods for consideration of the second-order effects are available to
the users. Each of these are described in detail in a subsequent section (see
User Options in this chapter) and in the Steel Frame Design Preferences,
Appendix B of this manual. Alternatively, if the user desires to use a more
traditional design method, the Effective Length method can be specified using
the Design Preferences.

Effective Length Method

For structures exhibiting small second-order effects, the effective length
method may be suitable. The effective length approach relies on two main
assumptions, namely, that the structural response is elastic and that all columns
buckle simultaneously. The effective length method also relies on a calibrated
approach to account for the differences between the actual member response
and the 2nd-order elastic analysis results. The calibration is necessary because
the 2nd-order elastic analysis does not account for the effects of distributed
yielding and geometric imperfections. Since the interaction equations used in
the effective length approach rely on the calibration corresponding to a 2nd-
order elastic analysis of an idealized structure, the results are not likely
representative of the actual behavior of the structure. However, the results are
generally conservative. In the AISC 360-05/IBC 2006 code, the effective
length method is allowed provided the member demands are determined using
a second-order analysis (either explicit or by amplified first-order analysis) and
notional loads are included in all gravity load combinations. K-factors must be
calculated to account for buckling (except for braced frames, or where
A2 /A1<1.0,K=1.0)

Direct Analysis Method vs. Effective Length Method
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1.3.2

1.4

Direct Analysis Method

The Direct Analysis Method is expected to more accurately determine the
internal forces of the structure, provided care is used in the selection of the
appropriate methods used to determine the second-order effects, notional load
effects and appropriate stiffness reduction factors as defined in AISC 2.2, App.
7.3(3). Additionally, the Direct Analysis Method does not use an effective
length factor other than k = 1.0. The rational behind the use of k = 1.0 is that
proper consideration of the second-order effects (P-A and P-8), geometric
imperfections (using notional loads) and inelastic effects (applying stiffness
reductions) better accounts for the stability effects of a structure than the earlier
Effective Length methods.

User Options

In addition to offering ASD and LRFD design, the Design Options menu pro-
vides seven analysis methods for design, as follows:

= General Second Order Elastic Analysis (AISC C2.2a)
= Second Order Analysis by Amplified First Order Analysis (AISC C2.1b)
= Limited First Order Elastic Analysis (AISC 2.2b, App. 7.3(1))

= Direct Analysis Method with General Second Order Analysis and Variable
Factor Stiffness Reduction (AISC 2.2, App. 7.3(3))

= Direct Analysis Method with General Second Order Analysis and Fixed
Factor Stiffness Reduction (AISC 2.2, App. 7.3(3))

= Direct Analysis Method with Amplified First Order Analysis and Variable
Factor Stiffness Reduction (AISC 2.2, App. 7.3(3))

= Direct Analysis Method with Amplified First Order Analysis and Fixed
Factor Stiffness Reduction (AISC 2.2, App. 7.3(3))

These options are explained in greater detail in Chapter 2. The first three op-
tions make use of the effective length approach to determine the effective
length factors, K. The four options available for the Direct Design Method dif-

User Options  1-5
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fer in the use of a variable or fixed stiffness reduction factor and the method
used to capture the second-order effects. All four Direct Analysis Methods op-
tions use an effective length factor, K = 1.0.

1.5 Non-Automated Items in the AISC 360-05/IBC
2006 Steel Frame Design

Currently, the software does not automate the following:
= Notional loads combinations that include lateral wind and quake loads

= The validity of the analysis method. The user must verify the suitability of
the specified analysis method used under the User Options described in the
preceding sections. The AISC code requires, for instance, that the Direct
Analysis Method be used when a ratio of the second order displacements to
the first order displacements exceeds 1.5. This check currently must be
performed by the user.

= P-A analysis. Since many different codes are supported by the software and
not all require a P-A analysis, the user must specify that a P-A analysis be
performed during the analysis phase so that the proper member forces are
available for use in the design phase. See the AISC Direct Analysis Method
Practical Guide for additional information.

1-6  Non-Automated Items in the AISC 360-05/IBC 2006 Steel Frame Design
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Chapter 2
Design Algorithms

This chapter provides an overview of the basic assumptions, design precondi-
tions, and some of the design parameters that affect the design of steel frames.

For referring to pertinent sections of the corresponding code, a unique prefix is
assigned for each code.

» Reference to the ANSI/AISC 360-05 code is identified with the prefix
"AISC."

» Reference to the ANSI/AISC 341-05 code is identified with the prefix
"AISC SEISMIC" or sometimes "SEISMIC" only.

* Reference to the ASCE/SEl 7-05 code is identified with the prefix
"ASCE."

» Reference to the IBC 2006 code is identified with the prefix "IBC."

Check and Design Capability

The program has the ability to check adequacy of a section (shape) in accord-
ance with the requirements of the selected design code. Also the program can
automatically choose (i.e., design) the optimal (i.e., least weight) sections from
a predefined list that satisfies the design requirements.
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To check adequacy of a section, the program checks the demand/capacity
("DIC") ratios at a predefined number of stations for each design load combina-
tion. It calculates the envelope of the D/C ratios. It also checks the other re-
quirements on a pass or fail basis. If the capacity ratio remains less than or
equal to the D/C ratio limit, which is a number close to 1.0, and if the section
passes all the special requirements, the section is considered to be adequate,
else the section is considered to be failed. The D/C ratio limit is taken as 0.95
by default. However, this value can be overwritten in the Preferences (see
Chapter 3).

To choose (design) the optional section from a predefined list, the program first
orders the list of sections in increasing order of weight per unit length. Then it
starts checking each section from the ordered list, starting with the one with
least weight. The procedure of checking each section in this list is exactly the
same as described in the preceding paragraph. The program will evaluate each
section in the list until it finds the least weight section that passes the code
checks. If no section in the list is acceptable, the program will use the heaviest
section but flag it as being overstressed.

To check adequacy of an individual section, the user must assign the section
using the Assign menu. In that case, both the analysis and design sections will
be changed.

To choose the optimal section, the user must first define a list of steel sections,
the Auto Select sections list. The user must next assign this list, in the same
manner as any other section assignment, to the frame members to be opti-
mized. The program will use the median section by weight when doing the ini-
tial analysis. Check the program Help for more information about defining and
assigning Auto Select Section lists.

Design and Check Stations

For each design combination, steel frame members (beams, columns, and
braces) are designed (optimized) or checked at a number of locations (stations)
along the length of the object. The stations are located at equally spaced
segments along the clear length of the object. By default, at least three stations
will be located in a column or brace member, and the stations in a beam will be
spaced at most 2 feet apart (0.5 m if the model has been created in metric

Design and Check Stations
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units). The user can overwrite the number of stations in an object before the
analysis is run and refine the design along the length of a member by request-
ing more stations. Refer to the program Help for more information about
specifying the number of stations in an object.

Demand/Capacity Ratios

Determination of the controlling demand/capacity (D/C) ratios for each steel
frame member indicates the acceptability of the member for the given loading
conditions. The steps for calculating the D/C ratios are as follows:

The factored forces are calculated for axial, flexural, and shear at each de-
fined station for each design combination. The bending moments are calcu-
lated about the principal axes. For I-Shape, Box, Channel, T-Shape, Dou-
ble-Angle, Pipe, Circular, and Rectangular sections, the principal axes co-
incide with the geometric axes. For Single-Angle sections, the design con-
siders the principal properties. For General sections, it is assumed that all
section properties are given in terms of the principal directions.

For Single-Angle sections, the shear forces are calculated for directions
along the geometric axes. For all other sections, the program calculates the
shear forces along the geometric and principal axes.

The nominal strengths are calculated for compression, tension, bending
and shear based on the equations provided later in this manual. For flexure,
the nominal strengths are calculated based on the principal axes of bend-
ing. For the 1-Shape, Box, Channel, Circular, Pipe, T-Shape, Double-Angle
and Rectangular sections, the principal axes coincide with their geometric
axes. For the Angle sections, the principal axes are determined and all
computations related to flexural stresses are based on that.

The nominal strength for shear is calculated along the geometric axes for
all sections. For 1-Shape, Box, Channel, T-Shape, Double-Angle, Pipe,
Circular, and Rectangular sections, the principal axes coincide with their
geometric axes. For Single-Angle sections, principal axes do not coincide
with the geometric axes.

Demand/Capacity Ratios 2 -3
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= Factored forces are compared to nominal strengths to determine D/C ratios.
In either case, design codes typically require that the ratios not exceed a
value of one. A capacity ratio greater than one indicates a member that has
exceeded a limit state.

Design Load Combinations

The design load combinations are the various combinations of the prescribed
load cases for which the structure needs to be checked. The program creates a
number of default design load combinations for steel frame design. Users can
add their own design combinations as well as modify or delete the program
default design load combinations. An unlimited number of design load combi-
nations can be specified.

To define a design load combination, simply specify one or more load cases,
each with its own scale factor. The scale factors are applied to the forces and
moments from the load cases to form the factored design forces and moments
for each design load combination.

For normal loading conditions involving static dead load (DL), live load (LL),
roof live load (RL), snow load (SL), wind load (WL), earthquake load (EL),
notional load (NL), and dynamic response spectrum load (EL), the program has
built-in default design combinations for the design code. These are based on
the code recommendations.

The default design combinations assume all load cases declared as dead or live
to be additive. However, each load case declared as wind, earthquake, or
response spectrum cases, is assumed to be non-additive with other loads and
produces multiple lateral combinations. Also static wind, earthquake and
notional load responses produce separate design combinations with the sense
(positive or negative) reversed. The notional load patterns are added to load
combinations involving gravity loads only.

For other loading conditions involving moving load, time history, pattern live
load, separate consideration of roof live load, snow load, and the like, the user
must define the design load combinations in lieu of or in addition to the default
design load combinations. If notional loads are to be combined with other load
combinations involving wind or earthquake loads, the design load combina-

Design Load Combinations



Chapter 2 Design Algorithms
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tions need to be defined in lieu of or in addition to the default design load com-
binations.

For multi-valued design combinations, such as those involving response spec-
trum, time history, moving loads and envelopes, where any correspondence
between forces is lost, the program automatically produces sub-combinations
using the maxima/minima values of the interacting forces. Separate combina-
tions with negative factors for response spectrum load cases are not required
because the program automatically takes the minima to be the negative of the
maxima response when preparing the sub-combinations described previously.

The program allows live load reduction factors to be applied to the member
forces of the reducible live load case on a member-by-member basis to reduce
the contribution of the live load to the factored responses.

Second Order P-Delta Effects

The AISC 360-05/IBC 2006 steel frame design options include the use of the
Direct Analysis Method. The software is well suited to make us of the Direct
Analysis Method because each program can capture the second-order P-A and
P-6 effects, provided the user specifies that a nonlinear P-Delta analysis be per-
formed.

Second Order P-Delta Effects 2-5
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translation, A, shown by
dashed line 5

Figure 2-1 System sway and element order effects

For a detailed discussion of the program capabilities and limitations, see
Appendix A.

Analysis Methods

The code requires that stability shall be provided for the structure as a whole
and for each of the elements. Any method of analysis that considers the influ-
ence of second order effects of P-4 and P-5, geometric imperfections, out-of-
plumbness, and member stiffness reduction due to residual stresses are permit-
ted by the code. The effects of geometric imperfection and out-of-plumbness
generally are captured by the use of notional loads. The effect of axial, shear
and flexural deformations and the effects of residual stresses on the member
stiffness reduction has been considered in a specialized method called "Direct
Analysis Method." This method can come in different incarnations (formats)
according to the choice of the engineer as allowed in the code.

The program offers the user seven analysis options for design:

Direct Analysis Method

Analysis Methods



Chapter 2 Design Algorithms

e General Second Order Elastic Analysis with
7, Variable (user option 1, Default)
o fixed (user option 2)
o Amplified First Order Elastic Analysis with
7, Variable (user option 3)
o fixed (user option 4)
Equivalent Length Method
e General Second Order Elastic Analysis (AISC C2.1a) (user option 5)
o Amplified First Order Elastic Analysis (AISC C2.1b)  (user option 6)
Limited First-Order Analysis (AISC 2.2b, App. 7.3(1)) (user option 7)

A summary of all of the user options and requirements is provided in
Table 2-1. The main difference between the various options concerns the use of
the Direct Analysis Method or the Equivalent Length Method. Within each of
the categories, the user can choose the method to calculate the second-order
effects, namely, by a General Second Order Analysis or an Amplified First-
Order Analysis. When the amplified first-order analysis is used, the force
amplification factors, B, andB, (AISC C2.1b), are needed. The B, factor is
calculated by the program; however, the B, factor is not. The user will need to

provide this value using the overwrite options that are described in Appendix
B.

When the user selects one of the options available under the Direct Analysis
Method, the user must further choose how the stiffness reduction factors for
El and AE are to be considered. For options 1 and 3, Table 2-1, the stiffness
reduction factors (z,) are variable because they are functions of the axial force
in the members, while for methods 2 and 4, the stiffness reduction factors are
fixed (0.8), and not a function of axial force. If the user desires, the stiffness
reduction factors (z,) can be overwritten. When options 2 and 4 are used, a
higher notional load coefficient (0.003) must be used compared to methods 1
and 3 for which the notional load coefficient is 0.002. Also, all the direct anal-
ysis methods (methods 1 through 4) allow use of K -factors for sway condition

Analysis Methods 2-7
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(K,) to be equal to 1, which is a drastic simplification over the other effective

length method.

The AISC requirements to include notional loads are also summarized in Table
2-1. The notional load coefficients (AISC C2.2a, App. 7.3) are summarized as
well. The program automates creation of notional load combinations for all
gravity loads but does not automate the creation of notional load combinations
that include lateral wind or seismic loads. Combinations for notional loads with
lateral loads are required for the Direct Analysis Method when the 4, , /4,

exceeds 1.5. Additionally, combinations for notional loads with lateral loads
are required if the Limited First Order Analysis, option 7, is used.

The Limited First Order Analysis, option 7, does not include the secondary
P-4 and P-s effects. This method has very limited applicability and might be
appropriate only when the axial forces in the columns are very small compared

to their Euler buckling capacities.

When using the LRFD provision, the actual load combinations are used for
second order P-A effects. When using the ASD provision, the load combina-
tions are first amplified by 1.6 before the P-A analysis and then the results are
reduced by a factor of (1/1.6) (AISC 2.2a, App. 7.3).

Table 2-1 The Essentials and Limitations of the Design Analysis Methods

Direct Analysis Method

Option Variable L|m|t'at|or'1.or Essentials of the Method
Applicability
2nd Order Analysis
Reduced stiffness
EI* =0.87,El
EA* =0.8EA
10 for Y <05
PY
Variable r =
General Second . o b aP aP aP
. Factor Stiffness No limitation 4 2 || 1-Z0 | for ZZ=>05
Order Analysis . =) p p
Reduction y y y
B, and B, not used
K, =1 (used for P,)
Notional load with all combos, except for 4, ,/4,, <15 for
which notional load with gravity combos only
Notional load coefficient = 0.002 (typically)
2-8 Analysis Methods
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Table 2-1 The Essentials and Limitations of the Design Analysis Methods

Direct Analysis Method

Option

Variable

Limitation or
Applicability

Essentials of the Method

Fixed Factor
Stiffness
Reduction

No limitation

2nd Order Analysis
Reduced stiffness

EI* =0.87,El
EA*=0.8EA
7, =10
B, and B, not used
K, =1 (used for P,)
Notional load with all combos, except for 4, /4, <1.5

for which notional load with gravity combos only
Notional load coefficient = 0.003 (typically)

Amplified First
Order Analysis

Variable
Factor Stiffness
Reduction

No limitation

1st Order Analysis
Reduced Stiffness

El* =0.8,El
EA* =0.8EA

1.0 for “PR <05

y

Ty, =
4 _aR 1__aP, for _aR >0.5
P P P

y y y

K, =1for B,
K, =1for P, and B,
Notional load with all combos, except for 4, /4, <1.5

for which notional load with gravity combos only
Notional load coefficient = 0.002 (typically)

Amplified First
Order Analysis

Fixed Factor
Stiffness
Reduction

No limitation

2nd Order Analysis
Reduced stiffness

El* =0.87,El
EA*=0.8EA
7,=1.0
K, =1 (used for P,)
Notional load with all combos, except for 4, ,/4,, <1.5

for which notional load with gravity combos only
Notional load coefficient = 0.003 (typically)

Effective Length Method
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Table 2-1 The Essentials and Limitations of the Design Analysis Methods

Direct Analysis Method

General Second
Order Elastic

st

(for all stories)

Option Variable L|m|t'at|or'1.or Essentials of the Method
Applicability
Option L|m|t_at|on'or Essentials of the Method
Applicability
Ay <15 2nd Order Analysis

Unreduced Stiffness
K =K, (used for P,)
Notional load with gravity combos only

y

(for all columns)

) ok _ any Notional load coefficient = 0.002 (typically)
Analysis P, B =1
(for all columns) B, =1
Ay 1st Order Analysis
—==<15 Unreduced stiffness
st
(for all stories) K, for B,
Amplified First P _ K, for B,
Order Analysis P, -av K =K, (used for P,)
(for all columns) Notional load with gravity combos only
Notional load with coefficient = 0.002 (typically)
Use of B, and B,
Limited First Order Analysis
4, 1st Order Analysis
—<15 Unreduced stiffness
st
Limited First (fOI’ all StOI’iES) ) Kz for Pn '(not Bz)
Order Elastic P Notional load with all combos
Analysis ——<05

Notional load with coefficient = (2)(%] >0.0042

The program has several limitations that have been stated in Section 1-5 and
the preceding paragraphs. Additionally, the user must be aware that it is possi-
ble to choose a design option that violates certain provisions of the AISC code
that will not be identified by the program. The limitation for the use of the

aP

. . A
effective length method, namely, the requirement that =2 <1.5 and —— must

1st e
be verified by the user. To assist users to in making validity checks, the ratio
aP,

and t are now reported in tabular form for each member.

e

2-10 Analysis Methods
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2.8

Notional Load Patterns

Notional loads are lateral loads that are applied at each framing level and are
specified as a percentage of the gravity loads applied at that level. They are
intended to account for the destabilizing effects of out-of-plumbness, geometric
imperfections, inelasticity in structural members, and any other effects that
could induce sway and that are not explicitly considered in the analysis.

The program allows the user to create a Notional Load pattern as a percentage
of the previously defined gravity load pattern to be applied in one of the global
lateral directions: X or Y. The user can define more than one notional load
pattern associated with one gravity load by considering different factors and
different directions. In the ANSI/AISC 360-05 code, the notional loads are
typically suggested to be 0.2% (or 0.002) (AISC C2.2a, App. 7.3(2)), a factor
referred to as the notional load coefficient in this document. The notional load
coefficient can be 0.003 (AISC App 7.3(3)). In some cases, it can be a function
of second order effects measured by relative story sway (AISC C2.26). The
code also gives some flexibility to allow the engineer-of-record to apply
judgment (AISC App. 7.3(2)).

The notional load patterns should be considered in combination with appropri-
ate factors, appropriate directions, and appropriate senses. Some of the design
analysis methods need the notional loads to be considered only in gravity load
combinations (AISC App. 7.3(2)), and some of the methods need the notional
loads to be considered in all the design load combinations (AISC App 7.3(2)).
For a complete list, see Table 2-1 in the preceding "Second Order Effects and
Analysis Methods" section of this chapter.

Currently, the notional loads are not automatically included in the default
design load combinations that include lateral loads. However, the user is free to
modify the default design load combinations to include the notional loads with
appropriate factors and in appropriate load combinations.

Member Unsupported Lengths

The column unsupported lengths are required to account for column
slenderness effects for flexural buckling and for lateral-torsional buckling. The

Notional Load Patterns 2 - 11
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program automatically determines the unsupported length ratios, which are
specified as a fraction of the frame object length. These ratios times the frame
object lengths give the unbraced lengths for the member. These ratios can also
be overwritten by the user on a member-by-member basis, if desired, using the
overwrite option.

Two unsupported lengths, 133 and 1,,, as shown in Figure 2-2 are to be
considered for flexural buckling. These are the lengths between support points
of the member in the corresponding directions. The length I3 corresponds to
instability about the 3-3 axis (major axis), and I, corresponds to instability
about the 2-2 axis (minor axis). The length I 1g,not shown in the figure, is

also used for lateral-torsional buckling caused by major direction bending (i.e.,
about the 3-3 axis).

In determining the values for I,, and I33 of the members, the program recog-
nizes various aspects of the structure that have an effect on these lengths, such
as member connectivity, diaphragm constraints and support points. The pro-
gram automatically locates the member support points and evaluates the corre-
sponding unsupported length.

It is possible for the unsupported length of a frame object to be evaluated by
the program as greater than the corresponding member length. For example,
assume a column has a beam framing into it in one direction, but not the other,
at a floor level. In this case, the column is assumed to be supported in one
direction only at that story level, and its unsupported length in the other direc-
tion will exceed the story height.

By default, the unsupported length for lateral-torsional buckling, 1, 1g,is taken
to be equal to the 1,, factor. Similar to 1,,and Is3, I 1 Can be overwritten.

Member Unsupported Lengths
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Figure 2-2 Unsupported lengths 133 and 1y,

Effects of Breaking a Member into Multiple
Elements

The preferred method is to model a beam, column or brace member as one sin-
gle element. However, the user can request that the program break a member
internally at framing intersections and at specified intervals. In this way, accu-
racy in modeling can be maintained, at the same time design/check specifica-
tions can be applied accurately. There is special emphasis on the end forces
(moments in particular) for many different aspects of beam, column and brace
design. If the member is manually meshed (broken) into segments, maintaining
the integrity of the design algorithm becomes difficult.

Manually, breaking a column member into several elements can affect many
things during design in the program.

1. The unbraced length: The unbraced length is really the unsupported length
between braces. If there is no intermediate brace in the member, the un-
braced length is typically calculated automatically by the program from the
top of the flange of the beam framing the column at bottom to the bottom
of the flange of the beam framing the column at the top. The automatically

Effects of Breaking a Member into Multiple Elements 2 - 13
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calculated length factor typically becomes less than 1. If there are interme-
diate bracing points, the user should overwrite the unbraced length factor in
the program. The user should choose the critical (larger) one. Even if the
user breaks the element, the program typically picks up the unbraced length
correctly, provided that there is no intermediate bracing point.

K-factor: Even if the user breaks the member into pieces, the program typi-
cally can pick up the K-factors correctly. However, sometimes it can not.
The user should note the K-factors. All segments of the member should
have the same K-factor and it should be calculated based on the entire
member. If the calculated K-factor is not reasonable, the user can over-
write the K-factors for all the segments.

C,factor: The C_ factor should be based on the end moments of

unbraced lengths of each segment and should not be based on the end
moments of the member. The program already calculates the C, factors

based on the end moments of unbraced lengths of each segment. If the
break-up points are the brace points, no action is required by the user. If
the broken segments do not represent the brace-to-brace unsupported
length, the program calculated C_ factor is conservative. If this

conservative value is acceptable, no action is required by the user. If it is
not acceptable, the user can calculate the C_ factor manually for the

critical combination and overwrite its value for that segment.

C, factor: The logic is similar to that for the C_ factor.

B, factor: This factor amplifies the factored moments for the P-¢ effect. In
its expression, there are the C_ factor and the Euler Buckling capacity P, .
If the user keeps the unbraced length ratios (l3; and 1,,) and the
K-factors ( Kz and Ky, ) correct, the B, factor would be correct. If the
axial force is small, the B, factor can be 1 and have no effect with respect
to modeling the single segment or multi-segment element.

B, factor: The program does not calculate the B, factor. The program
assumes that the user turns on the P-A. In such cases, B, can be taken as

equal to 1. That means the modeling with one or multiple segments has no
effect on this factor.

Effects of Breaking a Member into Multiple Elements
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If the user models a column with a single element and makes sure that the L-
factors and K -factors are correct, the effect of B, and B, will be picked up

correctly. The factors C,, and C, will be picked up correctly if there is no in-
termediate bracing point. The calculated C_ and C, factors will be slightly
conservative if there are intermediate bracing points.

If the user models a column with multiple elements and makes sure that L-
factors and K-factors are correct, the effect of B, and B, will be picked up

correctly. The factors C_ and C, will be picked up correctly if the member is
broken at the bracing points. The calculated C_, and C, factors will be con-
servative if the member is not broken at the bracing points.

Effective Length Factor (K)

The effective length method for calculating member axial compressive strength
has been used in various forms in several stability based design codes. The
method originates from calculating effective buckling lengths, KL, and is based
on elastic/inelastic stability theory. The effective buckling length is used to
calculate an axial compressive strength, Pn, through an empirical column curve
that accounts for geometric imperfections, distributed yielding, and residual
stresses present in the cross-section.

There are two types of K-factors in the ANSI/AISC 360-05 code. The first
type of K-factor is used for calculating the Euler axial capacity assuming that
all of the beam-column joints are held in place, i.e., no lateral translation is al-
lowed. The resulting axial capacity is used in calculation of the B, factor. This

K -factor is named as K, in the code. This K, factor is always less than 1 and
is not calculated. By default the program uses the value of 1 for K,. The pro-
gram allows the user to overwrite K, on a member-by-member basis.

The other K-factor is used for calculating the Euler axial capacity assuming
that all the beam-column joints are free to sway, i.e., lateral translation is al-
lowed. The resulting axial capacity is used in calculating P,. This K-factor is

named as K, in the code. This K, is always greater than 1 if the frame is a
sway frame. The program calculates the K, factor automatically based on
sway condition. The program also allows the user to overwrite K, factors on a

Effective Length Factor (K) 2-15
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member-by-member basis. The same K, factor is supposed to be used in cal-
culation of the B, factor. However the program does not calculate B, factors

and relies on the overwritten values. If the frame is not really a sway frame, the
user should overwrite the K, factors.

Both K, and K, have two values: one for major direction and the other for
minor direction, K K K K

Iminor ! 1major ! 2minor ! 2major *

There is another K-factor. K, for lateral torsional buckling. By default, K,
is taken as equal to K However the user can overwrite this on a member-
by-member basis.

2minor *

The rest of this section is dedicated to the determination of K, factors.

The K-factor algorithm has been developed for building-type structures,
where the columns are vertical and the beams are horizontal, and the behavior
is basically that of a moment-resisting frame for which the K-factor calcula-
tion is relatively complex. For the purpose of calculating K-factors, the ob-
jects are identified as columns, beam and braces. All frame objects parallel to
the Z -axis are classified as columns. All objects parallel to the X -Y plane are
classified as beams. The remainders are considered to be braces.

The beams and braces are assigned K-factors of unity. In the calculation of the
K-factors for a column object, the program first makes the following four
stiffness summations for each joint in the structural model:

)

C

C

) sex(®)

where the x and y subscripts correspond to the global X and Y directions and
the ¢ and b subscripts refer to column and beam. The local 2-2 and 3-3 terms
El,,/L,, and El,,/L,, are rotated to give components along the global X and

Y directions to form the (EI/L)X and (EI/L)y values. Then for each column,

the joint summations at END-I and the END-J of the member are transformed
back to the column local 1-2-3 coordinate system, and the G -values for END-I

Effective Length Factor (K)
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and the END-J of the member are calculated about the 2-2 and 3-3 directions as
follows:

| J
| Sz ] S ez
G»= | G 2= 3
b22 S b2
I J
| S'cas 3 S s
G 33 = | G 33 = 3
S b33 S b33

If a rotational release exists at a particular end (and direction) of an object, the
corresponding value of G is set to 10.0. If all degrees of freedom for a particu-
lar joint are deleted, the G -values for all members connecting to that joint will
be set to 1.0 for the end of the member connecting to that joint. Finally, if G'
and G’ are known for a particular direction, the column K-factors for the cor-
responding direction is calculated by solving the following relationship for .

a’G'G’ -36  «
6(G' +G’) tana

from which K = w/a. This relationship is the mathematical formulation for the
evaluation of K-factors for moment-resisting frames assuming sidesway to be
uninhibited. For other structures, such as braced frame structures, the
K-factors for all members are usually unity and should be set so by the user.
The following are some important aspects associated with the column
K -factor algorithm:

= An object that has a pin at the joint under consideration will not enter the
stiffness summations calculated above. An object that has a pin at the far
end from the joint under consideration will contribute only 50% of the cal-
culated El value. Also, beam members that have no column member at the
far end from the joint under consideration, such as cantilevers, will not en-
ter the stiffness summation.

= |f there are no beams framing into a particular direction of a column mem-
ber, the associated G-value will be infinity. If the G-value at any one end
of a column for a particular direction is infinity, the K -factor correspond-
ing to that direction is set equal to unity.

= |If rotational releases exist at both ends of an object for a particular direc-
tion, the corresponding K-factor is set to unity.

Effective Length Factor (K) 2-17
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» The automated K-factor calculation procedure can occasionally generate
artificially high K-factors, specifically under circumstances involving
skewed beams, fixed support conditions, and under other conditions where
the program may have difficulty recognizing that the members are laterally
supported and K-factors of unity are to be used.

= All K-factors produced by the program can be overwritten by the user.
These values should be reviewed and any unacceptable values should be

replaced.

» The beams and braces are assigned K-factors of unity.

When a steel frame design is performed in accordance with ANSI/AISC 360-
05 provision and the analysis method is chosen to be any of the four direct
analysis methods, the K, factors are automatically taken as 1 (AISC App. 7.1).

The calculated K, factors and their overwritten values are not considered in

design.

2.11 Supported Framing Types

The code (ANSI/AISC 341-05) recognizes the following types of framing

systems.
Framing Type References
SMF (Special Moment Frame) AISC SEISMIC 9

IMF (Intermediate Moment Frame)

OMF (Ordinary Moment Frame)

STMF (Special Truss Moment Frame)

SCBF (Special Concentrically Braced Frame)
OCBF (Ordinary Concentrically Braced Frame)
EBF (Eccentrically Braced Frame)

BRBF (Buckling Restrained Braced Frame)
SPSW (Special Plate Shear Wall)

AISC SEISMIC 10
AISC SEISMIC 11
AISC SEISMIC 12
AISC SEISMIC 13
AISC SEISMIC 14
AISC SEISMIC 15
AISC SEISMIC 16
AISC SEISMIC 17

2-18 Supported Framing Types
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With regard to these framing types, the program has implemented specifica-
tions for all types of framing systems, except STMF, BRBF, and SPSW. Im-
plementing those three types of framing require further information about
modeling.

The program recognizes the OCBF framing in its two separate incarnations:
OCBF for regular Ordinary Concentrically Braced Frames (AISC SEISMIC
14) and OCBFI for (base) Isolated Ordinary Concentrically Braced Frames
(AISC SEISMIC 14.5).

See Chapter 4 Special Seismic Provisions (ANSI/AISC 314-05) for additional
requirements.

Continuity Plates

In a plan view of a beam/column connection, a steel beam can frame into a
column in the following ways:

» The steel beam frames in a direction parallel to the column major direction,
i.e., the beam frames into the column flange.

= The steel beam frames in a direction parallel to the column minor direc-
tion, i.e., the beam frames into the column web.

= The steel beam frames in a direction that is at an angle to both of the prin-
cipal axes.

To achieve a beam/column moment connection, continuity plates, such as
shown in Figure 2-3, are usually placed on the column, in line with the top and
bottom flanges of the beam, to transfer the compression and tension flange
forces of the beam into the column.

For connection conditions described in the last two bullet items, the thickness
of such plates is usually set equal to the flange thickness of the corresponding
beam.

Continuity Plates 2-19
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However, for the connection condition described by the first bullet item, where
the beam frames into the flange of the column, such continuity plates are not
always needed. The requirement depends upon the magnitude of the beam
flange force and the properties of the column.

The program investigates whether the continuity plates are needed based on the
requirements of the selected code. Columns of I-sections supporting beams of
I-sections only are investigated. The program evaluates the continuity plate re-
quirements for each of the beams that frame into the column flange and reports
the maximum continuity plate area that is needed for each beam flange. The
continuity plate requirements are evaluated for moment frames only.

Doubler Plates

One aspect of the design of a steel framing system is an evaluation of the shear
forces that exist in the region of the beam column intersection known as the
panel zone. Shear stresses seldom control the design of a beam or column
member. However, in a moment resisting frame, the shear stress in the beam-
column joint can be critical, especially in framing systems when the column is
subjected to major direction bending and the web of the column resists the joint
shear forces. In minor direction bending, the joint shear is carried by the col-
umn flanges, in which case the shear stresses are seldom critical, and the pro-
gram does therefore not investigate this condition.

Shear stresses in the panel zone, due to major direction bending in the column,
may require additional plates to be welded onto the column web, depending
upon the loading and the geometry of the steel beams that frame into the col-
umn, either along the column major direction, or at an angle so that the beams
have components along the column major direction. See Figure 3-3. When
code appropriate, the program investigates such situations and reports the
thickness of any required doubler plates. Only columns with I-shapes and only
supporting beams with I-shapes are investigated for doubler plate requirements.
Also, doubler plate requirements are evaluated for moment frames only.

Doubler Plates 2-21
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Choice of Units

English as well as SI and MKS metric units can be used for input. The codes
are based on a specific system of units. All equations and descriptions present-
ed in the subsequent chapters correspond to that specific system of units unless
otherwise noted. However, any system of units can be used to define and de-
sign a structure in the program.

It should be noted that two design processes are available in CSiBridge: super-
structure design (on the Design/Rating tab) and design of the individual ele-
ments comprising the structure (the Advanced > Frame Design commands).
This manual addresses the second design process.

Choice of Units



Chapter 3
Design Using ANSI/AISC 360-05

This chapter provides a detailed description of the algorithms used by the pro-
grams in the design/check of structures in accordance with "ANSI/AISC 360-
05 — Specifications for Structural Steel Building" (AISC 20053, b). The menu
option "AISC 360-05/IBC 2006" also covers the "ANSI/AISC 341-05 —
Seismic Provisions for Structural Steel Building Including Supplement No. 1"
(AISC 2005c¢), which is described in the next chapter. The implementation co-
vers load combinations from "ASCE/SEI 7-05," which is described in the sec-
tion "Design Loading Combinations” in this chapter. The loading based on
"ASCE/SEI 7-05" has been described in a separate document entitled "CSI
Lateral Load Manual™ (CSI 2007). References also are made to IBC 2006 in
this document.

For referring to pertinent sections of the corresponding code, a unique prefix is
assigned for each code.

» Reference to the ANSI/AISC 360-05 code is identified with the prefix
"AISC."

» Reference to the ANSI/AISC 341-05 code is identified with the prefix
"AISC SEISMIC" or sometimes "SEISMIC" only.

* Reference to the ASCE/SElI 7-05 code is identified with the prefix
"ASCE."

» Reference to the IBC 2006 code is identified with the prefix "IBC."
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3.1 Notations

The various notations used in this chapter are described herein.

A Cross-sectional area, in?

Ae Effective cross-sectional area for slender sections, in?

Aq Gross cross-sectional area, in?

Avz,Avs Major and minor shear areas, in?

Ay Shear area, equal dt, per web, in?

B, Moment magnification factor for moments not causing sidesway
B> Moment magnification factor for moments causing sidesway
Co Bending coefficient

Cnm Moment coefficient

Cu Warping constant, in®

D Outside diameter of pipes, in

E Modulus of elasticity, ksi

Fer Critical compressive stress, ksi

Fr Compressive residual stress in flange assumed 10.0 for rolled

sections and 16.5 for welded sections, ksi

Fy Yield stress of material, ksi

G Shear modulus, ksi

I Minor moment of inertia, in*

I33 Major moment of inertia, in*

J Torsional constant for the section, in*

3-2 Notations
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K1
Ko

Ks3, K22

Mrsz, Mr22
My

Muss, Mu22
Pe

Pn

Pu

Py

Q

Qa

Effective length factor
Effective length factor for braced condition
Effective length factor for unbraced condition

Effective length K-factors in the major and minor directions for
appropriate braced (K1) and unbraced (K:) condition

Laterally unbraced length of member, in
Limiting laterally unbraced length for full plastic capacity, in

Limiting laterally unbraced length for inelastic lateral-torsional
buckling, in

Elastic buckling moment, kip-in

Factored moments causing sidesway, kip-in

Factored moments not causing sidesway, Kip-in

Nominal bending strength in major and minor directions, Kip-in

Elastic lateral-torsional buckling moment for angle sections, Kip-
in

Major and minor limiting buckling moments, Kip-in
Factored moment in member, Kip-in

Factored major and minor moments in member, Kip-in
Euler buckling load, kips

Nominal axial load strength, kip

Factored axial force in member, kips

AgFy, Kips

Reduction factor for slender section, = QaQs

Reduction factor for stiffened slender elements

Notations 3-3
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3-4 Notations

Reduction factor for unstiffened slender elements
Section modulus, in®
Major and minor section moduli, in®

Effective major and minor section moduli for slender sections,
in®

Section modulus for compression in an angle section, in®
Nominal major and minor shear strengths, kips

Factored major and minor shear loads, kips

Plastic modulus, in®

Major and minor plastic moduli, in®

Nominal dimension of plate in a section, in
longer leg of angle sections, bs — 2t,, for welded and b; — 3ty for
rolled box sections, and the like

Effective width of flange, in
Flange width, in

Overall depth of member, in
Effective depth of web, in

Clear distance between flanges less fillets, in
assumed d — 2k for rolled sections, and d — 2t; for welded sec-
tions

Distance from outer face of flange to web toe of fillet, in

Parameter used for section classification
ke= 4/ \Jh/t, , 0.35< k, <0.763

Major and minor directions unbraced member lengths, in

Radius of gyration, in
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F33,F22 Radii of gyration in the major and minor directions, in
t Thickness, in

s Flange thickness, in

tw Thickness of web, in

Bw Special section property for angles, in

A Slenderness parameter

A, he Column slenderness parameters

Ap Limiting slenderness parameter for compact element
Ar Limiting slenderness parameter for non-compact element
As Limiting slenderness parameter for seismic element
Aslender Limiting slenderness parameter for slender element
(o Resistance factor for bending

0c Resistance factor for compression

0t Resistance factor for tension yielding

QT Resistance factor for torsion

Qv Resistance factor for shear

Qp Safety factor for bending

Qc Safety factor for compression

Qi Safety factor for tension

Qr Safety factor for torsion

Q Safety factor for shear

Notations 3-5
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3.2 Design Loading Combinations

The structure is to be designed so that its design strength equals or exceeds the
effects of factored loads stipulated by the applicable design code. The default
design combinations are the various combinations of the already defined load
cases, such as dead load (DL), live load (LL), roof live load (RL), snow load
(SL), wind load (WL), and horizontal earthquake load (EL).

AISC 360-05 refers to the applicable building code for the loads and load com-
binations to be considered in the design, and to ASCE 7-05 in the absence of
such a building code. Hence, the default design combinations used in the cur-
rent version are the ones stipulated in ASCE 7-05:

For design in accordance with LRFD provisions:

1.4 DL (ASCE 2.3.2-1)
12DL+16LL+05RL (ASCE 2.3.2-2)
12DL+10LL+16RL (ASCE 2.3.2-3)
12DL+16LL+05SL (ASCE 2.3.2-2)
12DL+1.0LL+1.6SL (ASCE 2.3.2-3)
0.9DL + 1.6 WL (ASCE 2.3.2-6)
1.2DL + 1.6 RL £0.8 WL (ASCE 2.3.2-3)
12DL +1.0LL+0.5RL +1.6 WL (ASCE 2.3.2-4)
12DL +1.6SL+0.8 WL (ASCE 2.3.2-3)
12DL +1.0LL +0.55L + 1.06 WL (ASCE 2.3.2-4)
09DL+1.0EL (ASCE 2.3.2-7)
12DL +1.0LL +0.2SL + 1.0EL (ASCE 2.3.2-5)

For design in accordance with ASD provisions:

1.0 DL (ASCE 2.4.1-1)
1.0DL +1.0LL (ASCE 2.4.1-2)
1.0DL + 1.0RL (ASCE 2.4.1-3)
1.0DL +0.75 LL + 0.75 RL (ASCE 2.3.2-4)
1.0DL +1.0SL (ASCE 2.4.1-3)
1.0DL +0.75 LL +0.75 SL (ASCE 2.3.2-4)
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1.0 DL + 1.0 WL (ASCE 2.4.1-5)
1.0 DL +0.75 LL + 0.75 RL + 0.75 (WL) (ASCE 2.4.1-6)
1.0 DL +0.75 LL + 0.75 SL + 0.75 (WL) (ASCE 2.4.1-6)
0.6 DL +1.0 WL (ASCE 2.4.1-7)
1.0DL +0.7 EL (ASCE 2.4.1-5)
1.0 DL +0.75 LL + 0.75 SL + 0.75(0.7 EL) (ASCE 2.4.1-6)
0.6 DL + 0.7 EL (ASCE 2.4.1-8)

Most of the analysis methods recognized by the code are required to consider
Notional Load in the design loading combinations for steel frame design. The
program allows the user to define and create notional loads as individual load
cases from a specified percentage of a given gravity load acting in a particular
lateral direction. These notional load patterns should be considered in the com-
binations with appropriate factors, appropriate directions, and appropriate
senses. Currently, the program automatically includes the notional loads in the
default design load combinations for gravity combinations only. The user is
free to modify the default design load combinations to include the notional
loads. For further information, refer to the "Notional Load Patterns" section in
Chapter 2.

The program automatically considers seismic load effects, including over-
strength factors (ASCE 12.4.3), as special load combinations that are created
automatically from each load combination, involving seismic loads. In that
case, the horizontal component of the force is represented by Enm and the verti-
cal component of the force is represented byE,, where

Erm = Q0Qe (ASCE 12.4.3.1)
E, =0.2SpsD (ASCE 12.4.2.2)

where, Q, is the overstrength factor and it is taken from ASCE 7-05 Table
12.2-1. The factor Sps is described later in this section. Effectively, the special
seismic combinations that are considered for the LRFD provision are

(0.9 - 0.2Sps)DL £ Q0Qe (ASCE 12.4.3.2)
(1.2 -0.2Sps)DL + Q0Qe + 1.0LL (ASCE 12.4.3.2)
and for the ASD provision the combinations are

(1.0 — 0.14Sp5)DL + 0.70Qe (ASCE 12.4.3.2)
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(1.0 + 0.105Sps)DL + 0.75(0.7Q2)Qe + 0.75LL (ASCE 12.4.3.2)
(0.6 — 0.14Sp5)DL + 0.70Qe (ASCE 12.4.3.2)

The program assumes that the defined earthquake load is really the strength
level earthquake, which is equivalent to Qe as defined in Section 12.4.2.1 of
the ASCE 7-05 code. For regular earthquake, load is considered to have two
components: horizontal, E, and vertical E,, which are taken as

En = pOe (ASCE 12.4.2.1)
E, = 0.2SpsD (ASCE 12.4.2.2)

where, p is the redundancy factor as defined in Section 12.3.4 of ASCE 7-05,
and the Sps is the design earthquake spectral response acceleration parameters
at short periods, as defined in Section 11.4.4 of ASCE 7-05 code.

Effectively, the seismic load combination for the LRFD provision becomes:

(1.2 + 0.2Sps)DL + pQe (ASCE 2.3.2-5, 12.4.2.3)
(1.2 + 0.2Sps)DL + pQe + 1.0LL (ASCE 2.3.2-5, 12.4.2.3)
(0.9 - 0.2Sps)DL + pQe (ASCE 2.3.2-7, 12.4.2.3)

The seismic load combinations for the ASD provision become:
(1.0 + 0.14Sps)DL + 0.7pQe (ASCE 2.4.1-5,12.4.2.3)
(1.0 + 0.105Sps)DL + 0.75(0.7p)Qe + 0.75LL  (ASCE 2.4.1-6, 12.4.2.3)
(0.6 — 0.14Sps)DL + 0.7pQe (ASCE 2.4.1-7,12.4.2.3)

The program assumes that the seismic loads defined as the strength level load
is the program load case. Otherwise, the factors p, Qo, and Sps will not be able
to scale the load to the desired level.

The combinations described herein are the default loading combinations only.
They can be deleted or edited as required by the design code or engineer-of-
record.

Design Loading Combinations
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3.3

The program allows live load reduction factors to be applied to the member
forces of the reducible live load case on a member-by-member basis to reduce
the contribution of the live load to the factored responses.

Classification of Sections for Local Buckling

The nominal strengths for axial, compression, and flexure are dependent on the
classification of the section as Seismically Compact, Compact, Noncompact,
Slender, or Too Slender. Compact or Seismically Compact sections are capable
of developing the full plastic strength before local buckling occurs. Non-
compact sections can develop partial yielding in compression, and buckle
inelastically before reaching to a fully plastic stress distribution. Slender sec-
tions buckle elastically before any of the elements yield under compression.
Seismically Compact sections are capable of developing the full plastic
strength before local buckling occurs when the section goes through low cycle
fatigue and withstands reversal of load under seismic conditions.

Sections are classified as Compact, Noncompact, or Slender sections in
accordance with Section B4 of the code (AISC B4). For a section to qualify as
Compact, its flanges must be continuously connected to the web or webs and
the width-thickness ratios of its compression elements must not exceed the
limiting width-thickness ratios A, from Table B4.1 of the code. If the width-
thickness ratio of one or more compression elements exceeds A,, but does not
exceed A, from Table B4.1, the section is Noncompact. If the width-thickness
ratio of any element exceeds A, but does not exceed As, the section is Slender.
If the width-thickness ratio of any element exceed As, the section is considered
Too Slender. The expressions of Ap, Ar, and As, as implemented in the program,
are reported in Table 3-1 (AISC Table B4.1, B4, F8, F13.2). In that table all
expressions of A, and A, are taken from AISC section B4 and AISC Table
B4.1. The limit demarcating Slender and Too Slender has been identified as As
in this document. The expressions of As for I1-Shape, Double Channel, Channel
and T-Shape sections are taken from AISC section F13.2. The expression of As
for Pipe Sections is taken from AISC section F8. The expression of A, for
Angle and Double Angle sections is taken from AISC Seismic code
ANSI/AISC 341-05 Table 1-8-1.
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The table uses the variables k., F., h, hy, he, by, t1, tw, b, t, D, d, and so on. The
variables b, d, D and t are explained in the respective figures inside the table.
The variables by, t;, h, hy, he, and tw are explained in Figure 3-1. For Doubly
Symmetric I-Shapes, h, hp, and h. are all equal to each other.
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AISC-2005: Axes Conventions 2y
2-2 is the cross section axis '
T parallel to the webs, the ——
D longer dimension of tubes,
d the longer leg of single
l l angles, or the side by side
legs of double anges. T_hls is
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3-3is orthogonal to 2-2. This is
the same as the x-x axis.

Figure 3-1 AISC 360-05 Definition of Geometric Properties
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For unstiffened elements supported along only one edge parallel to the direc-
tion of compression force, the width shall be taken as follows:

(a) For flanges of I-shaped members and tees, the width b is one-half the full-
flange width, by.

(b) For legs of angles and flanges of channels and zees, the width b is the full
nominal dimension.

(c) For plates, the width b is the distance from the free edge to the first row of
fasteners or line of welds.

(d) For stems of tees, d is taken as the full nominal depth of the section.

Refer to Table 3-1 (AISC Table B4.1) for the graphic representation of unstiff-
ened element dimensions.

For stiffness elements supported along two edges parallel to the direction of the
compression force, the width shall be taken as follows:

(a) For webs of rolled or formed sections, h is the clear distance between
flanges less the fillet or corner radius at each flange; h is twice the dis-
tance from the centroid to the inside face of the compression flange less the
fillet or corner radius.

(b) For webs of built-up sections, h is the distance between adjacent lines of
fasteners or the clear distance between flanges when welds are used, and hc
is twice the distance from the centorid to the nearest line of fasteners at the
compression flange or the inside face of the compression flange when
welds are used; h, is twice the distance from the plastic neutral axis to the
nearest line of fasteners at the compression flange or the inside face of the
compression flange when welds are used.

(c) For flange or diaphragm plates in built-up sections, the width b is the dis-
tance between adjacent lines of fasteners or lines of welds.

Classification of Sections for Local Buckling
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Table 3-1 Limiting Width-Thickness Ratios of Compression Elements for Classification Sections

Width- Limiting Width-Thickness Ratios for Compression
Thicknes Element
section | Descrinti ACISC Ratio, Compact NonCompact Slender
ection | Description ase
Type | of Element Example No. (7‘) (7“") (xr) (7‘5)
e > =
Flexural ¢
compression
of flanges of 1| b2t 0.38,/E/F, 10,/E/F, No Limit
rolled
I-Shapes
f=b -
Flexural g5
compression 7 ¢
in flanges of 2 2 b, /2t, 0.38,/E/F, 0.95,/k E/F, No Limit
built-up 7
I-Shapes 2
CPP Al PPl rrA
e > =
g | Axialonly
5 compression t
- in flanges of 3 b, /2t, 0.38,/E/F, 0.56,/E/F, No Limit
£ rolled
g I-Shapes
£
() jo= [ =y
- .
= Axial on_ly 7
3 compression
a in flanges of 4 b, /2t, 0.38,/E/F, 0.64,/k E/F, No Limit
built-up
I-Shapes
m;ﬂm
%! .
| / min{0.42 E/F,, 260}
Flexure in web| /1 : t, 9 h/t, 3.76,/E/F, 5.70,/E/F, (beams)
| g No limit for columns
Y and braces
prirrfIrrrrz)
m;ﬂm
7 .
Web in axal | ; min{0.42 E/F,, 260}
only h 7 £ 10 h/t, NA 1.49 E/Fy (beams)
compression | ; No limit for columns
Y and braces
rrrrad P rsrss)
Flexural
Compression
of flanges of 1 b, /2t, 0.38,/E/F, 10,/E/F, No Limit

Singly Symmetric
I-Shapes

rolled
I-Shapes

T
=Ni
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Table 3-1 Limiting Width-Thickness Ratios of Compression Elements for Classification Sections

Width- Limiting Width-Thickness Ratios for Compression
Thicknes Element
section | Descrinti ACISC Ratio, Compact NonCompact Slender
ection | Description ase
Type | of Element Example No. (7‘) (7“") (xr) (7‘5)
el
Flexural 1
Compression g
in flanges of 2 2 b, /2t, 0.38,/E/F, 0.95,/k.E/F. No Limit
built-up 2
I-Shapes 2
f=b=
Axial only it
compression
< | inflanges of 3 | b/2t 0.38,/E/F, 0.56,/E/F, No Limit
3 rolled
£ I-Shapes
c
8
g felra
s Axial only
2 | compressi a1t
- pression %
2 | in flanges of 7 4 b, /2t 0.38,/E/F, 0.64,/k E/F, No Limit
g built-up g
IS I-Shapes 7
S v
wn
>
[=)] 77774
h |E
‘UE) E‘I el g E hC F
Flexurein |~ 2 / A B ST M . EF
e 11 h/t, M "5, No Limit
Web 2 “ [0.54"—0.09 /
—b/q—f M‘/
gl
min{0.42 E/F,, 260}
Fle\;(\f;g in h/t, NA NA (beams)
No limit for columns
and braces
Flexural
compression 1 b, /t, 0.38,/E/F, 10,/E/F, No Limit
in flanges
3
§ V77
& —r—1
Axial only te
compression 3 b, /t; 0.38,/E/F, 0.56,/E/F, No Limit
in flanges
Z
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Table 3-1 Limiting Width-Thickness Ratios of Compression Elements for Classification Sections

Limiting Width-Thickness Ratios for Compression

in stems

Width-
Thicknes Element
section | Descrinti ACISC Ratio, Compact NonCompact Slender
ection | Description ase
Type | of Element Example No. (7‘) (7“") (xr) (7‘5)
R 1 min{0.42 E/F,, 260}
B [Flexure in web k 9 h/t, 3.76,[E/F, 5.70,/E/F, (beams)
£ No limit for columns
S and braces
2
g Web in axial i m|n{0.42 E/FV’%O}
§ only . 10 h/t, NA 149 /E/F, (beams)
compression No limit for columns
and braces
p—h—
Flexural T,
compression 1| b/t 0.38,/E/F, 10,/E/F, No Limit
in flanges
p—=b=— |
Axial only T
S | compression 3 b, /t, 0.38,/E/F, 0.56,/E/F, No Limit
S in flanges
=
(&)
@
5 P, min {0.42 E/F,, 260}
o
O |Flexure in web 9 h/t, 3.76,/E/F, 5.70,/E/F, (beams)
No limit for columns
and braces
Web in axial min{0.42 E/F,, 260}
only 10 h/t, NA 1.49,/E/F, (beams)
compression No limit for columns
and braces
Flexural or
axial
compression 112 [E/F 1.40.[EJE o
of flanges 12 b/t /F, /F, No Limit
under major
3 axis bending
M
Flexure in web 13 h/t 2.42,[E[F, 5.70,/E/F, No Limit
Flexural or
axial L
. b, /2t 0.38,/E/F. 1.0./E/F
@ | compression ! o2 /5 /5 No Limit
s in flanges
P
= | zzzZZZZZA T
Compression bt d 8 d/t, 0.30,E/F, 0.75,/E/F, No Limit
4
¥
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Table 3-1 Limiting Width-Thickness Ratios of Compression Elements for Classification Sections

Width- Limiting Width-Thickness Ratios for Compression
Thicknes Element
section | Descrinti ACISC Ratio, Compact NonCompact Slender
ection escription ase
Type | of Element Example No. (7‘) (k") (xr) (7”5)
p—1r
Any type of F
o | compression 'l 6 b/t 0.30,/E/F, 0.45,/E/F, No Limit
2 in leg
< oF
3
3 Any type of 1_
O | compression || 6 b/t 0.30,/E/F, 0.45,/E/F, No Limit
in leg e
Flexural iy
exura
compression ! 7 b/t 0.54,/E/F, 0.91/E/F, No Limit
inany leg
)
=
< I3
Axial only
compression t 6 b/t 0.30,/E/F, 0.45,/E/F, No Limit
inany leg
t
Flexural
compression @ 15 D/t 0.07 E/Fy O'le/Fy 0'45E/Fy
3
& /
Axial only
compression @ 15 D/t 0.07 E/Fy 0'11E/Fy 0.45 E/Fy
Rgund _ — Assumed Noncompact
ar
Rectan-
qular _ —— Assumed Noncompact
General _ | ——— Assumed Noncompact
SD
Section _ —— Assumed Noncompact
(d) For flanges of rectangular hollow structural sections (HSS), the width b is
the clear distance between webs less the inside corner radius on each side.
For webs of rectangular HSS, h is the clear distance between the flanges
less the inside corner radius on each side. If the corner radius is not known,
b and h shall be taken as the corresponding outside dimension minus three
times the thickness. The thickness, t, shall be taken as the design wall
thickness, in accordance with AISC Section B3.12.
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Refer to Table 3-5 (AISC Table B4.1) for the graphic representation of stiff-
ened element dimensions.

The design wall thickness, t, for hollow structural sections, such as Box and
Pipe sections, is modified for the welding process (AISC B3.12). If the welding
process is ERW (Electric-Resistance Welding), the thickness is reduced by a
factor of 0.93. However, if the welding process is SAW (Submerged Arc
Welded), the thickness is not reduced. The Overwrites can be used to choose if
the thickness of HSS sections should be reduced for ERW on a member-by-
member basis. The Overwrites can also be used to change the reduction factor.

The variable k. can be expressed as follows:

k. :L, (AISC Table B4.1 Note a)
ht,
0.35<k:<0.76. (AISC Table B4.1 Note a)

For Doubly Symmetric 1-Shapes, Channels, and Double Channels, F. can be
expressed as follows:

FL=0.7Fy, (AISC Table B4.1 Note b)

and for Singly Symmetric I-Shape sections, F. can be expressed as follows:

F ::_xrpy, where (AISC Table B4.1 Note b, F4-6)

Xc

0.5F, < FL < 0.7F. (AISC Table B4.1 Note b, F4-6)

Seismically Compact sections are compact sections that satisfy a more strin-
gent width-thickness ratio limit, Ays. This limit Ay is presented in Table 4-1 in
Chapter 4, which is dedicated to the seismic code.

In classifying web slenderness of 1-Shapes, Box, Channel, Double Channel,
and all other sections, it is assumed that there are no intermediate stiffeners.
Double angles and channels are conservatively assumed to be separated.

Stress check of Too Slender sections is beyond the scope of this program.
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Calculation of Factored Forces and Moments

The factored member loads that are calculated for each load combination are
Pr, Miss, Mi22, V2, Viz and T, corresponding to factored values of the axial load,
the major and minor moments and shears, and torsion, respectively. These fac-
tored loads are calculated at each of the previously defined stations.

The factored forces can be amplified to consider second order effects, depend-
ing on the choice of analysis method chosen in the Preferences. If the analysis
method is chosen to be General Second Order Elastic Analysis or any of the
Direct Analysis methods with General Second Order Analysis, it is assumed
that the analysis considers the influence of second-order effects (P-A and P-5
effects); hence the analysis results are used without amplification (AISC C2.1,
C2.2a, App 7.3). Second-order effects due to overall sway of the structure can
usually be accounted for, conservatively, by considering the second-order ef-
fects on the structure under one set of loads (usually the most severe gravity
load case), and performing all other analyses as linear using the stiffness matrix
developed for this one set of P-delta loads (see also White and Hajjar 1991).
For a more accurate analysis, it is always possible to define each loading com-
bination as a nonlinear load case that considers only geometric nonlinearities.
For both approaches, when P-6 effects are expected to be important, use more
than one element per line object (accomplished using the automatic frame sub-
divide option; refer to the program Help for more information about automatic
frame subdivide).

If the analysis method is chosen to be Second Order Analysis by Amplified
First Order Analysis or any of the Direct Analysis Methods with Amplified
First Order Analysis (AISC C2.1b, C2.2, App 7.3), it is assumed that the analy-
sis does not consider the influence of second order effects (P-A and P-3).
Hence the analysis results are amplified using B: and B, factors using the fol-
lowing approximate second-order analysis for calculating the required flexural
and axial strengths in members of lateral load resisting systems. The required
second-order flexural strength, My, and axial strength, P, are determined as fol-
lows:

M, = BiMn: + BaM (AISC C2-1a)
r = Pnt + B2Pyt (AISC C2-1b)

where,

Calculation of Factored Forces and Moments
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C
B, = T—2>1 and (AISC C2-2)
l-a-*
el
B—— L > (AISC C2-3)
2 _oaXP, 7
zP,
where,
1.0 for LRFD,
(04 =
1.6 for ASD,
M: = required second-order flexural strength using LFRD and ASD
load combinations, kip-in (N-mm)
My = first-order moment using LFRD and ASD load combinations,
assuming there is no lateral translation of the frame, kip-in. (N-
mm)
My = first-order moment using LRFD or ASD load combinations
caused by lateral translation of the frame only, kip-in (N-mm)
Py = required second-order axial strength using LRFD or ASD load
combinations, kip (N)
Pt = first-order axial force using LRFD or ASD load combinations,
assuming there is no lateral translation of the frame, kips (N)
>Pn = total vertical load supported by the story using LRFD or ASD
load combinations, including gravity column loads, kips (N)
Pt = first-order axial force using LRFD or ASD load combinations
caused by lateral translation of the frame only, kips (N)
Cn = a coefficient assuming no lateral translation of the frame,

whose value is taken as follows:

(i) For beam-columns not subject to transverse loading be-
tween supports in the plane of bending,
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C, =0.6-0.4(M,/M,), (AISC C2-4)

where, Ma and My, calculated from a first-order analysis,
are the smaller and larger moments, respectively, at the
ends of that portion of the member unbraced in the plane
of bending under consideration. M, /M, is positive when

the member is bent in reverse curvature, negative when
bent in single curvature.

(if) For beam-columns subjected to transverse loading between
supports, the value of Cy, is conservatively taken as 1.0 for
all cases.

When My is zero, Cn is taken as 1.0, the program defaults
Cm to 1.0, if the unbraced length is more than actual mem-
ber length. The user can overwrite the value of C, for any
member. Cr, can be expressed as follows:

1.00, if length is more than actual length,
1.00, if tension member,
C,, =41.00, if both ends unrestrained,
0.6-0.4 M, , if no transverse loading, and
b
1.00, if transverse loading is present.
(AISC C2-1b)

Pe = elastic critical buckling resistance of the member in the plane

of bending, calculated based on the assumption of zero side-
sway, Kips (N)
2
p,= " EL (AISC C2-5)
(KiL)

If any of the direct analysis methods are used, the reduced val-
ue of El is used (AISC App. 7.3(1)).
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Zpez

= elastic critical buckling resistance for the story determined by

sidesway buckling analysis, kips (N)

For moment frames, where sidesway buckling effective length
factors K; are determined for the columns, it is the elastic story
sidesway buckling resistance and calculated as

2
sp,=x " (AISC C2-6a)
(K;L)
where,
E = modulus of elasticity of steel = 29,000 ksi

(200,000 MPa)

If any of the direct analysis methods are used,
the reduced value of El is used (AISC App.
7.3(2)).

I = moment of inertia in the plane of bending, in.*
(mm®)

L = story height, in. (mm)

K1 effective length factor in the plane of bending,
calculated based on the assumption of no lateral
translation. It is taken to be equal to 1.0, conser-
vatively. The Overwrites can be used to change
the value of Ky for the major and minor direc-

tions.

K, = effective length factor in the plane of bending,
calculated based on a sidesway buckling analy-
sis. The Overwrites can be used to change the
value of K; for the major and minor directions.

In the expression of Bs, the required axial force P; is used based on its first or-
der value. The magnification factor B, must be a positive number. Therefore,
P must be less than Pei. If aP; is found to be greater than or equal to Pe; a
failure condition is declared.
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If the program assumptions are not satisfactory for a particular structural model
or member, the user has the choice to explicitly specify the values of B; for any
member.

Currently, the program does not calculate the B, factor. The user is required to
overwrite the values of B, for the members.

Calculation of Nominal Strengths

The nominal strengths in compression, tension, bending, and shear are comput-
ed for Compact, Noncompact, and Slender members in accordance with the
following sections. The nominal flexural strengths for all shapes of sections
are calculated based on their principal axes of bending. For the Rectangular, I-
Shape, Box, Channel, Double Channel, Circular, Pipe, T-Shape, and Double
Angle sections, the principal axes coincide with their geometric axes. For the
Single Angle sections, the principal axes are determined and all computations
except shear are based on that.

For all sections, the nominal shear strengths are calculated for directions
aligned with the geometric axes, which typically coincide with the principal
axes. Again, the exception is the Single Angle section.

If the user specifies nonzero nominal capacities for one or more of the
members on the Steel Frame Overwrites form, those values will override
the calculated values for those members. The specified capacities should
be based on the principal axes of bending for flexure, and the geometric
axes for shear.

Nominal Tensile Strength

This section applies to the members subject to axial tension.

Although there is no maximum slenderness limit for members designed to re-
sist tension forces, the slenderness ratio preferably should not exceed 300
(AISC D1). A warning message to that effect is printed for such slender ele-
ments under tension.

The design tensile strength, ¢«Ps, and the allowable tensile strength, P, /Q,, of
tension members is taken as the lower value obtained according to the limit
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3.5.2

states of yielding of gross section under tension and tensile rupture in the net
section.

3.5.1.1 Tensile Yielding in the Gross Section

Po=Fy A (AISC D2-1)
1 =0.90 (LRFD) (AISC D2)
Q.= 1.67 (ASD) (AISC D2)

3.5.1.2 Tensile Rupture in the Net Section

Pn=FiAe (A|SC D2-2)
d1 =0.75 (LRFD) (AISC D2)
Q= 2.00 (ASD) (AISC D2)

The effective net area, A, is assumed to be equal to the gross cross-sectional
area, Ay, by default. For members that are connected with welds or members
with holes, the Ae/Ag ratio must be modified using the steel frame design

Overwrites to account for the effective area.

Nominal Compressive Strength

The design compressive strength, &:P,, and the allowable compressive
strength, P,/Q., of members subject to axial compression are addressed in this

section. The resistance and safety factors used in calculation of design and al-
lowable compressive strengths are:

¢c = 0.90 (LRFD) (AISC E1)
Q. =167 (ASD) (AISC E1)

In the determination, the effective length factor K; is used as the K-factor. If
the chosen analysis method in the Preferences is the General Second Order
Elastic Analysis, the First Order Analysis using Amplified First Order Analy-
sis, or the Limited First Order Analysis, the calculated K, factors are used. If
the user overwrites the K, factors, the overwritten values are used. If the cho-
sen analysis method is one of any Direct Analysis Methods, the effective
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length factor, K, for calculation of P, is taken as one (AISC App 7.1). The
overwritten value of Kz will have no effect for the latter case.

The nominal axial compressive strength, P, depends on the slenderness ratio,
Kl/r,where

r33 r.22

For all sections except Single Angles, the principal radii of gyration ry; and rs3
are used. For Single Angles, the minimum (principal) radius of gyration, r;, is
used instead of r and rss, conservatively, in computing Kl/r. Ks; and Kz, are

two values of K; for the major and minor axes of bending.

Although there is no maximum slenderness limit for members designed to re-
sist compression forces, the slenderness ratio preferably should not exceed 200
(AISC E2). A warning message to that effect is given for such slender elements
under compression.

The members with any slender element and without any slender elements are
handled separately.

The limit states of torsional and flexural-torsional buckling are ignored for
closed sections (Box and Pipe sections), solid sections, general sections, and
sections created using Section Designer.

3.5.2.1 Members without Slender Elements

The nominal compressive strength of members with compact and noncompact
sections, Py, is the minimum value obtained according to the limit states of
flexural buckling, torsional and flexural-torsional buckling.

3.5.2.1.1 Flexural Buckling

For compression members with compact and noncompact sections, the nominal
compressive strength, P, based on the limit state of flexural buckling, is given

by
Pn=Fer Ag. (AlSC E3'1)

The flexural buckling stress, Fe, is determined as follows:
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Fy
(O.GSBRJFW it “boa7|E
r F

F, = (AISC E3-2, E3-3)

0.877F,, if & >4.71 /E
r Fy

where F. is the elastic critical buckling stress given by

2
F-_TE (AISC E3-4)

e & 2"
r
3.5.2.1.2 Torsional and Flexural-Torsional Buckling

For compression members with compact and noncompact sections, the nominal
compressive strength, P,, based on the limit state of torsional and flexural-
torsional buckling is given by

Pn = Fer Ag (A|SC E4-1)

where Ag is the gross area of the member. The flexural buckling stress, Fc., is
determined as follows.

3.5.2.1.2.1 Box, Pipe, Circular, Rectangular, General and Section Design-
er Sections

The limit states of torsional and flexural-torsional buckling are ignored for
members with closed sections, such as Box and Pipe sections, solid sections
(Circular and Rectangular), General sections and sections created using the
Section Designer.

3.5.2.1.2.2 Double Angle and T-Shapes

F F 4F. ,,F._H
F. Z(Mj 1- [1- el | (AISC E4-2)
2H (Fcr22 + Fcrz)

where,
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FY
(0.658%)F, if &34.71 E,
ry, Fy

cr22
0.877F,, if &>4.71 E
r,, F

(AISC E3-2, E3-3)

2
F=—"E  and (AISC E3-4)
( KL,, J
rZZ
F=2 (AISC E4-3)
AT

3.5.2.1.2.3 |-Shape, Double Channel, Channel, Single Angle Sections

For 1-Shape, Double Channel, Channel, and Single Angle sections, F. is calcu-
lated using the torsional or flexural-torsional elastic buckling stress, F., as fol-
lows:

FY
(o.assﬂij, it *-can /5,
. r F

= (AISC E3-2, E3-3, E-4b)

0.877F,, if KL >4.71 /E.
r K

where F. is calculated from the following equations:

3.5.2.1.23.1 [|-Shapes and Double Channel Sections

2
F=| ZEC L6 (—1 j (AISC E4-4)
(Ksz) o+l
35.21.23.2  Channel Sections
F = (—Fe% +Fe J 1- - 2Rafall (AISC E4-5)
2H (Fe33 + Fez)
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3.5.2.1.23.3 Single Angle Sections with Equal Legs

F F 4F..F H
F, {%) 1- 1_(e33—ez)2 (AISC E4-5)
Fe33 + Fez

3.5.2.1.23.4  Single Angle Sections with Unequal Legs
F. is the lowest root of the cubic equation.

2
X
(Fe - F933)(Fe - FGZZ)(Fe - FeZ)_ R’ (Fe - FeZZ)[F_OJ R (Fe - Fess)()ri_oj -

0 0

(AISC E4-6)

In the preceding equations,
Cu is the warping constant, in® (mm®)

Xo, Yo are the coordinates of the shear center with respect to the cen-
troid, Xo = 0 for Double Angle and T-Shaped members (y-axis

symmetry)
T o= \/xf +Y +m = polar radius of gyration about the shear
center (AISC E4-7)
X2 +y?
H = 1_[ e —Jo ] (AISC E4-8)
r
n°E
Fp= —— (AISC E4-9)
(Kss L33/r33)
n’E
Fpp= ————— (AISC E4-10)
(Kzz Lzz/rzz)
2
Fo= | 25 eyl (AISC E 4-11)
(Kz L, ) AT,

K2, Kss  are effective length factors K> in minor and major directions
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K, is the effective length factor for torsional buckling, and it is
taken equal to Kitg in this program; it can be overwritten

L2, L3z are effective lengths in the minor and major directions
r22, 33 are the radii of gyration about the principal axes

L, is the effective length for torsional buckling and it is taken
equal to L2, by default, but it can be overwritten.

For angle sections, the principal moment of inertia and radii of gyration
are used for computing Fe. Also, the maximum value of KL, i.e,
max(Kazloz, Kaslas), is used in place of Kala, or Kss Lss in calculating
Fe22 and Fess in this case. The principal maximum value rmax is used for
calculating Fess, and the principal minimum value ri, is used in calculat-
ing Feoo.

3.5.2.2 Members with Slender Elements

The nominal compressive strength of members with slender sections, Py, is the
minimum value obtained according to the limit states of flexural, torsional and
flexural-torsional buckling.

3.5.2.2.1 Flexural Buckling

For compression members with slender sections, the nominal compressive
strength, Py, based on the limit state of flexural buckling, is given by

Pn = FerAg. (AISC E7-1)

The flexural buckling stress, Fe, is determined as follows:

QF,
Q[0.658 F }Fy, if F,>0.44QF,, and
F, =

Cl

(AISC E7-2, E7-3)

0.877F,, if F, <0.44QF,,

where F. is the elastic critical buckling stress for flexural buckling limit state.
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2
F-_TE (AISC E3-4)

(KLY
r
3.5.2.2.2 Torsional and Flexural-Torsional Buckling

For compression members with slender sections, the nominal compressive
strength, Pn, based on Torsional and Flexural-Torsional limit state is given by:

Pn = Fer Ag, Where (AISC E7-1)

F¢r is determined as follows:

o,
0.658 % |F, if F, >0.44QF,, and
= Q[ J e o (AISC E7-2, E7-3)

0.877F, if F, <0.44F,

where, Fe is the elastic critical buckling stress for torsional and flexural-
torsional limit states, which are given for different shapes as follows.

352221 Box, Pipe, Circular, Rectangular, General and Section Design-
er Sections

The limit states of torsional and flexural-torsional buckling are ignored for
members with closed (Box and Pipe), solid (Circular and Rectangular), General
sections and sections created using the Section Designer.

3.5.2.2.2.2 |-Shape and Double Channel Sections

2
F == ECWZ +GJ ( 1 J (AISC E7, E4-4)
(Ksz) I22+I33

3.5.2.2.2.3 Channel Sections

F,+F AF F_H
Fﬁ( s T J 1 oo Hesfaf (AISC E7, E4-5)
2H (Fe33+Fez)
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3.5.2.2.2.4 Double Angle Sections and T-Shapes

Fp, +F 4F,,,F,H
F 2(&j 1- [1-—<2re (AISC E7, E4-5)
2H (Fe33 + Fez)

3.5.2.2.25 Single Angle Sections with Equal Legs
F, =(%j{1—\/1—4FLF“HZ} (AISC E7, E4-5)
(Fess +Fez)

3.5.2.2.2.6 Single Angle Sections with Unequal Legs
F. is the lowest root of the cubic equation.

2 2
(Fe - Fe33)(Fe - Fezz)(':e - I:ez)_ Fe2 (Fe - Fezz)[%j - I:e2 (Fe - Fe33)[¥] =0

[o]

(AISC E7, E4-6)

The variables used in the preceding expressions for Fe, such as Cu, Xo, Yo, T,
H, Fess, Fezz, Fez, Kz, Kas, Ky, L2z, Las, Lz, KL/r, and so on, were explained in
the previous section.

3.5.2.2.3 Reduction Factor for Slenderness

The reduction factor for slender compression elements, Q, is computed as fol-
lows:

0=0Q.0., (AISC E7)

where Qs and Q. are reduction factors for slender unstiffened compression el-
ements (flanges of 1-Shapes, T-Shapes, Double Angles, Channels, and Double
Channels; legs of angles; and stems of T-Shapes) and slender stiffened com-
pression elements (webs of I-Shapes, Channels, and Boxes; and Pipe sections),
respectively. For cross-sections composed of only unstiffened slender ele-
ments, Q = Qs (Qa = 1) and for cross-sections composed of only stiffened slen-
der elements, Q = Qa (Qs=1).

The reduction factor, Qs, for slender unstiffened elements is defined as follows:

3.5.223.1 Flange of I-Shape, T-Shape, Channel and Double Channel
Sections

Rolled:
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1.0, if E<056/
F
Q,=<1.415- 074(bj <
E
0'69E2, if —>1 03 |—
b F
F . y
(¢) "
Built-Up:
1.0, if E<064
Q, =41.415- 065 y if 0.64
0.90Ek, , if ?>117 F
b \j
6 y
where k —L and 0.35<k.<0.76
© b, o

and b/t is defined as

—~ | T

b, /tf
b, /tf

if 0.56 /—< <1.03 /— and

(b,/2t;) for I Shapes,

(b /2t,) for T Shapes,

for Channels,

for Double Channels.

\/ﬁ

(AISC E7-4, E7-5, E7-6)

—<1 17 ,

(AISC E7-7, E7-8, E7-9)

(AISC E7.1b)

(AISC B4.1a, E7.1)
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3.5.2.23.1.1 Legs of Single and Double Angle Sections

1.0, if 9<045 \F
o) [F .
QSZ 1.34—0.76[Tj\/;, if 045\/7 —<091\/: and

053E if —>091\F
(1) -

(AISC E7-10, E7-11, E7-12)

where b is the full width of the longest leg, and t is the corresponding thickness
(AISC B4.1b, E7.1c).

3.5.2.23.1.2 Stem of T-Sections

1.0, if 9<o75 /E
F
Q= 1.908-1.22@, if 075\/:< <1.03 /— and
0'69E2, it 951, 03/
. (dj t F’

(AISC E7-13, E7-14, E7-15)

where d is the full nominal depth of the tee and t is the thickness of the element
(AISC B4.1d).

For T-Shapes, the Qs is calculated for the flange and web separately, and the
minimum of the two values is used as Qs. For Angle and Double Angle sec-
tions, Qs is calculated based on the leg that gives the largest b/t and so the

smallest Q.

The reduction factor, Qa, for slender stiffened elements is defined as follows:
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Q. =ﬁ, (AISC E7-16)

A

where A is the total cross sectional area of the member, and A is the summa-
tion of the effective areas of the cross-section,

Aef‘fZA_z (b_ be)t,

based on the reduced effective width, be, which is determined as follows.

3.5.2.2.3.1.3  Webs of | -Shapes, Channels, and Double Channels

102t [E11-934 Bl if Poiag (B and
f1° (b/t)VF t f

b, if E<1.49\/E,
t f

b =

e

(AISC E7-17)

where f is taken as F¢ with Q = 1.0 (AISC 7.2a), and b is taken for rolled
shapes as the clear distance between flanges less the corner radius, and is taken
for welded shapes as the clear distance between flanges.

3.5.2.2.3.2 Webs and Flanges of Box Sections

1.92t [ 1-E\/E <b, if 251405 and
X f1° (bt)VF t f
b, if 2140 [
t F,

where f is conservatively taken as Fy (AISC 7.2b). The flange, b, is taken as
br — 3tw, and for webs, b is taken as h — 3t (AISC B4.1d). The design wall
thickness is modified for the welding process (AISC B3.12)

(AISC E7-18)

3.5.2.2.3.3 Pipe Sections
The reduction factor for slender stiffened elements is given directly by:
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10, if D/t<011 =,
Fy
Q,—Q={20%8E .2 4t 011E P 045 E and (AIsCET-19)
F,(D/t) 3 Fot F,
10, if D/t>045L=,
Fy

where D is the outside diameter and t is the wall thickness. The design wall
thickness is modified for the welding process (AISC B3.12). If D/t exceeds

0.45E/F,, the section is considered to be too slender and it is not designed.

Nominal Flexure Strength

This section applies to members subject to simple bending about one principal
axis. The members are assumed to be loaded in a plane parallel to a principal
axis that passes through the shear center, or restrained against twisting.

The design flexural strength, ¢oM,, and the allowable flexural strength,
M, /£,, are determined using the following resistance and safety factors:

¢ =0.90 (LRFD) (AISC F1(1))
Qy = 1.67 (ASD) (AISC F1(1))

When determining the nominal flexural strength about the major principal axis
for any sections for the limit state of lateral-torsional buckling, it is common to
use the term C,, the lateral-torsional buckling modification factor for non-
uniform moment diagram. Cy, is calculated as follows:

C, = 12.5M R, <3.0, (AISC F1-1)
25M,,, +3M, +4M; +3M,
where,
Mmax = absolute value of maximum moment in unbraced segment, kip-in.
(N-mm)
Ma = absolute value of moment at quarter point of the unbraced seg-

ment, Kip-in. (N-mm)
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Mg = absolute value of moment at centerline of the unbraced segment,
kip-in. (N-mm)
Mc = absolute value of moment at three-quarter point of the unbraced

segment, Kip-in. (N-mm)

Rm = cross-section monosymmetry parameter
= 1.0, doubly symmetric members
= 1.0, singly symmetric member subject to single curvature bending

2

| . . .

= 0.5+2(I—V°J , singly symmetric members subjected to reverse
y

curvature bending

I, = moment of inertia about the principal y-axis, in.* (mm?*)
lye = moment of inertia about y-axis referred to the compression flange,
or if reverse curvature bending, referred to the smaller flange, in.*
(mm)
1.0, for Double Channel, Box, Pipe, and

doubly symmetric | Shapes,

1.0, for Channel, Tee, Double Angle and singly symmetric
R, = | Shapes subjected to curvature bending, and
2

I
05+2 % , for Channel, Tee, Double Angle, and singly symmetric

y | Shapes subjected to reverse curvature bending.

If the member is under tension and if the section is doubly symmetric, Cy is in-
creased by a factor fc, where Ra is given as follows:

P,

1+ (LRFD)
R, = ” (AISC H1.2)

LI (as)

ey

Cyo should be taken as 1.0 for cantilevers. However, the program is unable to
detect whether the member is a cantilever. The user should overwrite Cy, for
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cantilevers. The program also defaults Cy to 1.0 if the minor unbraced length,
I, is redefined to be more than the length of the member by the user or the
program, i.e., if the unbraced length is longer than the member length. The
Overwrites can be used to change the value of C, for any member.

The nominal bending strength depends on the following criteria: the geometric
shape of the cross-section; the axis of bending; the compactness of the section;
and a slenderness parameter for lateral-torsional buckling. The nominal bend-
ing strength is the minimum value obtained according to the limit states of
yielding, lateral-torsional buckling, flange local buckling, web local buckling,
tension flange yielding as appropriate to different structural shapes. The fol-
lowing sections describe how different members are designed against flexure
in accordance with AISC Chapter F. AISC, in certain cases, gives options in
the applicability of its code section, ranging from F2 to F12. In most cases, the
program follows the path of the sections that gives more accurate results at the
expense of more detailed calculation. In some cases, the program follows a
simpler path. For an easy reference, Table 3-2 shows the AISC sections for the
various scenarios.

Table 3.2 Selection Table for the Application of Chapter F Sections

Section in Flange Web
Chapter F Cross Section Slenderness Slenderness Limit States
——3 ¢
F2 ﬂhi } C C Y,LTB
F3 —T NC, S C LTB, FLB
F4 / C,NC, S NC Y,LTB, FLB
F5 —T C,NC, S S Y, LTB, FLB

F4 C,NC, S C,NC Y, LTB, FLB, TFY
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Table 3.2 Selection Table for the Application of Chapter F Sections

Section in Flange Web
Chapter F Cross Section Slenderness Slenderness Limit States
==
F5 C,NC, S S Y, LTB, FLB, TFY
I

F6 C,NC, S Any Y, FLB
F7 % C,NC, S C,NC Y, FLB, WLB
F8 @ N/A N/A Y, LB
F9 _“_ I C,NC, S Any Y, LTB, FLB
F10 | /\ N/A N/A Y,LTB, LLB
F11 . I N/A Any Y,LTB
F12 Unsymmetrical shapes N/A N/A All limit states

Y = yielding LLB = leg local buckling

LTB = lateral-torsional buckling LB = local buckling

FLB = flange local buckling C = compact or seismically compact

WLB = web local buckling NC =noncompact

TFY =tension flange yielding S = slender

3.5.3.1 Doubly Symmetric I-Sections

3.5.3.1.1 Major Axis Bending

The nominal flexural strength for major axis bending depends on compactness
of the web and flanges.

3.5.3.1.1.1 Compact Webs with Compact Flanges

The nominal flexural strength is the lowest value obtained according to the
limit states of yielding (plastic moment) and lateral-torsional buckling.
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3531111 Yielding
Mn = Mp = FyZSS,

where, Zs3 is the plastic section modulus about the major axis.

3.5.3.1.1.1.2 Lateral-Torsional Buckling

ifL, <L,

if Lp >L,,

(AISC F2-1)

L, -L
M = C{Mp—(Mp—O.YFyS%){Lb_LPJ]s M,, ifL <L, <L, and

(AISC F2-1, F2-2, F2-3)

where, Sss is the elastic section modulus taken about the major axis, Ly is the
unbraced length, L, and L, are limiting lengths, and F is the critical buckling

stress. Fer, Lp, and L, are given by:

g LY
F-GrE \/1+0.078 I (—bJ ,
i Sghy \ T

r

ts

L, =1.76r, | =,
Fy

0.7F
L —195r —— |- 14 [1+6.76) ——x
0.7F, | Sh E Jc

33°°0

c=1,and

ho is the distance between flange centroids.
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3.5.3.1.1.2 Compact Webs with Noncompact or Slender Flanges

The nominal flexural strength is the lowest value obtained from the limit states
of lateral-torsional buckling and compression flange local buckling.

3.5.3.1.1.21 Lateral-Torsional Buckling

The provisions of lateral-torsional buckling for "Compact Web and Flanges" as
described in the provision pages also apply to the nominal flexural strength of
I-Shapes with compact webs and noncompact or slender flanges bent about
their major axis.

M. if L<L,,

L, -L, _
M, =4C,| M, —(M, -0.7F,S ;) T | [EMe i Ly <Ly <L and

if L >L,.
(AISC F3.1, F2-1, F2-2, F2-3)

3.5.3.1.1.2.2 Compression Flange Local Buckling

.
Mp—(Mp—O.YFyS%) | for noncompact flanges,
f

Mn _ rf p
m' for slender flanges,
A

(AISC F3-1, 3-2)

where A, Ay, and A are the slenderness and limiting slenderness for compact
and noncompact flanges from Table 3.5, respectively,

hy =0.38 /FE (AISC Table B4.1, F3.2)
y
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10 /FE (Rolled),
Ay = ’ (AISC Table B4.1, F3.2)

0.95 k;—E (Welded),

L

and k. is given by

4
k., = —=, 0.35<k:<0.76. AISC F.3.2

"I, ( :
3.5.3.1.1.3 Noncompact Webs with Compact, Noncompact and Slender

Flanges

The nominal flexural strength is the lowest values obtained from the limit
states of compression flange yielding, lateral-torsional buckling, and compres-
sion flange local buckling.

3.5.3.1.13.1 Compression Flange Yielding
Mn = RpcMy, (AISC F4-1)

where, Ry is the web plasticity factor, which is determined as follows:

—£, it A<k,

Ry
My (Mo gl 2=Po Mo e o
M, (M Apy — M, P

(AISC F4-9a, F4-9b)

Mp = ZasFy < 1.6Ss3Fy (AISC F4-2)
Ssz = elastic section modulus for major axis bending

A =D (AISC F4.2, Table B4.1)

t,

N
I

A, the limiting slenderness for a compact web, as given in
Table 3-5 (AISC Table B4.1)

pw
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Anw = Ar, the limiting slenderness for a noncompact web, as given in
Table 3-5 (AISC Table B4.1)

and My is the yield moment, which is determined as follows:

M, = SsF, (AISC F4-1)
3.5.3.1.1.3.2  Lateral-Torsional Buckling
R.M,, if L,<L,
L, -L, _
M, =4C,| R, .M, —(R,:M, ~FSy,) T |[SRaMys I Ly <Ly <L,
r p
F, Sy <R M, if L,>L,
(AISC F4-1, F4-2, F4-3)
where,
2 2
£ ST E \/1+ 0,078 [i] (AISC F4-5)
ﬁ 33l \ T
I
bf
r = 2 (AISC F4-10)
h, 1_ h
12 04 a -
J [ d 6™ hodJ
h.t
a, =—"<10 (AISC F4-11)
bftf

AISC F4.2
0, if I,/1,<0.23 ( )

L, =11, /FE (AISC F4-7)
y

2
L =1.95r £ |3 \/1+ \/1+ 6.76(%533—“’} (AISC F4-8)

L 33

. :{1, if 1,,/1,>0.23
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F. =0.7F, (AISC F4-63)

Rpc = web plastification factor, which is determined using a formula de-
scribe previously (AISC F4-9)

I, =moment of inertia of the compression flange about the minor axis

I, =moment of inertia of the entire section about the minor axis.

3.5.3.1.1.3.3 Compression Flange Local Buckling

where,

FL

ke

7\4rf

R,.M,, if flanges are compact,
- .
Ry.M, —(R,cM, —F,Sg;) — | if flanges are noncompact, and
o~ vpt
&ECS”, if flanges are slender,
A
(AISC F4-1, F4-12, F4-13)
= 0.7Fy (AISC F4-6a, F4.3)
= is the web plastification factor, which is determined using a formu-
la described previously (AISC F4-9, F4.3)
- \/h4/T . 35<k <076 (AISC F4.3, Table B4.1)
_ b

= Ap, the limiting slenderness for compact flange, as given in Table
3-5 (AISC Table B4.1, B4.3)

= r, the limiting slenderness for noncompact flange, as given in Ta-
ble 3-5 (AISC Table B4.1, B4.3).
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3.5.3.1.1.4 Slender Webs with Compact, Noncompact, and Slender
Flanges

The nominal flexural strength is the lowest value obtained from the limit states
of compression flange vyielding, lateral-torsional buckling, and compression
flange local buckling.

35.3.1.14.1 Compression Flange Yielding
M = RngySSS. (A|SC F5-1)

where Ry is the bending strength reduction factor given by

S SR VI LS L0 P (AISC F5-6)
=77 1200+ 300a, | t, F,
ht,
a,=p-<10, (AISC F5.2, F4-11)

frf

where hy is the distance between flange centroids (AISC F2.2).

3.5.3.1.1.4.2 Lateral-Torsional Buckling
M = RngchS3, (A|SC F5-2)

where F is the critical lateral-torsional buckling stress given by

F, if L,<L,,

L,-L _
F, = Cb[Fy—(O.SFy)[Lh L”HsFy, if L <L,<L,and

<F, if L,>L,

(AISC F5-1, F5-3, 5-4)

where,
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L, =1r [ = (AISC F5.2, 4-7)
y
L = |—= (AISC F5-5)
0.7F,
b
[ = , (AISC F5.2, F4-10)

t
hy 1_ h?
12| 2+>a, —
\/ [ d 6" hod]
Rpg is the bending strength reduction factor, which has been described in the

previous section.

3.5.3.1.14.3 Compression Flange Local Buckling
M = RngchS3, (A|SC F5-7)

where F is the critical buckling stress given by

K. if flanges are compact,

A=A
F = {F —~(0.3F )[ﬁﬂ if flanges are noncompact, and
rf — MVpf

cr
p

S<F, if flanges are slender,

(AISC F5-1, F5-8, F5-9)

and A, Apr, and A, are the slenderness and the limiting slenderness ratios for
compact and noncompact flanges from Table 3.5, respectively, and k. is given

by

k. = _4 where 0.35 < k. < 0.76. (AISC 5.3)

Coh,
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3.5.3.1.2 Minor Axis Bending

The nominal flexural strength is the lower value obtained according to the limit
states of yielding (plastic moment) and flange local buckling.

3.5.3.1.21 Yielding
Mn = Mp = FyZZZ S 1.6Fy822, (AISC F6‘1)

where Sy, and Zy, are the section and plastic moduli about the minor axis, re-
spectively.

3.5.3.1.2.2 Flange Local Buckling
M, for compact flange,

-
M = Mp—(Mp—OJFySZZ) 3 . for noncompact flanges, and

rf pf
F.S,,, for slender flanges,
(AISC F6-1, F6-2, F6-3)

where,

(AISC 6-4)

A=—1t (AISC F6.2)

and Apr and A are the limiting slendernesses for compact and noncompact
flanges, respectively, as described in Table 3-5 (AISC B4.1).

3.5.3.2 Singly Symmetric |-Sections

3.5.3.2.1 Major Axis Bending

The nominal of flexural strength for major axes bending depends on compact-
ness of the web and flanges.

3.5.3.21.1 Compact and Noncompact Webs with Compact, Noncompact
and Slender Flanges

The nominal flexural strength is the lowest values obtained from the limit sates
of compression flange yielding, lateral-torsional buckling, compression flange
local buckling, and tension flange yielding.
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3.5.3.2.1.2 Compression Flange Yielding

M = RpcMyc.

(AISC F4-1)

where, Ry is the web plasticity factor, which is determined as follows:

K

Arw

—+, if A<,

pc =
M M A=A M
P —t-1 <=2 0 A, <Ay SAg,
M M Aew — A M

(AISC F4-9a, F4-9b)

ZasFy < 1.6S53cFy (AISC F4-2)

elastic section modulus for major axis bending referred to
compression flange

elastic section modulus for major axis bending referred to ten-
sion flange

?—° (AISC F4.2, Table B4.1)
Ap, the limiting slenderness for a compact web, as given in
Table 3-5 (AISC Table B4.1)

Ar, the limiting slenderness for a noncompact web, as given in
Table 3-5 (AISC Table B4.1)

and My is the yield moment for compression flange yielding, which is
determined as follows:

Myc = S33(;Fy. (AISC F4‘1)
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3.5.3.2.1.3 Lateral-Torsional Buckling

where,

RyM,..

if L,<L,

L, -L

C{RpcMyc—(RpCMyC—FLS%C)(L _Lp}]g R.M,, if L <L <L,

FchSSC < RpcMyc'

r p
if L,>L,,
(AISC F4-1, F4-2, F4-3)

2 2
F, = Cym 'f \/1+ 0.078“"—°[ij (AISC F4-5)
L, 33l \ I
I
bfc
r = 2 (AISC F4-10)
h, 1 h
12| 2+ ~a, ——
J [d 6™ hyd
ht
a, =—* <10 (AISC F4-11)
bfetfc
1 if 1,/1,>023
C= _ (AISC F4.2)
0, if 1,/1,<0.23
[E
L, =11, |— (AISC F4-7)
Fy
2
L, =1.95rt£ L\/h \/1+6.76(EMJ (AISC F4-8)
L 33'% E ‘]
0.7F,, if%zo.Y
F = s 3330 (AISC F4-6a, F4-6b)
“BLE >05F, if-2-<07

33c

33c
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Ry = web plastification factor, which is determined using a formula
describe previously (AISC F4-9)

Iy = moment of inertia of the compression flange about the minor axis
Iy = moment of inertia of the section about the minor axis.

3.5.3.2.1.4 Compression Flange Local Buckling

RpcM,., if flanges are compact,

M, =4[ RpeM,, —(R My — FL833C)[X—m]], if flanges are noncompact, and
t

rf pi

O'gE—k;S33°, if flanges are slender,
A
(AISC F4-1, F4-12, F4-13)
where,
F. = isacalculated stress, which has been defined previously
(AISC F4-6a, F4-6b, F4.3)
Rpc = is the web plastification factor, which is determined using a

formula described previously (AISC F4-9, F4.3)

ke = \/;T 35<k:<0.76 (AISC F4.3, Table B4.1)
Ly
7\’ - be
At = Ap, the limiting slenderness for compact flange, as given in
Table 3-5 (AISC Table B4.1, B4.3)
Ai = Ar, the limiting slenderness for noncompact flange, as given

in Table 3-5 (AISC Table B4.1, B4.3).

3.5.3.2.1.5 Tension Flange Yielding

" _{Mp, if Sy > Sage

. (AISC F4-14)
RuM,, if Sgp < Sy
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where, Ry is the web plastification factor corresponding to the tension flange
yielding limit state. It is determined as follows:

if <,

where,

Sazc

Saat

Aw

Arw

353216

A=A .
P W Ry <A< Ay
yt krw_}\'pw

(AISC F4-15a, F4-15b)

= ZaF, (AISC F4-2)

elastic section modulus for major axis bending referred to
compression flange

elastic section modulus for major axis bending referred to ten-
sion flange

he (AISC F4.2, Table B4.1)

t

\

Ap, the limiting slenderness for a compact web, as given in
Table 3-5 (AISC Table B4.1)

Ar, the limiting slenderness for a noncompact web, as given in
Table 3-5. (AISC Table B4.1)

Slender Webs with Compact, Noncompact and Slender Flang-
es

The nominal flexural strength is the lowest value obtained from the limit states
of compression flange yielding, lateral-torsional buckling, compression flange
local buckling, and tension flange yielding.

3532161

M = RngyS3SC,

Compression Flange Yielding

(AISC F5-1)

where, Ry is the bending strength reduction factor given by
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R o—1-— & M B g (AISC F5-6)
" =7 1200+300a, | t, F,
a, - ;ttw <10 (AISC F5.2, F4-11)
frf

where, ho is the distance between flange centroids (AISC F2.2).

3.5.3.2.1.6.2 Lateral-Torsional Buckling
M = RngchS3c, (A|SC F5-2)

where, F is the critical lateral-torsional buckling stress given by

F, if L,<L,,
L,-L
F, = Cb[Fy—(0.3Fy)[Lh_L“HsFy, if L,<L,<L,and
r p
2
STE E if L>L,

(AISC F5-1, F5-3, 5-4)

where,

r (AISC F5.2, 4-7)

F
t Fy
E
| (AISC F5-5)
0.7 Fy
b

I = e (AISC F5.2, F4-10)
\/12(

h 1 K
—+—a
d 6" hd

L, =11
L, =mr,
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Rpg is the bending strength reduction factor, which has been described
in a previous section.

3.5.3.21.6.3 Compression Flange Local Buckling
M = RngchS3c, (A|SC F5-7)

where, F is the critical buckling stress given by

F ., if flanges are compact,

a-a, Y]
F,=1|F, —(O.SF ) ﬁ—p , if flanges are noncompact, and
rf

pf

S<F, if flanges are slender,

(AISC F5-1, F5-8, F -9)

and A, Ay, and A, are the slenderness and the limiting slenderness ratios for
compact and noncompact flanges from Table 3.5, respectively, and k. is given

by

k., = 4
Vi,
3.5.3.2.1.6.4 Tension Flange Yielding
{Mp if S; >S,,.,
" F S if Sy < Sa.

, wWhere 0.35 < k. <0.76. (AISC5.3)

(AISC F5-10)

3.5.3.2.2 Minor Axis Bending

The nominal flexural strength is the lower value obtained according to the limit
states of yielding (plastic moment) and flange local buckling.

3.5.3.22.1 Yielding
Mn = My = Fy Zo2 < 1.6Fy S, (AISC F6-1)
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where, Sy and Z», are the section and plastic moduli about the minor axis, re-
spectively.

3.5.3.2.2.2 Flange Local Buckling

M o for compact flange,

n

=Ny
M, =4M, —(M, -0.7FS,,) -5 | fornoncompact flanges, and
f

rf pi
F.S,,, for slender flanges,

(AISC F6-1, F6-2, F6-3)

where,
0.69E
Fa =" (AISC 6-4)
b, b
A =max{— (AISC F6.2)
ttb tﬂ

and Ay and A« are the limiting slendernesses for compact and noncompact
flanges, respectively, as described in Table 3-5 (AISC B4.1).

3.5.3.3 Channel and Double Channel Sections

3.5.3.3.1 Major Axis Bending

The nominal flexural strength is the lowest value obtained according to the
limit states of yielding (plastic moment), lateral-torsional buckling, and com-
pression flange local buckling.

3.5.3.3.1.1 Yielding
Mn = M, =Fy Zs3, (AISC F2-1)

where Zs; is the plastic section modulus about the major axis.
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3.5.3.3.1.2 Lateral-Torsional Buckling
M., if L,<L,,

L, -L
M, = C{Mp—(Mp—O.YFyS%){Lb_LPJ]s M, if L, <L, <L,, and

if Lp >L,,

(AISC F2-1, F2-2, F2-3)

where Ss3 is the elastic section modulus taken about the major axis, Ly is the
unbraced length, L, and L, are limiting lengths, and F is the critical buckling
stress. Fer, Lp and L, are given by

2 2
F =2t \/1+ 0,078 (i] (AISC F2-4)

2
5 33'l

r

ts

L, =176r, | = (AISC F2-5)
Fy

0.7F ’
L =1.95r, 07i o \/1+ \/1+ 6.76[?3%*‘0j (AISC F2-6)
. C

y S33ho
where
2 |YCW
r.’ = (AISC F2-7)
833

1 for Double Channel sections

C=:{n /I ] (AISC F2-8a, F2-8b)
?" C_y for Channel sections

and hy is the distance between flange centroids.
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3.5.3.3.1.3 Compression Flange Local Buckling

The nominal strength for compression flange local buckling is determined
based on whether the web is compact, noncompact, or slender.

If the web is compact,

M iy for compact flanges,

A
M, =M, —(Mp _0'7FVS33)[ﬁ} for noncompact flanges, and
f

rf p

%' for slender flanges,
A
(AISC F2-1, F3-1, F3-2)

if the web is noncompact,

R.M,, for compact flange,

M, ={R. .M, —(R,:M, - FLS33)[X—”J, for noncompact flanges, and
f

rf p

0.9Ek S,

2 for slender flanges,

(AISC F4-1, F4-12, F4-13)
and if the web is slender,
M, = RngchSS (A|SC F5-7)

where, Fis the critical buckling stress give by

K, if flanges are compact,

A=A
F. =1F, —(O.SFy)(k—pf}, if the flanges are noncompact,
f

rf pi

O'ifkc <F, if the flanges are slender,

where,
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(=2

f
L

A =

N

Aot = Ap, the limiting slenderness for compact flange, as given in Table
3-5 (AISC Table B4.1, B4.3)

Mt =Ar, the limiting slenderness for noncompact flange, as given in
Table 3-5 (AISC Table B4.1, B4.3)

ke = \/h4/_, 35<k.<0.76 (AISC F4.3, Table B4.1)
L
F. =07F (AISC F4-6a, F4.3)
M
Wﬁ’ if A, <A,

e = Im (m A=A M
— PR g — 2|2, if A, <A, <Ay,
M, (M Ay — Ao ||~ M

(AISC F4-9a, F4-9Db)

Ry = 1-— 2 [N 57 /E 1 gy (AISC F5-6)
1200+ 300a, | t, F,

Ssz = elastic section modulus for major axis bending,

o

t

\

Apw = Ap, the limiting slenderness for compact web, as given in Table 3-5
(AISC Table B4.1)

Amw = Ar, the limiting slenderness for a noncompact web, as given in
Table 3-5 (AISC Table B4.1)

Rpg is the bending strength reduction factor, which has been described in a
previous section.
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3.5.3.3.2 Minor Axis Bending

The nominal flexural strength is the lower value obtained according to the limit
states of yielding (plastic moment) and flange local buckling.

3.5.3.3.21 Yielding
Mn = Mp = FyZZZ S 1.6Fy822 (AISC F6‘1)

where, S and Zy, are the section and plastic moduli about the minor axis, re-
spectively.

3.5.3.3.2.2 Flange Local Buckling
M., for compact flange,

-y
M = Mp—(Mp—OJFySZZ) A ,  for noncompact flanges, and

rf pf
F.S,,, for slender flanges,
(AISC F6-1, F6-2, F6-3)

where,
F, = O'i?E (AISC 6-4)
bf
X=? (AISC F6.2)

and Ay and A« are the limiting slendernesses for compact and noncompact
flanges, respectively, as described in Table 3-5 (AISC B4.1).

3.5.3.4 Box Sections

This section applies to Box sections with compact or noncompact webs and
compact, noncompact or slender flanges, bent about either axis. The program
uses the same set of formulas for both major and minor direction bending, but
with appropriate parameters.

The nominal flexural strength is the lowest value obtained according to the
limit states of yielding (plastic moment), flange local buckling and web local
buckling.
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3.5.3.4.1 Yielding
M =M, = F,Z, (AISC F7-1)

where, Z is the plastic section modulus about the axis of bending.

3.5.3.4.2 Flange Local Buckling

M, for compact flanges,
L < f fl
M =4M, —(I\/Ip - FyS) 3.57? E -4.0|<M, for noncompact flanges, and
F S for slender flanges,

(AISC F7-1, F7-2, F7-3)

where, Serr IS the effective section modulus determined using the effective com-
pressive flange width, be,

b, =102t [£[1-038 |E | (AISC F7-4)
F |~ bty\F

See the "Reduction Factor for Slenderness” section for details (AISC F7, E7.2).

3.5.3.4.3 Web Local Buckling

M, for compact webs, and

h /F
M, =M, —(Mp - Fys3s)(0.305t— Ey —0.738] <M,, for noncompact webs,

F
M, —(M, - |=y333)[0.305tﬂ1 /Ey - 0.738} <M,, for slender webs.
(AISC F7-1, F7-5)

Note that the code does not cover the Box section flexure strength if the web is
slender. The program uses the same flexure strength formula for Box sections
with noncompact and slender webs, even though the formula applies only to
noncompact section.
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3.5.3.5 Pipe Sections

This section applies to pipe sections with D/t ratio less than 0-45E

. If a Pipe

section violates this limit, the program reports an error.

The nominal flexural strength is the lowest value obtained according to the
limit states of yielding (plastic moment) and local buckling. The same set of
formulas is used for both major and minor axes of bending.

3.5.3.5.1 Yielding
Mn =M, = F,Z (AISC F8-1)

3.5.3.5.2 Local Buckling

M., for compact sections,
0.021E _
M, = 5t F, |S, for noncompact sections, and (AISC F8-1, F8-2, F8-3)
t
F.S, for slender sections,

where, S is the elastic section modulus and F is the critical buckling stress,
where,

F - %. (AISC F8-4)
t

3.5.3.6 T-Shapes and Double Angle Sections

3.5.3.6.1 Major Axes Bending

The nominal flexural strength for T-Shapes and Double Angles bent about their
major (3-3) axis, i.e., the axis perpendicular to the axis of symmetry, is taken as
the lowest value obtained according to the limit states of yielding (plastic mo-
ment), lateral-torsional buckling, and flange local buckling.
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3.5.3.6.1.1 Yielding

M {M o =FZ; <M, for stems in compression, and

M, =FZ;<16M,,  forstemsin tension.

(AISC F9-1, F9-2, F9-3)

3.5.3.6.1.2 Lateral-Torsional Buckling

n JEl GJ
M =M, :L—V[B+\/1+ BZ] (AISC F9-4)
b
where, B is taken conservatively as:
d |
B= iZ.B(—J Ty (AISC5 F9-5)
b

The plus sign for B applies when the stem is in tension (M > 0) and the minus
sign applies when the stem is in compression (M < 0).

3.5.3.6.1.3 Flange Local Buckling

When the flange is under compression (i.e., when the factored moment M; is
positive), the nominal moment capacity is taken as follows:

Mn = FerSxe, (AISC F9-6)

where. Sy is the elastic section modulus about the compression flange, and Fer
is determined as follows:

F, for compact sections,

F
F, = Fy[l.19 - O.50(b/t)4/—y} for noncompact sections, and
E

0.69E
(b)"

for slender sections,

(AISC F9-1, F9-7, F9-8)

where,
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b b
—=—, (for T-Shapes
Co, ( pes)

% = ?_f (for Double Angles)
f

and by and t; are described in Figure 3-1.

When the flange is in tension, i.e., when the factored moment M, is negative,
this limit state is not considered in the program.

3.5.3.6.2 Minor Axes Bending
The nominal flexural strength for T-Shapes and Double Angles bent about their
minor (2-2) axes, i.e., the axis of symmetry, is taken as the lowest value ob-
tained according to the limit states of yielding (plastic moment) and flange lo-
cal buckling.
3.5.3.6.2.1 Yielding
Mn = Mp = FyZZZ S 1.6Fy822 (AISC F6‘1)
where, S and Z, are the section and plastic moduli about the minor axis, re-
spectively.
3.5.3.6.2.2 Flange Local Buckling

M for compact flange,

-
M = Mp—(Mp—OJFySZZ) - . for noncompact flanges, and

rf pf

F.S,, for slender flanges,
(AISC F6-6)
where,
F - O.G?E (AISC 6-4)
A

b
A= j (for T-Shapes)

f
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b
A= t—‘ (for Double Angles)

f

and Ay and A, are the limiting slendernesses for compact and noncompact
flanges, respectively, as described in Table 3-5 (AISC B4.1).

3.5.3.7 Single Angle Sections

The nominal flexural strength of angle sections is conservatively calculated
based on the principal axes of bending. The nominal flexural strength about the
major principal axis is the lowest value obtained according to the limit states of
yielding (plastic moment), lateral-torsional buckling, and leg local buckling.

3.5.3.7.1 Yielding
M, = 1.5My, (AISC F10-1)
where, My is the yield moment about the axis of bending.

3.5.3.7.2 Lateral-Torsional Buckling

The nominal flexure strength for bending about the major principal axis for the
limit state of lateral-torsional buckling is given as follows:

(0.92—0']"\;M9]M , if M,<M,,and

e
y

e

M
[0.92—1.17 —yJI\/I <15M, if M,>M,
M y y e y

(AISC F10-2, F-10-3)
where Mc is the elastic lateral-torsional buckling moment defined as follows:

0.46Eb’t’C,

3 for equal-leg angles,

2
° |4.9EIC
sz \/Bi+o_o5g[%J +B,, | for unequal-leg angles.

(AISC F10-5,6)

where,
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Cv = lateral-torsional buckling modification factor for nonuniform mo-
ment diagram. It is computed using equation AISC F1-1. A limit on
Cp is imposed (Cp < 1.5) in the program (AISC F10).

L = laterally unbraced length of the member. It is taken as the max(Lz,
Lss) in the program because L and Lsz are not defined in the princi-
pal direction, in. (mm).

I = minor principal axis moment of inertia, in.* (mm?),
r. = radius of gyration for the minor principal axis, in. (mm),
t  =angle leg thickness, in. (mm). It is taken as min(ty, tr)

w = asection property for unequal-legged angles. It is given as follows:

B, zli [2(w? +22)da-2z, (AISC Table C-F10.1)
W A

Bw is positive for short leg in compression, negative for long leg in
compression, and zero for equal-leg angles. If the long leg is in com-
pression anywhere along the unbraced length of the member, the
negative value of Bw should be used (AISC F10.2). It is conservative-
ly taken as negative for unequal-leg angles.

z = coordinate along the minor principal axis
w = coordinate along the major principal axis

Zo = coordinate of the shear center along the z-axis with respect to
the centroid

lw = major principal axis moment of inertia
I, = minor principal axis moment of inertia.

In the preceding equation, My is taken as the yield moment about the major
principal axis of bending, considering the possibility of yielding at the heel and
both of the leg tips.
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The nominal flexural strength for bending about the minor principal axis for
the limit state of lateral-torsional buckling is not needed because the limit state
of lateral-torsional buckling does not apply for minor axis bending.

3.5.3.7.3 Leg Local Buckling

The nominal flexural strength for bending about the major and minor principal
axes of single angle sections for the limit state of hy local buckling are given as
follows:

15FS, if compact,
b F .
M, FS.|243-1.72 TINE if noncompact, and
0'7—1F;Sc if slender,
(b/t)

(AISC F10-7, F10-8, F10-9)
where,

S¢ = elastic section modulus to the toe in compression relative to the axis
of bending

t = thickness of the leg under consideration
b = outside width of the leg under consideration.

In calculating the bending strengths for single-angles for the limit state of leg
local buckling, the capacities are calculated for both the principal axes consid-
ering the assumption that either of the two tips (toes) can be under compres-
sion. The minimum capacities are considered.

3.5.3.8 Rectangular Sections

This section applies to rectangular sections bent about either axis.

The nominal flexural strength is the lowest value obtained according to the
limit states of yielding (plastic moment) and lateral-torsional buckling.
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3.5.3.8.1 Yielding
Mn =M, = FyZ < 1.6M, (AISC F11-1)

3.5.3.8.2 Lateral-Torsional Buckling

Limit state of lateral-torsional buckling does not apply to rectangular sections
bent about their moving axis. For rectangular sections, M, about major axis, is
given by the following:

. L :
v If%dSOOSE,
t F
F
M, =1C,|1.52-0.274 'de Sim em, if 28E Lbzd <19E
tt JE| 7P Fooot F,
. Ld_19E
Fch33—Mp’ If L2> Fy ’

(AISC F11-1, F11-2, F11-3)

where, F¢ is the critical buckling stress, which is given by

F, = 1‘9LEdCb , (AISC F11-4)
e

where, t is the width of the rectangular bar parallel to axis of bending; d is the
depth of the rectangular bar; and L, is the length unbraced against lateral dis-
placement of the compression region or twist of the cross-section.

3.5.3.9 Circular Sections

The nominal flexural strength is the value obtained according to the limit states
of yielding (plastic moment).

M,=Mp,=F/Z <1.6M, (AISC F11-1)
For this section, the limit state of lateral-torsional buckling need not be consid-
ered (AISC F11.2(c)).
3.5.3.10 General Sections and Section Designer Sections

For General sections and Section Designer sections, the nominal major and
minor direction bending strengths are assumed as:
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M, = M, = SF,.

The program does not check any lateral-torsional buckling, flange local buck-
ling, web local buckling, or tension flange yielding. The program assumptions
may not be conservative. The user is expected to calculate the capacity and
overwrite it.

Nominal Shear Strength

The nominal shear strengths are calculated for shears along the geometric axes
for all sections. For I-Shape, Box, Channel, Double Channel, T-Shape, Double
Angle, Pipe, Circular and Rectangular sections, the principal axes coincide
with their geometric axes. For Angle sections, principal axes do not coincide
with their geometric axes.

In calculating nominal strength for shear, V,, it is assumed that there is no in-
termedial stiffeners used to enhance shear strength of a section (AISC G2-2).
The code allows the use of one of following methods: (a) the limit state of
shear yielding and shear buckling without using tension-field-action (AISC
G2); and (b) post buckling strength of the member or tension-field-action
(AISC G3). The program uses the first method to calculate shear strengths.

The design shear strength, ¢.Vn, and the allowable shear strength, V, /Q,, are
determined using the following factors.

For all sections in both the major and minor directions, except for the web of
rolled I-Shaped members with h/t, <2.24,/E/F,

¢ =0.9 (LRFD) (AISC G1)
Q, =167 (LRFD) (AISC G1)

For the web of rolled I-Shaped members with h/t, <2.24,/E/F, and for ma-
jor direction shear only

¢ =1.0(LRFD) (AISC G2.1a)
Q, = 1.50 (ASD) (AISC G2.1a)
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3.5.4.1 Shear in the Major Direction

The nominal shear strength for major direction, Vi, is evaluated according to
the limit states of shear yielding and shear buckling

Vo = 0.6F, Ay Cy, (AISC G2-1)

where Ay is the area of the web (overall depth times the web thickness, dty),
and C, is the web shear coefficient. The expressions of Ay and C, differ from
section to section, as follows.

3.5.4.1.1 I-Shapes

For all I-shaped members, Ay is taken as the overall depth of the member times
the web thickness

Aw = dty. (AISC G2.1(b))

For the webs of rolled I-shaped members with h/t,, < 2.241/E/Fy, Cy is taken
as 1.

C =1 (AISC G2-2)

For webs of all other I-shaped members, including both singly and doubly
symmetric and both rolled and welded sections, C, is taken as follows:

. h
. f —<1.10./k E/F
1.0, if <1.10,/k, E/F,,

W

110,k E/F, h
C =q——— 2 if 1.10,/kVE/Fy<¥sl.37 k, E/F,, and

h/t,
1.51Ek . h
St I if —>1.37/k E/F,,
(h/t,)F, t, /

(AISC G2-3, G2-4, G2-5)
where ky is the web plate bucking coefficient and it is taken as
kv =5. (AISC G2.1(b)(i))

In the preceding expression, for rolled shapes, h is taken as the clear distance
between flanges less the fillet or corner radii, and for built-up welded sections,
h, is taken as the clear distance between flanges (AISC G2.1(b), B4.2).
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It should be observed that the ¢, factor, also the Q, factor, differs for the web
of rolled I-shaped members with h/t, <2.24,/E/F, from the web of other I-

shaped members.

3.5.4.1.2 Channel, Double Channel, and T-Shape Sections
A is taken as the overall depth of the member times the web thickness

Aw=dty,  for Channel sections, (AISC G2.1(b))
Ay =2dt, for Double Channel sections, (AISC G2.1(b))
Aw=dty,  for T-Shape sections. (AISC G2.1(b))

C., is taken as follows:

. h
: f —<1.10,/k E/F
1.0, i < [k, E/F,,

W

110k, E/F, h
C,=y—— |if 1.10,/kVE/Fy<Es1.37 [k, E/F,, and

' h/t,
1.51Ek . h
_— if —>1.374/kVE F ,
(h/tw )2 Fy t‘” /

(AISC G2-3, G2-4, G2-5)

where,
ke =5  for Channel and Double Channel sections  (AISC G2.1(b)(i))
ke =1.2 for T-Shape sections (AISC G2.1(b)(1))

and for Channel and Double Channel sections, h is taken as the clear distance
between flanges less the fillet or corner radii (AISC G2.1(b), B4.2); and for T-
Shape sections, h is taken as the overall depth (AISC G2.1(b)).

3.5.4.1.3 Box Sections
Aw is taken as follows:

Aw = 2ht. (AISC G5)

C., is taken as follows:
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ooh
L0, it —<110,Jk E/F,,

W

110k, E/F, h
c, =i —— >, if 110k E/F, <531.37 [k, E/F,. and

' h/t,
—(i/?il)ikﬁ o if %>1.37m ,
(AISC G5, G2-3, G2-4, G2-5)
where,
ke =5 (AISC G5)
h=d- 3t. (AISC Gb)

Note that the design thickness of the Box section can differ by a reduction fac-
tor from its nominal thickness if the welding process is ERW (AISC B3.12).
The choice of reduction and the reduction factor C can be overwritten on a
member-by-member basis.

3.5.4.1.4 Angle Sections
Aw and C, are taken as follows:

Aw = bt (AISC G4)
C,=10 (AISC G4)
where b is the width of the leg resisting the shear force.

3.5.4.1.5 Double Angle Sections
Aw and C, are taken as follows:

A = 2bt (AISC G4)
C, =10 (AISC G4)

where b is the width of the leg resisting the shear force.

3.5.4.1.6 Rectangular, Circular (Round), General and SD Sections

For these sections, Aw is calculated as the effective shear area from the basic
principle of elastic shear distribution, and C, is taken as 1 for simplicity.
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3.5.4.1.7 Pipe Section

The nominal shear strength, V,, of round HSS (i.e, Pipe sections) according to
the limit state of shear yielding and shear buckling is taken as

V,=F, Ag/2 (AISC G6-1)
where,
F. = 0.78E < 0.6F,. (AISC G6-2b)

The code allows F: to be taken as the maximum of two alternate values. The
program conservatively uses one of the two expressions only. In the preceding
equations,

Ay = gross area of section based on design wall thickness
D = outside diameter
t = design wall thickness.

The design wall thickness is equal to 0.93 times the nominal wall thickness for
ERW HSS, and equal to the nominal wall thickness for SAW HSS. However,
the choice of thickness reduction and the reduction factor can be overwritten in
the program on a member-by-member basis.

3.5.4.2 Shear in Minor Direction

The nominal shear strength for minor directions, Vns, is evaluated according to
the limit states of shear yielding and shear buckling as follows:

Vo = 0.6FyAwCy, (AISC G2-1)

where, Ay is the shear area for minor direction shear, and C, is the web shear
coefficient. The expression of A, and C, differs from section to section as fol-
lows.

3.5.4.2.1 I-Shapes, Channel, Double Channel, and T- Shapes
Ay is taken as the sum of flange areas.
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2b,t; Doubly Symmetric I-Shapes
bete + Dty Singly Symmetric I-Shapes
A, =12bt; Channels (AISC G7)
4b;t; Double Channels
bt T Shapes

C., is taken as follows:

. h
1.0 f —<110/k E/F
, if == JE/F,,

W

110,k E/F, h
c, ={———"" if 110,k E/F, <ES1'37 [k, E/F,, and

h/t,
1.51Ek . h
2N i —>1.37./k E/F,,
(ht,)'F, t, /

(AISC G7, G2-3, G2-4, G2-5)

where h/t,, is really meant for flange and is taken as follows,

by /2t | Shapes

b, /t Channels
h_ o/t (AISC G7)
t, |br/t Double Channels

by /2t T Shapes

and ky is taken as 1.2,
ke =1.2. (AISC G7)

All dimensions used in the preceding equation are explained in Figure 3-1. For
Singly Symmetric I-Shapes where each flange has its own properties, the shear
capacity contribution is calculated for each flange separately based on its own
dimensions, and then the combinations are added together.

3.5.4.2.2 Box Sections, Angles, and Double Angles

The shear capacity in the minor direction, Vns, is calculated in exactly the same
way as for calculation of the major shear capacity, Vi2, except that the appro-
priate dimensions are used (AISC G4, G5, G1).
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3.5.4.2.3 Pipe Sections

The shear capacity in the minor direction, Vn3, is exactly the same as that for
major direction (AISC G6).

3.5.4.2.4 Rectangular, Circular (Round), General and SD Sections

For these sections, Ay is calculated as the effective shear area from the basic
principle of elastic stress distribution. C, is taken as 1 for simplicity. Then,
equation G2-1 is used to calculate the shear capacity.

Nominal Torsional Strength

The nominal torsion strengths are calculated for closed sections such as Boxes
and Pipes only. Torsion is ignored in design for all other section types.

The design torsional strength, ¢rT,, and the allowable torsional strength,
T,/Q; , are determined using the following resistance and safety factors:

¢r=0.90 (LRFD) (AISC H3.1)
Qr = 1.67 (ASD) (AISC H3.1)

The nominal torsional strength, T,, according to the limit states of torsional
yielding and torsional buckling, is as follows:

Th=Fe C, (A|SC H3-1)
where C is the torsional shear constant, and F is the critical buckling stress.

For round HSS (i.e., Pipe sections), C is taken conservatively as

_n(D-t)’t

c 2

(AISC H3.1 Note)

Fer is taken as,
Fcr = maX(Fcrl, FCI’Z) S O.6Fy, (AISC H31)

where,
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F = 1.23E and

(o)

_ 0.60E

In the preceding equations,

(AISC H3-2a)

(AISC H3-2b)

L =torsional unbraced length of the member, L ts. This length is taken
as the minor direction unbraced length for flexural buckling, L2, by
default. However, this length can be overwritten in the program.

D = outside diameter of the Pipe section

t = design wall thickness

For regular HSS (i.e., Box sections),

C =2(b, —t,)(d—t, ){min(t,.t, )} -45(4-m){(min(t,t,))’}

0.6F,,
2.45,./E/F
F, = 0.6Fy—/y,
(h/t)
0.458m% ——,
h/t)

(AISC H3.1)

if h/t<2.45 [E/F,,
if 245 /E/F, <h/t<3.07,[E/F, , and

if 3.07,/E/F, <h/t<26.0.

(AISC H3-3, H3-4, H3-5)

The variables b, tw, d, t, h and t used in the preceding expression have been
explained in Figure 3-1. In calculating h/t, the maximum of the ratio of depth

to thickness and width to thickness are considered.

Here t is the design thickness. The design wall thickness is equal to 0.93 times
the nominal wall thickness for ERW HSS and equal to the nominal wall thick-
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3.6.1

ness for SAW HSS. However, the choice of thickness reduction and the reduc-
tion factor can be overwritten in the program on a member-by-member basis.

Design of Members for Combined Forces

Previous sections of this design manual address members subject to only one
type of force, namely axial tension, axial compression, flexure or shear. This
section addresses the design of members subject to a combination of two or
more of the individual forces.

In the calculation of the demand/capacity (D/C) ratios, first, for each station
along the length of the member, the actual member force/moment components
are calculated for each design combination. Then, the corresponding capacities
are calculated. Then, the D/C ratios are calculated at each station for each
member under the influence of each of the design combinations. The control-
ling D/C ratio is then obtained, along with the associated station and design
combination. A D/C ratio greater than the D/C ratio limit (whose default value
is 1.0) indicates exceeding a limit state.

During the design, the effect of the presence of bolts or welds is not consid-
ered.

Doubly and Singly Symmetric Members Subjected to
Flexure and Axial Compression

The interaction of flexure and axial compression in all members with Doubly
Symmetric sections (I-Shapes, Double Channel, Box, Pipe, Solid Circular, Sol-
id Rectangular) and Singly Symmetric sections (Channel, T-Shape, Double
Angle), with some exceptional cases, is given as follows:

For ﬂz 0.2
PC
P8 My My g (AISC H1-1a)
Pc 9 M033 Mc22

For £+ <0.2
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R +(M+MJ <10, (AISC H1-1b)
2Pc Mc33 c22

where, Py and P are the required and available axial strengths; M, and M. are
the required and available flexural strengths; and 3 and 2 represent the strong
and weak axes, respectively.

Depending on the selected design provisions (LRFD or ASD), the aforemen-
tioned terms are defined as follows:

For design according to LRFD provisions:

P. = required axial compressive strength using LRFD load combinations
P. = design axial compressive strength = ¢.Pn

M: = required flexural strength using LRFD load combinations

M¢ = design flexural strength = ¢pM,

dc resistance factor for compression = 0.90

db

For design according to ASD provisions:

resistance factor for flexure = 0.90

Pt = required axial compressive strength using ASD load combinations
P. = allowable axial compressive strength = Pn/Q.

M: = required flexural strength using ASD load combinations

M. = allowable flexural strength = Mn/Qy

Q¢ = safety factor for compression = 1.67

Q, = safety factor for flexure = 1.67

As an exception, for Circular and Pipe sections, an SRSS (Square Root of Sum
of Squares) combination is made first of the two bending components before
adding the axial load component, instead of the single algebraic addition as
implied by the interaction equations given by AISC H1-1a and AISC H1-1b.
The resulting interaction equation is given by the following:

For i >0.2
P

c
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2 2
R + \/[hJ +[h] <1.0.
2Pc Mc33 Mc22
The philosophy behind the preceding modification is that the engineer has the
freedom to choose the principal axis. The engineer can easily choose the prin-
cipal axis to match with the resultant moment so that the design is always
based on the uniaxial bending with axial force. In that case, the moment will be
the resultant (SRSS) moment from the two components. The resultant D/C ra-
tio calculated using the preceding equations will match the calculated D/C ratio
from the pure resultant moment for the Pipe section. The reason is that M, for
the Pipe section is independent of the K and L factors. However, for solic cir-
cular (round) sections, the resultant stress ratio calculated using the preceding
equations will not match exactly with the calculated D/C ratio from the pure
resultant moment because M, for this section depends on the K and L factors,
which are known for only two given principal directions.

As an exception, for members with double symmetric sections in flexure and
compression with negligible minor axis bending moment, two independent
limit states, namely in-plane instability and out-of-plane buckling, also are
considered separately considering the combined approach provided in AISC
equations H1-1a and H1-1b. The minimum ratio provided by the original ap-
proach (AISC H1-1a, H1-1b) and the alternative approach described herein are
taken as the resulting D/C ratio.

a) For the limit state of in-plane instability, equations H1-1a and H1-1b are
used with M. having a different meaning.

For i >0.2

c
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iﬁ[ _ Mg | M ) <1.0. (AISC H1-1a, H1.3a)

P 9 €33,NoLTB MCZZ

c

For & <0.2
P

c

P, N [ v M, n M.z, ] <1.0, (AISC H1-1b, H1.33)

2 Pc c33,NoLTB Mc22

where, all the terms in the preceding equations are the same as explained
earlier in this section, except McasnoLts IS €xplained as follows:

For LRFD:

Measnote = dpMnzs = design flexural strength determined in accord-
ance with Chapter F, except that in determining Msss, in this case, the
lateral torsional buckling is not considered.

For ASD:

MnsznoLte = M ;,/Q, = allowable flexural strength determined in ac-

cordance with Chapter F, except that in determining Mss3, in this case,
the lateral torsional buckling is not considered.

In general, MussnoLTe IS either larger than the regular Mns; or equal to (for
Pipe sections) the regular Mns3. The negligibility of the minor axis moment
is tested in the program by using a tolerance (0.001) multiplied by the mi-
nor direction capacity (Mn22).

For the limit state of out-of-plane buckling, the following interaction equa-
tion is used

2
M
i+ —38 1 <1.0 (AISC H1-2)
Pco Mc33
where
Peo = available compressive strength considering out-of-plane

bending; it is taken equal to ¢cPn,
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Mz = available flexural strength considering all limit states, in-
cluding lateral-torsional buckling.

As an exception, any singly-symmetric 1-Shape section with ch/ly beyond the

range of 0.1< ch/ly <0.9 is considered beyond the scope of the code (AISC
H.1, F13.2). Those sections are not checked by the program.

As an exception, all General sections and section created using Section De-
signer are treated as Doubly or Singly Symmetric sections. The equations H1-
la and H1-1b are use for calculation of the D/C ratios.

The program considers the left-hand side to calculate the D/C ratio. The D/C
ratio is really compared with the D/C ratio limit rather than 1. By default, the
D/C ratio limit is 0.95. This limit can be changed in the Preferences.

Doubly and Singly Symmetric Members Subjected to
Flexure and Axial Tension

The interaction of flexure and axial tension in all members with Doubly Sym-
metric sections (I, Double Channel, Box, Pipe, Solid Circular, Solid Rectangu-
lar) and Singly Symmetric sections (Channel, T-Shapes, Double Angle), with
some exceptional cases, are given as follows:

For iz 0.2
PC
M
B8 My Mo | g (AISC H1-2, H1-1a)
Pc 9 Mc33 Mc22
For E< 0.2
PC
P +[%+MJ31_0, (AISCH1-2, H1-1b)
2Pc Mc33 c22

where, Pr and P are the required and available axial strengths; M, and M. are
the required and available flexural strengths; and 3 and 2 represent the strong
and weak axes, respectively.
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Depending on the selected design provisions (LRFD or ASD), the aforemen-
tioned terms are defined as follows:

For design in accordance with LRFD provisions:

Pt
Pc
M,
M.
t
0o

required axial tensile strength using LRFD load combinations
design axial tensile strength = ¢cPn

required flexural strength using LRFD load combinations

design flexural strength = ¢ppM,

resistance factor for tension (0.90 yielding, 0.75 rupture) (AISC D2)
resistance factor for flexure = 0.90

For design in accordance with ASD provisions:

Pt
Pc
M,
Mc
Q4
Qp

required axial compressive strength using ASD load combinations
allowable axial compressive strength = P,/Q).

required flexural strength using ASD load combinations
allowable flexural strength = Mn/Qy

safety factor for tension (1.67 yielding, 2.00 rupture) (AISC D2)
safety factor for flexure = 1.67

As an exception, for Circular and Pipe sections, an SRSS (Square Root of Sum
of Squares) combination is made first of the two bending components before
adding the axial load component, instead of the single algebraic addition as
implied by the interaction equations given by AISC H1-1la and AISC H1-1b.
The resulting interaction equation is given by the following:

For & >0.2

c
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2 2
R + \/[—M'%J +[—M“22J <1.0.
2Pc Mc33 Mc22
As an exception, any single-symmetric I-Shape section with 1 / I, beyond the

range of 0.1< ch/ly <0.9 is considered beyond the scope of the code (AISC
H.1, F13.2). These sections are not checked by the program.

As an exception, all General sections and section created using Section De-
signer are treated as Doubly or Singly Symmetric sections. The equations H1-
la and H1-1b are use for calculation of the D/C ratios.

The program considers the left-hand side to calculate the D/C ratio. The D/C
ratio is really compared with the D/C ratio limit rather than 1. By default, the
D/C ratio limit is 0.95. This limit can be changed in the Preferences.

Unsymmetric Members Subjected to Flexure and Axial
Force

Unlike I-Shapes, Box, Channel, Double Channel, T-Shapes, Double Angle,
Pipe, Circular, and Rectangular sections, the principal axes of unsymmetric
(unequal leg) Single Angle sections do not coincide with their geometric axes.
For Single Angle sections, the principal properties of the section are deter-
mined. The forces are resolved in the principal directions (w and z). The itera-
tion of flexure and axial stress is calculated as follows:

f
L L P (AISC H2-1)
Fa bw bz

where f, and F, are the required and available axial stresses at the point of con-
sideration; f, and Fy are required and available bending stresses; w is the sub-
script related to the major principal axis bending; and z is the subscript related
to the minor principal axis bending.

For design in accordance with LRFD provisions:

fa = required axial stress using LRFD load combinations
Fa = design axial stress = ¢cFer or ¢ Fy
fow, fz = required flexural stress using LRFD load combinations
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Fow, F = design flexural stress = $M,y

dc = resistance factor for compression = 0.90

Or = resistance factor for tension (0.9 for yielding, 0.75 for rupture)
(Section AISC D2)

do = resistance factor for flexure = 0.90

For design in accordance with ASD provisions:

fa = required axial stress using ASD load combinations
Fa = allowable axial stress = F¢r / Qc or Fy/ Oy
fow, foz = required flexural stress using ASD load combinations

M
Fow, Fo: = allowable flexural stress = o n
b

Qc = safety factor for compression = 1.67

(O); = safety factor for tension (1.67 for yielding, 2.00 for rupture)
(Section AISC D2)

Qp = safety factor for flexure = 1.67

For General sections and Section Designer sections, it is assumed that the sec-
tion properties are given in terms of principal directions. These two types of
sections are treated as symmetric sections for interaction purposes.

Members Subject to Torsion, Flexure, Shear and Axial

Force

The interaction of torsion, flexure, shear, and axial force is considered only for
Box and Pipe sections and only if the torsion is significant. Torsion is consid-
ered significant when the required torsional strength, T, is more than 20% of

the available torsional strength, T¢ (AISC H3.2). The interaction of torsion with
other forces is ignored when

T, <0.2Te, (AICS H3.2)

and for members with Box sections, the interaction of torsion, shear, flexure
and axial force is given by

Design of Members for Combined Forces
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2
M Y
5+(—“3‘°’+hj+(43+h+T—f] <1.0, (AISC H3-6)
Pc Mc33 Mc22 VcB c2 Tc

and for members with Pipe sections, the interaction of torsion, shear, flexure,
and axial forces is given by

2 2 2
E+ M,z n M., + h.f_&-ki <1.0, (AISC H3-6)
Pc M c33 M c22 Vc3 V<:2 TC

where, P and P. are the required and available axial strength; M; and M. are
required and available flexural strength; V, and V. are required and available
shear strength; and T, and T, are required and available torsional strength, re-
spectively.

For design in accordance with LRFD provisions:

P, = required axial strength using LRFD load combinations
P. = design compressive/tensile strength = ¢:Pn or ¢:Pn
M, = required flexural strength using LRFD load combinations
M.= design flexural strength = ¢sM,
V: = required shear strength using LRFD load combinations
V¢ = desire shear strength = ¢,V
T: = required torsional strength using LRFD load combinations
T. = design torsional strength = ¢7Ty,
¢c = resistance factor for compression = 0.90
¢r = resistance factor for tension (0.9 for yielding, 0.75 for rupture) (from AISC D2)
¢v = resistance factor for flexure = 0.90
v = resistance factor for shear = 0.90
¢t = resistance factor for torsion = 0.9

For design in accordance with ASD provisions:

P, = required axial strength using ASD load combinations
P. = allowable compressive/tensile strength = P, / Q¢ or Pn / O
M, = required flexural strength using ASD load combinations
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M.= allowable flexural strength = M, / Qp

V: = required shear strength using ASD load combinations

V. = allowable shear strength = V,, /Q,

T, = required torsional strength using ASD load combinations

T. = allowable torsional strength = T, / O,

Q= safety factor for compression = 0.90

Q. = safety factor for tension (1.67 for yielding, 2.0 for rupture) (from AISC D2)
Q= safety factor for flexure = 0.90

Q, = safety factor for shear = 0.90

Q, = safety factor for torsion =0.90
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Chapter 4
Special Seismic Provisions
(ANSI/AISC 341-05)

This chapter provides a detailed description of the algorithms related to special seismic
provisions in the design/check of structures in accordance with the "ANSI/AISC 341-
05—Seismic Provisions for Structural Steel Buildings Including Supplement No. 1"
(AISC 2005). The code option "AISC 360-05/IBC 2006" covers these provisions. The
same code option covers "ANS/AISC 360-05—Specifications for Structural Steel
Building" (AISC 2005a, b) as the basic code. The implementation covers load
combinations from "ASCE/SEIl 7-05," which is described in the section "Design
Loading Combination™ of Chapter 3. The loading based on "ASCE/SEI 7-05" has been
described in a separate document entitled "CSI Lateral Load Manual" (CSI 2007).
References are also made to IBC 2006 in this chapter.

For referring to pertinent sections of the corresponding code, a unique prefix is
assigned for each code.

= Reference to the ANSI/AISC 360-05 code carries the AISC prefix.

= Reference to the ANSI/AISC 341-05, Part | code carries the AISC SEISMIC prefix
or sometimes SEISMIC only.

= Reference to the ASCE/SEI 7-05 code carries the ASCE prefix.

= Reference to the IBC 2006 code carries the IBC prefix.
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4.1 Notations

Most of the notations used in this chapter have been described previously in Chapter 3.
Any additional notations used in this chapter are described herein.

Sps Design earthquake spectral response acceleration parameter at short
period (ASCE 11.4.4)

P Redundancy factor (ASCE 12.3.4)

(PN Overstrength factor (ASCE Table 12.2-1)

E, Effect of horizontal component of design seismic force, including the
effect of P (ASCE 12.4.2.1)

E, Effect of vertical component of design seismic force (ASCE 12.4.2.2)

E.,, Horizontal seismic load effects with overstrength factor (ASCE
12.4.3.1)

Qc Effects of horizontal seismic forces (ASCE 12.4.2.1, 12.4.3.1, 12.8.1)

4.2  Design Preferences

The steel frame design Preference are basic assignments that apply to all of the steel
frame members. The Preferences are described in Appendix B. Tables
B-1, B-2, and B-3 list the steel frame design Preferences. The following steel frame
design Preferences are relevant to the special seismic provisions.

= Framing Type

= Notional Load Coefficient

= Seismic Design Category

= Ignore Seismic Code?

= Ignore Special Seismic Load?

= |s Doubler Plate Plug Welded?

4-2 Notations
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4.3

4.4

Overwrites

The steel frame design Overwrites are basic assignments that apply only to those
elements to which they are assigned. The overwrites are described in Appendix C.
Table C-1 lists the steel frame design Overwrites. The following steel frame design
overwrites are relevant to the special seismic provisions.

= Frame Type
= Omega0

* Overstrength factor, R,

Supported Framing Types

The code (ANSI/AISC 341-05) now recognizes the following types of framing systems
(AISC SEISMIC 9, 10, 11, 12, 13, 14, 15, 16, 17).

Framing Type References

SMF (Special Moment Frame) AISC SEISMIC 9

IMF (Intermediate Moment Frame) AISC SEISMIC 10
OMF (Ordinary Moment Frame) AISC SEISMIC 11
STMF (Special Truss Moment Frame) AISC SEISMIC 12
SCBF (Special Concentrically Moment Frame) AISC SEISMIC 13
OCBF (Ordinary Concentrically Moment Frame) AISC SEISMIC 14
EBF (Eccentrically Moment Frame) AISC SEISMIC 15
BRBF (Buckling Restrained Moment Frame) AISC SEISMIC 16
SPSW (Special Plate Shear Wall) AISC SEISMIC 17

With regard to these framing types, the program has implemented specifica-tions for
all types of framing systems, except STMF, BRBF, and SPSW. Implementing those
three types of framing requires further information about modeling.

Overwrites 4-3



Steel Frame Design AISC 360-05/IBC 2006

4.5

4-

4

The program recognizes the OCBF framing in its two separate incarnations: OCBF for
regular Ordinary Concentrically Braced Frames (AISC SEISMIC 14) and OCBFI for
(base) Isolated Ordinary Concentrically Braced Frames (AISC SEISMIC 14.5).

By default, the frame type is taken as Special Moment Frame (SMF) in the program.
However, the default frame type can be changed in the Preference form for all frames
or in the Overwrites form on a member-by-member basis (Chapter 3). If a frame type
Preference is revised in an existing model, the revised frame type does not apply to
frames that have already been assigned a frame type through the Overwrites; the
revised Preference applies only to new frame members added to the model after the
Preference change and to the old frame members that were not assigned a frame type
though the Overwrites.

Applicability of the Seismic Requirements

Ideally, the special seismic provisions shall apply when the seismic response
modification factor, R, is taken as greater than 3, regardless of the seismic design
category (AISC SEISMIC 1). R is specified by the applicable building code (local
code or IBC). IBC actually refers to ASCE 7-05 for the value of R (IBC 2205.2.1).
Again, when R is taken as 3 or less, the structure is not required to satisfy these
provisions, unless specifically required by the applicable building code.

The applicable building code generally restricts buildings designed with an R factor of
3 or less to Seismic Design Category (SDC) A, B, or C; however, some systems that
have R factors less than 3 are permitted in SDC D, E, or F (IBC 2205.2, ASCE 12.2.1,

ASCE Table 12.2-1).

The program assumes that the special seismic provisions are applicable to any
structural steel structure that is assigned to SDC D, E, or F, irrespective of the value
of R, and to any structural steel structure designed with an R greater than 3 and that is
assigned to SDC A, B, or C. In addition, the program allows the user to change the
default applicability of special seismic provisions using the "Ignore Seismic Code?"
Preference item.

Applicability of the Seismic Requirements
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4.6

Design Load Combinations

The program creates the default design load combinations based on the specification of
ASCE 7-05 code. The default load combinations are generated differently when the
LRFD (ASCE 2.3.2) and ASD (ASCE 2.4.1) provisions are chosen. The default
combinations have been described in "Design Loading Combinations" in Chapter 3.
Additional information may be found in "Design Load Combinations" in Chapter 2.
The user may change the default load combinations if the governing code is different
(AISC SEISMIC 4.1).

The program assumes that the defined earthquake load is really the strength level
earthquake, which is equivalent to 6. as defined in Section 12.4.2.1 in ASCE 7-05
code. For a regular earthquake, load is considered to have two components: horizontal,
E, and vertical E,, which are taken as

E, = pb,, (ASCE 12.4.2.1)
E, =0.25,.D, (ASCE 12.4.2.2)

where, p is the redundancy factor as defined in Section 12.3.4 of ASCE 7-05, and the
Sps is the design earthquake spectral response acceleration parameters at short
periods, as defined in Section 11.4.4 of ASCE 7-05 code.

Effectively, the seismic load combinations for the LRFD provision become

(1.2+0.2S,) DL + pb, (ASCE 2.3.2-7,12.4.2.3)
(1.2+0.2S,5) DL £+ pQ, +1.0 LL (ASCE 2.3.2-7,12.4.2.3)
(0.9-0.2S,5) DL + pe2.. (ASCE 2.3.2-7,12.4.2.3)

The seismic load combinations for the ASD provision become

(1.0+0.14S, ) DL 0.7 p£2; (ASCE 2.4.1-5,12.4.2.3)

(1.0+0.105S, ) DL +0.75(0.7p)£2, +0.75 LL
(ASCE 2.4.1-6,12.4.2.3)

(0.6-0.14Sy, ) DL £0.7p42, . (ASCE 2.4.1-7,12.4.2.3)

Design Load Combinations 4-5
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The program automatically considers seismic load effects, including overstrength
factors (ASCE 7-05 12.4.3), as special load combinations that are created automatically
from each load combination involving seismic loads. In that case, the horizontal

component of the force is represented by E, , and vertical component of the force is

represented by E,, where,
E., =€2Q; and (ASCE 12.4.3.1)

E, = 0.2S.D. (ASCE 12.4.2.2)

Effectively, the special seismic combinations for the LRFD provision are

(0.9-0.2S,) DL +.02,Q, (ASCE 2.3.2-7,12.4.3.2)
(1.2+0.2S,5) DL £02,Q. +1.0LL (ASCE 2.3.2-5,12.4.3.2)

and for the ASD provision, the combinations are

(1.0+0.14S,5) DL £0.72,6, (ASCE 2.4.1-7, 12.4.3.2)
(1.0+0.105S, ) DL +£0.75(0.7£2,)6 +0.75LL (ASCE 2.4.1-6, 12.4.3.2)
(0.6-0.14S,) DL +£0.70,6, (ASCE 2.4.1-7,12.4.3.2)

The factor Syg is described earlier in this section. €is the seismic force
amplification factor that is required to account for structural overstrength. The factor
), is the overstrength factor, and it should be picked up from ASCE 7-05, Table 12.2-
1 by the user and input in the Preferences and auto-seismic load definition. The default
value of ) is taken as 3.0 in the program. If the user defines one or more auto-
seismic loads, the values of €2 are taken as the maximum of all the €2, defined for
each auto-seismic load case. Also if the user defines special seismic data that includes
an €, value and requests that the program include the special seismic design data,
then this €2, takes precedence over the default values and those defined for the auto-
seismic load cases. Moreover, €, can be overwritten for each individual member. The
overwritten €2, gets the highest precedence. The guideline for selecting a reasonable
value for €, can be found in ASCE 7-05, Table 12.2-1.

Design Load Combinations



Chapter 4 Special Seismic Provisions

4.7

Those combinations involving €2, are internal to the program. The user does NOT
need to create additional load combinations for those load combinations. The special
circumstances for which those load combinations are additionally checked are
described later in this chapter, as appropriate. The special loading combination factors
are applied directly to the load cases. It is assumed that any required scaling (such as
may be required to scale response spectra results) has already been applied to the load
cases.

The program assumes that the seismic loads defined as the strength level load is the
program load case. Otherwise, the factors p, £2,, and S, will be unable to scale the
load to the desired level.

Classification of Sections for Local Buckling

The sections are classified in the program as Seismically Compact, Compact,
Noncompact, Slender, and Too Slender. The sections are classified as Compact,
Noncompact, or Slender sections in accordance with Section B4 of the regular code
(AISC B4, AISC Table B4.1). The limiting width/thickness ratios, /1p, A, and A, that
demarcate the slenderness limits for Compact, Noncompact, Slender and Too Slender
sections were given in Table 3-5 in "Classification of Sections for Local Buckling" in
Chapter 3.

Seismically compact sections are capable of developing the full plastic strength before
local buckling occurs when the section goes through low cycle fatigue and withstands
reversal of load under seismic conditions. The width/thickness ratio ( A) should be less
than the limit, A,, for the section to be Seismically Compact. The limiting
width/thickness ratio, A, , for compression elements is given in Table 4-1 and is based
on the Seismic code (AISC SEISMIC 8.2,
Table 1-8-1). The Seismically Compact sections are reported as "Seismically
Compact," or sometimes as "Seismic™ only for brevity in the design output.

Classification of Sections for Local Buckling 4-7
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Table 4-1 Limiting Width-Thickness Ratios of Compression Elements for Classification Sections

Width- | Limiting Width-Thickness
Thick- Ratios for Compression
Gi ness Elements
IVeNn| Ratio, Seismically Compact
Section | Description Graphical Case P Ay P Applicable Situation
Type | of Element Example No. ( ) () with Code Reference
Flexural or ehAl Beams in SMF (SEISMIC 9)
uniform T Beams in BRBF (SEISMIC 16)
?OTIPVESSIOF; Links in EBF (SEISMIC 15)
In Tlanges o Columns in SMF (SEISMIC 9)
3 rolled and 12 | b /2, 0.30 JE/F, Columns in SCBF (SEISMIC 13)
& welded i Columns in BRBF (SEISMIC 16)
& I-Shaped Braces in SCBF (SEISMIC 13)
3 sections Braced in OCBF (SEISMIC 14)
% Lrrrrrsyrrrrii
e Beams in SMF (SEISMIC 9)
£ Flexura_l b
2 | compression W h 9 h/t, 2.45 JE/JF,
> in beam web
g |7 rrsdsrsrrs]
a i If C, <0.125 Beams in.BRBF (SEISMIC 16)
s Webs in Columns in SMF (SEISMIC 9)
> flexural boeratpeia E Columns in SCBF (SEISMIC 13)
S | compression 3.14 [ (1-154C,) | Columns in EBF (SEISMIC 15)
7] or combined t=4— | 10 h/t y Columns in BRBF (SEISMIC 16)
flexural and i C,>0.125 Braces in SCBF (SEISMIC 13)
axial b Braces in OCBF (SEISMIC 14)
17227722 77727) E E
compression 112@( 233-C,)> 1-49\E
y y
b—b— |
Flexural or 'Mﬂ
Uniform Columns in SCBF (SEISMIC 13)
compression 4| b/t 0.30E/F, Braces in SCBF (SEISMIC 13)
in flanges
VA
L]
Flexural T Beams in SMF (SEISMIC 9)
@ | compression grooh 9 h/t,, 2.45,[E[F,
8 in beam web
© 7,
. If C, <0.125
mibjrg ey : = Beams in BRBF (SEISMIC 16)
! *r £ Columns in SMF (SEISMIC 9)
compression "7 3'14\/ F (1-1.54C,) Columns in SCBF (SEISMIC 13)
or combined t a 10 h/t, Columns in EBF (SEISMIC 15)
flexural and If C,>0.125 Columns in BRBF (SEISMIC 16)
axial g £ Braces in SCBF (SEISMIC 13)
compression bz 1_12\/;( 233-C,) > 1_49\/; Braces in OCBF (SEISMIC 14)
y y
4-8 Classification of Sections for Local Buckling
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Table 4-1 Limiting Width-Thickness Ratios of Compression Elements for Classification Sections

Width- | Limiting Width-Thickness
Thick- Ratios for Compression
Gi ness Elements
IVeNn| Ratio, Seismically Compact
Section | Description Graphical Case P Ay P Applicable Situation
Type | of Element Example No. ( ) () with Code Reference
Flexural or Columns in SCBF (SEISMIC 13)
Unlform 4 b, /tf 0.30 E/Fy Braces in SCBF (SEISMIC 13)
compression
in flanges
T Flexure Beams in SMF (SEISMIC 9)
= compression 9 h/t, 2.45,/E/F,
S in beam web
D
§ If C, <0.125
a ‘f’:g’jrgl‘ T - Beams in BRBF (SEISMIC 16)
| £ Columns in SMF (SEISMIC 9)
compression 3'14\{ F, (1-1.54C,) Columns in SCBF (SEISMIC 13)
or combined 10 h/t, Columns in EBF (SEISMIC 15)
flexural and If C, >0.125 Columns in BRBF (SEISMIC 16)
axial 3 £ Braces in SCBF (SEISMIC 13)
compression 1_12\/;( 233-C,) > 1_49\/; Braces in OCBF (SEISMIC 14)
y y
Flexural or '
axial J; _.‘? Columns in SCBF (SEISMIC 13)
: h u I
compression 12 b/t 0.64,/ E/F Braces in SCBF (SEISMIC 13)
of flanges Y Braces in OCBF (SEISMIC 14)
under major
3 axis bending
fos]
Flexural P
compression I == Columns in SCBF (SEISMIC 13)
of webs under h 12 h/t 0.64 E/ F, Braces in SCBF (SEISMIC 13)
minor axis L Braces in OCBF (SEISMIC 14)
bending
Flexural or b=
i V27777777772
axial . v : t 7 | b /2tf 0.30 E/F Chord of STMF (SEISMIC 12)
compression ’ t y
2 in flanges v
I+
& T
F | compression 4
mp ] 8 d/t, 0.30\/E/F, Chord of STMF (SEISMIC 12)
in stems R y
—| f—
r
p—>1F
Any type of A‘#
= compression ’ 7 b/t 0.30,/E/F, Chord of STMF (SEISMIC 12)
b5 in leg
@
= Any type of T
8 compression | 7 b/t 0.30,/E/F, Chord of STMF (SEISMIC 12)
in leg e}

Classification of Sections for Local Buckling
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Table 4-1 Limiting Width-Thickness Ratios of Compression Elements for Classification Sections

Width- | Limiting Width-Thickness
Thick- Ratios for Compression
Gi ness Elements
IVeNn| Ratio, Seismically Compact
Section | Description Graphical Case P Ay P Applicable Situation
Type | of Element Example No. ( ) () with Code Reference
2]
Any type of 722222:1#
compression t 7 b/t 0.30,/ E/F, Chord of STMF (SEISMIC 12)
inany leg
D
=)
<
Any type of
compression 7 b/t 0.30,/E/F, Chord of STMF (SEISMIC 12)
inany leg
° Flexural or E Columns in SCBF (SEISMIC 13)
2 axial 11 D/t 0‘044F Braces in SCBF (SIESMIC 13)
o compression y Braces in OCBF (SIESMIC 14)
Round _ _ | —— Assumed non-compact
Bar
g
§7 Any 6 b/t 25 Diagonal web member in STMF
£ compression ' (SEISMIC 12)
2
General e e _— Assumed non-compact
SD
Section _ _ _ | —— Assumed non-compact

The table uses the dimension-related variables, such as b;, t;, t,, b, t, h, D, and
so forth. Some of those variables have been explained in the table itself. Some are
explained in Figure 3-1 and also explained in the code (AISC B4.1, B4.2, Table B4.1).
The variable C, can be expressed as follows:

Pu/(%Py) for LRFD
C, = (AISC SEISMIC Table 1-8-1 Note K)
0, P, /P, for ASD

P, = Required compressive strength (ASD)
P, = Required compressive strength (LRFD)

P, = Auxial yield strength

4-10 Classification of Sections for Local Buckling
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0.90

&,
0, = 167

When satisfying the Special Seismic criteria, it is in general not necessary for the
design sections to be Seismically Compact (AISC SEISMIC 8.2). However, for certain
special cases, the design sections must be Seismically Compact (AISC SEISMIC 8.2b)
or Compact (AISC SEISMIC 8.2a, AISC Table B4.1) as described in the "Seismic
Requirements" section of this chapter. For a situation when the code requires the
design section to be Seismically Compact, but the section fails to satisfy the criteria,
the user must modify the section. In that case, the program issues an error message in
the output.

Special Check for Column Strength

When P,/¢.P, for LRFD provision or 2, P, /P, for ASD provision in columns due

to prescribed loading combination without consideration of amplified seismic load is
greater than 0.4, the axial compressive and tensile strengths are checked in the absence
of any applied moment and shear for the amplified seismic load combinations (AISC
SEISMIC 8.3(1), 4.1).

For LRFD provisions,

(0.9-0.2Sy5 )DL + 2,Q; (ASCE 12.4.3.2, 2.3.2-7)
(1.2+0.2S5, )DL + 2,Q; +1.0LL (ASCE 12.4.3.2, 2.3.2-5)

For ASD provisions,

(1.0 +0.14Sps ) DL £ 0.7.2,Q; (ASCE 12.4.3.2, 2.4.1-5)
(1.0+0.105S5; )DL +0.7(0.742,)Qg +0.75LL  (ASCE 12.4.3.2, 2.4.1-6)
(0.6 —0.14S, ) DL +0.72,Q; (ASCE 12.4.3.2, 2.4.1-7)

where (2, and Sy are as described in the "Design Load Combinations" section in
Chapter 3.

Special Check for Column Strength 4-11
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49.1

4-12

The preceding load combinations are used to calculate axial force only because other
forces and moments are ignored. This axial capacity check is in addition to regular
strength checks for the regularly specified load combinations (AISC SEISMIC 8.3).

Those combinations involving €, are internal to the program. The user does NOT
need to create additional load combinations for such load combinations. The special
circumstances for which these load combinations are additionally checked are
described later in this chapter, as appropriate. The special loading combination factors
are applied directly to the load cases. It is assumed that any required scaling (such as
may be required to scale response spectra results) has already been applied to the load
cases.

If the overwrite item "Ignore Special Seismic Load?" is set to yes, the preceding check
will not be performed.

Member Design

This section describes the special requirements for designing a member. The section
has been divided into subsections for each framing type.

Special Moment Frames (SMF)

For this framing system, the following additional requirements are checked or reported
(AISC SEISMIC 9).

* When P/g.P, (or €2, P,/P,in ASD) in columns due to prescribed loading

combinations without consideration of amplified seismic load is greater than 0.4, the
axial compressive and tensile strengths are checked in absence of any applied
moment and shear for the special seismic load combination as described previously
in the "Special Check for Column" section of this manual (AISC SEISMIC 8.3, 4.1).

= All beams and columns are required to be Seismically Compact (AISC SEISMIC
9.4a, 8.2b, Table 1-8-1). The limits of the width-thickness ratio, A, has been

presented in this manual in Table 4-1. If these criteria are satisfied, the section is
reported as SEISMIC as described earlier under the "Classification of Sections for

Member Design
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49.2

49.3

Local Buckling" section. If these criteria are not satisfied, the program issues an
error message.

= The program checks the slenderness ratio, L/r,for columns to be less than 60

(AISC SEISMC 9.7b(2)). If this criterion is not satisfied, the program issues an error
message.

= The program checks the laterally unsupported length of beams not to exceed
0.086( E/F, )r, (AISC SEISMIC 9.8). If this criterion is not satisfied, the program

issues an error message.

Intermediate Moment Frames (IMF)

For this framing system, the following additional requirements are checked and
reported (AISC SEISMIC 10).

* When P/¢.P, (or €,P,/P, in ASD) in columns due to prescribed loading

combinations without consideration of amplified seismic load is greater than 0.4, the
axial compressive and tensile strengths are checked in absence of any applied
moment and shear for the special seismic load combinations as described previously
in the "Special Check for Column" section of this manual (AISC SEISMIC 8.3, 4.1).

= All beams and columns are checked to be Compact (AISC SEISMIC 10.4a, 8.23,
AISC Table B4.1). The limits of the width-thickness ratio, A,, have been presented

in this manual in Table 3-5. If this criterion is satisfied, the section is reported as
Compact as described earlier under the "Classification of Sections for Local
Buckling" section in Chapter 3. If this criterion is not satisfied, the program issues an
error message.

= The program checks the laterally unbraced length of beams between lateral braces
not to exceed the limiting value 0.17(E/F, )r, (AISC SEISMIC 10.8). If this

criterion is not satisfied, the program issues an error message.

Ordinary Moment Frames (OMF)

For this framing system, the following additional requirement is checked and reported
(AISC SEISMIC 11).

Member Design 4-13
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49.5
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When P /¢.P, (or .QCPa/Pn for ASD) in columns due to prescribed loading

combinations without consideration of amplified seismic load is greater than 0.4, the
axial compressive and tensile strengths are checked in absence of any applied
moment and shear for the special seismic load combinations as described previously
in the "Special Check for Column" section of this manual (AISC SEISMIC 8.3, 4.1).

Special Truss Moment Frames (STMF)

No special consideration for this type of framing system is given by the program. The
user is required to check the seismic design requirements for STMF independently.

Special Concentrically Braced Frames (SCBF)

For this framing system, the following additional requirements are checked or reported
(AISC SEISMIC 13).

When P,¢./P, (or €.P,/P, for ASD) in columns due to prescribed loading

combinations without consideration of amplified seismic load is greater than 0.4, the
axial compressive and tensile strengths are checked in the absence of any applied
moment and shear for the special seismic load combinations as described previously
in the "Special Check for Column" section of this manual (AISC SEISMIC 8.3, 4.1).

All column and brace members are checked to be Seismically Compact according to
Table 4-1 (AISC SEISMIC 13.2d, 8.2b, Table 1-8-1). If these criteria are satisfied,
the section is reported as SEISMIC as described earlier under "Classification of
Sections for Local Buckling" in this chapter. If these criteria are not satisfied, the
program issues an error message.

The maximum KI/r ratio of the braces is checked not to exceed 4,/E/Fy (AISC

SEISMC 13.2a). If this criterion is not satisfied, the program issues an error message.

The program checks the following requirements for V-type or inverted V-type SCBF
frames.

The program checks the laterally unbraced length of beams between lateral braces
not to exceed the limiting value of L, (AISC SEISMIC 13.4a(2)). The expression

for L4 for Box and Solid rectangular sections is given as follows:
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M E E
Lpd = [017+010(M—;)i|[|:—y]ry > Ol(Eyjry

(AISC A-1-8, AISC SEISMIC 13.4a(2))

For all other sections, L, is take as follows:

M, \]( E
L, = [0.12 +o.o76(M—iH(€er,

(AISC A-1-7, AISC SEISMIC 13.4a(2))

where,
M,; = Smaller moment at the end of the unbraced length of beam,
M, = Larger moment at the end of the unbraced length of the beam,
r, = Radius of gyration about minor axis.

M, /M, is positive for reverse curvature bending and negative for single curvature
bending (AISC AL1.7).

Note: Beams intersected by chevron (V or inverted-V) braces are NOT currently
checked to have a strength to support loads for the following two conditions (AISC
SEISMIC 13.4a):

(a) A beam that is intersected by braces shall be designed to support the effects of
all tributary dead and live loads from load combinations stipulated by the code,
assuming the bracings are not present.

(b) A beam that is intersected by braces and supporting earthquake load shall be
designed to resist the effects of the load combinations stipulated by the code,
except the brace forces have to be replaced by their capacities. The forces in all
braces in tension shall be assumed to be equal to R /F,A; (AISC SEISMIC

13.4a(1)a). The forces in all braces in compression shall be assumed to be equal
to 0.3 P, (AISC SEISMIC 13.4a(1)b).
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For this framing system, the following additional requirements are checked or reported
(AISC SEISMIC 14).

= When P,@./P, (or _QCPa/Pn for ASD) in columns due to prescribed loading

combinations without consideration of amplified seismic load is greater than 0.4,
the axial compressive and tensile strengths are checked in the absence of any
applied moment and shear for the special seismic load combinations as described
previously in the "Special Check for Column" section of this manual (AISC
SEISMIC 8.3, 4.1).

All brace members are checked to be Seismically Compact according to Table 4-1
(AISC SEISMIC 14.2, 8.2b, Table 1-8-1). If the criteria are satisfied, the section is
reported as SEISMIC as described earlier in "Classification of Sections for Local
Buckling" in this chapter. If this criterion is not satisfied, the program issues an
error message.

The program checks the laterally unbraced length of beams for V or inverted V
configurations between lateral braces not to exceed the limiting value of L,

(AISC SEISMIC 14.3(2)). The expression for L, for Box and Solid rectangular

sections is given as follows:

M\ E E
Ly = [0.17 + 0.10[M—;H(€er > 0.1(Eyjry.

(AISC A-1-8, AISC SEISMIC 14.3(2))

For all other sections, L, is take as follows:

M E
Lpd = {012 + OO?G(M—l):l(F—yjry,

(AISC A-1-7, AISC SEISMIC 14.3(2))

where,
M, = Smaller moment at the end of the unbraced length of beam,
M, = Larger moment at the end of the unbraced length of the beam,
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r = Radius of gyration about minor axis.

Ml/M2 is positive for reverse curvature bending and negative for single
curvature bending (AISC AL.7).

* The maximum KI/r ratio of the braces for V or inverted-V configurations is
checked not to exceed 4.0, /E/Fy (AISC SEISMIC 14.2). If this criterion is not

met, an error message is reported in the output.

4.9.7 Ordinary Concentrically Braced Frames from Isolated
Structures (OCBFI)

For this framing system, the following additional requirements are checked or reported
(AISC SEIAMIC 14.5).

* When P/#.P, (or €, P,/P, in ASD) in columns due to prescribed loading

combinations without consideration of amplified seismic load is greater than 0.4,
the axial compressive and tensile strengths are checked in absence of any applied
moment and shear for the special seismic load combinations as described
previously in the "Special Check for Column" section of this manual (AISC
SEISMIC 8.3, 4.1).

= All braces are required to be Compact (AISC SEISMIC 14.5a, 8.2a, AISC Table
B4.1). The limits of the width-thickness ratio, A,,have been presented in this

manual in Table 3-5. If these criteria are satisfied, the section is reported as
Compact as described previously under the "Classification of Sections for Local
Buckling" section in Chapter 3. If this criterion is not satisfied, the program issues
an error message.

= The maximum KI/r ratio for the braces is checked not to exceed 4 E/Fy

(AISC SEISMIC 14.5a). If this criterion is not met, an error message is reported in
the output.
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Eccentrically Braced Frames (EBF)

For this framing system, the program looks for and recognizes the eccentrically braced
frame configurations shown in Figure 4-1. The following additional requirements are
checked or reported for the beams, columns and braces associated with these
configurations (AISC SEISMIC 15).

N | @

@ (b) (©)

Figure 4-1. Eccentrically Braced Frame Configurations

* When P,¢./P, (or ,P,/P, for ASD) in columns due to prescribed loading

combinations without consideration of amplified seismic load is greater than 0.4,
the axial compressive and tensile strengths are checked in absence of any applied
moment and shear for the special seismic load combinations as described
previously in the "Special Check for Column" section of this manual (AISC
SEISMIC 8.3, 4.1).

The beams are checked to be Seismically Compact according to Table 4-1 (AISC
SEISMIC 15.2a, 8.2b, Table 1-8-1). If this criterion is satisfied, the section is
reported as SEISMIC as described earlier under "Classification of Sections for
Local Buckling Section” in this chapter. If this criterion is not satisfied, the
program issues an error message.

The shear strength for link beams is taken as follows (AISC SEISMIC 15.2b):

V, <¢,V, (LRFD)or (AISC SEISMIC 15.2b)
V, <V, /QV (ASD), (AISC SEISMIC 152b)
where,
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V,=min(V,, 2M  /e)

2
Pr
Vpa = Vp 1 - [Fc]

M., =1.18M{1—i},
P

V, =0.6F,(d-2t)t,,
M, =ZF,

¢ = ¢, (defaultis 0.9)

Q =Q, (default is 1.67)
P. = B, (LRFD)

P. = P, (ASD)

P, = P, (LRFD)

P, =P, /1.5 (ASD)

P, =AF,.

(AISC SEISMIC 15.2b)

(AISC SESIMIC 15-1)

(AISC SEISMIC 15-2)

(AISC SEISMIC 15.2b)

(AISC SEISMIC 15.2b)

(AISC SEISMIC 15.2b)
(AISC SEISMIC 15.2b)
(AISC SEISMIC 15.2b)
(AISC SEISMIC 15.2b)
(AISC SEISMIC 15.2b)
(AISC SEISMIC 15.2b)

(AISC SEISMIC 15.2b)

= If P, >0.15AF, (LRFD)or P, >(0.15/1.5) A;F, (ASD), the link beam length,
e, is checked not to exceed the following:

_if p o3

e< {1.15—0.5p'i}|:1.6ﬂ}
Al Vs

(AISC SEISMIC 15-3)
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- if p'i <0.3

M
es{l.GV—p} (AISC SEISMIC 15-4)

p

where,

A, =(d-2t)t, (AISC SEISMIC 15.2b)
p'=P/V, (AISC SEISMIC 15.2b)
V, =V, (LRFD) (AISC SEISMIC 15.2b)
V, =V, (ASD) (AISC SEISMIC 15.2b)

If the check is not satisfied, the program reports an error message.

= The link beam rotation, €, of the individual bay relative to the rest of the beam is
calculated as the story drift A times bay length (L) divided by the total lengths of
link beams (&) in the bay.

The link rotation, @, is checked as follows (AISC SEISMIC 15.2c):

i
€

— 0<0.08 radian, where link beam clear length, e<1.6 M, /V,
— 06<0.02 radian, where link beam clear length, e >2.6 Mp/Vp

— 0 < value interpolated between 0.08 and 0.02 as the link beam clear
length varies from 1.6 M, /V, to 2.6 M, /V,.

The story drift is calculated as

_ Ast

A== (ASCE 12.8-15)
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where C, is a System Deflection Amplification Factor and | is the system

Importance Factor.

The beam strength outside the link is checked to be at least 1.1R, times the beam

force corresponding to the controlling link beam shear strength (AISC SEISMIC
15.6b). The controlling link beam nominal shear strength is taken as follows:

V. = min(V

n

2Mpa/e). (AISC SEISMIC 15.6, 15.2)

pa>

The values of V, and M, are calculated following the procedure described

previously (AISC SEISMIC 15.2). The correspondence between brace force and
link beam force is obtained from the associated load cases, whichever has the
highest link beam force of interest.

For load combinations including seismic effects, a load Q, is substituted for the
term E,where Q, is defined as the axial forces and moments generated by at least
1.1 times the expected nominal shear strength R,V (ASIC SEISMIC 15.6b).

All braces are checked to be at least Compact (AISC SEISMIC 15.6a, 8.2a, AISC
Table B4.1). The limits of the width-thickness ratio, A, have been presented in

this manual in Table 3-5. If this criterion is satisfied, the section is reported as
Compact as described earlier under the "Classification of Sections for Local
Buckling" section in Chapter 3. If this criterion is not satisfied, the program issues
an error message.

The brace strength is checked for 1.25R, times the brace forces corresponding to
the controlling link beam nominal shear strength amplified by R, (RyVn)(AISC
SEISMIC 15.6a). The controlling link beam nominal shear strengths are obtained

by the process described earlier (AISC SEISMIC 15.2b).

For load combinations including seismic effects, a load Q,, is substituted for the
term E, where Q, is defined as axial forces and moments generated by at least
1.25 times the expected nominal shear strength of the link RV, (ASIC SEISMIC

15.6a).

All column members are checked to be Seismically Compact according to Table
4-1 (AISC SEISMIC 15.8, 8.2b, Table 1-8-1). If these criteria are satisfied, the
section is reported as SEISMIC as described earlier under the "Classification of
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Sections for Local Buckling" in this chapter. If these criteria are not satisfied, the
program issues an error message.

= The column strength is checked for 1.1Ry times the column forces corresponding

to the controlling link beam nominal shear strength (AISC SEISMIC 15.8). The
controlling link beam nominal shear strength and the corresponding forces are
obtained by the process described previously.

Note: Axial forces in the beams are included in checking the beams. The user is
reminded that using a rigid diaphragm model will result in zero axial forces in the
beams. The user must disconnect some of the column lines from the diaphragm to
allow beams to carry axial loads. It is recommended that only one column line per
eccentrically braced frame be connected to the rigid diaphragm or that a flexible
diaphragm model be used.

Buckling Restrained Braced Frames (BRBF)

No special consideration for this type of framing system is given by the program. The
user is required to check the seismic design requirements for BRBF independently.

Special Plate Shear Walls (SPSW)

No special consideration for this type of framing system is given by the program. The
user is required to check the seismic design requirements for SPSW independently.

Joint Design

When using the SEISMIC design code, the structural joints are checked and designed
for the following.

= Check the requirement of continuity plate and determination of its area
= Check the requirement of doubler plate and determination of its thickness
= Check the ratio of beam flexural strength to column flexural strength

= Report the beam connection shear

Joint Design
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= Report the brace connection force

4.10.1 Design of Continuity Plates

In a plan view of a beam-column connection, a steel beam can frame into a column in
the following ways.

= The steel beam frames in a direction parallel to the column major direction, i.e.,
the beam frames into the column flange.

= The steel beam frames in a direction parallel to the column minor direction, i.e.,
the beam frames into the column web.

= The steel beam frames in a direction that is at an angle to both of the principal axes
of the column, i.e., the beam frames partially into the column web and partially
into the column flange.

To achieve a proper beam-column moment connection strength, continuity plates such
as shown in Figure 2.3 of Chapter 2 are usually placed on the column, in line with the
top and bottom flanges of the beam, to transfer the compression and tension flange
forces of the beam into the column. For connection conditions described by the first
bullet, where the beam frames into the flange of the column, such continuity plates are
not always needed. The requirement depends on the magnitude of the beam-flange
force and the properties of the column. This is the condition that the program
investigates. Columns of | Sections only are investigated. The program evaluates the
continuity plate requirements for each of the beams that frame into the column flange
(i.e., parallel to the column major direction) and reports the maximum continuity plate
area that is needed for each beam flange. The continuity plate requirements are
evaluated for moment frames (OMF, IMF, SMF) only. No check is made for braced
frames (OCBE, SCBF, EBF, BRBF).

The program first evaluates the need for continuity plates. When the required
strength P, exceeds the available strength ¢R,(LRFD) or R,/Q(ASD), as
appropriate, a continuity plate will be required. The program checks the following limit
states.

* The column flange design strength, ¢R,, and the allowable strength, R,/Q, for the

limit state of flange local bending is given as follows:
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R, =6.25t7 Fe if not at top story (AISC J10-1)
R, =(0.5)6.25t, F, if at top story (AISC J10.1)
where

¢ = 0.9 (LRFD)

Q =1.67 (ASD)

= The available strength of the column web against local yielding at the toe of the fillet
is given as follows:

R, = (5.0k, +t5)F.t, if not at top story (AISC J10-2)
R, =(2.5k, +t4)F,.t,. if at top story (AISC J10-3)
where

¢ =1.0 (LRFD)

Q=15 (ASD)

= The available strength of the column web against crippling is given as follows:

15
t t EF t
R, =0.80t, 1+3(§J(tt_w] —X® ifnot at top story

c fc we

(AISC J10-4)

t

c fc we

15
t EF t
R, =0.40t2 |1+ 3(%}(“—““} %fc, if at top story and t;, /d, <0.2

(AISC J10-5a)

t t

WC

15
t EF,t
R, =0.40t%, 1+[4f—0.2}[tﬂj —wr (AISC J10-5b)

fc
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where
¢ =0.75 (LRFD)
Q =2.0 (ASD)

= The available compressive strength of the column web against local buckling is
given as follows:

. _24t;c EF,

N q , if not at the top story (AISC J10.8)
c
12t} \JEF,
N = g ,  ifatthe top story. (AISC J10.8,J10.5)

If any of the preceding conditions are not met, the program calculates the required
continuity plate area as follows.

For LRFD:
P. —¢R
A :&, (AISC J10, J10.8, E3)
P ¢ F
c cr
For ASD:
(be - Rn /Q)
= (AISC J10, J10.8, E3)
FCI‘ /QC

In the preceding expressions, ¢c, ¢, and F¢ are taken as follows:

¢ = 0.90(LFRD) (AISC E1)
Qc, = 1.67 (ASD) (AISC E1)
Fer = Flexural buckling stress of equivalent column

related to the beam-column joint

The flexural buckling stress, Fcr, is determined as follows:
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FV
(0.658ﬁj|=y, it <Loa71 /E,
r F

F, = (AISC J10.8, E3)
0.877F,, if & >4.71 /E
r Fy

where F is the elastic critical buckling stress given by

_ n’E
CO(KLY
r

The member properties of the equivalent column are taken as follows:

(AISC E3-4)

= The cross-section is comprised of two stiffeners and a strip of the web having
a width of 25ty at the interior stiffener and 12t at the ends of the columns
(AISC J10.8).

= The effective length is taken as 0.75h, i.e., K=0.75and L = h = d. — 2t
(AISC J10.8).

L . . . .
is calculated based on the equivalent cross-section and equivalent length
r

stated here.

In addition to satisfying the preceding limit states, it is made sure that the
equivalent section, consisting of the stiffeners and part of the web plate, is able
to resist the compressive concentrated force (AISC J8). This is similar to a col-
umn capacity check. For this condition, the program calculates the required
continuity plate area as follows:

For LRFD:

P
® _25t2,  if notat top story

Acp:

c'cr
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P

A, = ; :i ~12t2,,  ifat top story (AISC J10.8, E3)
chcr

For ASD:

be 2 P

Ay, = £ 0 —25t,., if notat top story
cr C
be 2 P

A = F G —12t2., ifattop story (AISC J10.8, E3)
cr C

An iterative process is involved as A, r, and Fer are interdependent. If A is
needed, iteration starts with the minimum thickness and minimum width of the
continuity plate. A maximum of three iterations is performed.

If ACp <0, no continuity plates are required. If continuity plates are required, they

must satisfy a minimum area specification defined as follows:
= The minimum thickness of the stiffeners is taken as follows:

to" =0.5t, (AISC J10.8)

If the maximum thickness is more than the upper limit, the program reports an error.
Here it is assumed that the continuity plate can extend for the full width of the
column flange.

= The minimum width of the continuity plate on each side plus 1/2 the thickness of the
column web shall not be less than 1/3 of the beam flange width, or

min bfp t
b =2 5 (AISC J10.8)

= So that the minimum area is given by
o =tohy. (AISC J10.8)

p "~ cp

Therefore, the continuity plate area provided by the program is zero or the greater of
A, and AD".
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In the preceding equations,

A

Required continuity plate area

ch = Yield stress of the column and continuity plate material

d, = Beamdepth

d, = Column depth

h = Clear distance between flanges of column less fillets for rolled shapes

k. = Distance between outer face of the column flange and web toe of its fillet
M, = Factored beam moment

P, = Beam flange force, assumed as M /(d, —t,)

R, = Nominal strength

t,, = Beam flange thickness

t, = Column flange thickness

t,. = Column web thickness

¢ = Resistance factor (LRFD)

O]
1

Safety factor (ASD)

The special seismic requirements additionally checked by the program are dependent
on the type of framing used. Continuity plate requirements for seismic design are
evaluated for moment frames (OMF, IMF, SMF) only. No checks are performed for
braced frames (OCBF, SCBF, and EBF).

= For OMF, the continuity plates are checked and designed for a beam flange force,

be =M pb/(db _tfb)’

Ry =M,,/(d, —tg) (AISC SEISMIC 11.5)
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4.10.2

= For SMF and IMF, the continuity plates are checked and designed for a beam flange
force, By =R F byt

Py =R F,byty, (AISC SEISMIC 9.5, 10.5)

Note that the code insists on designing the continuity plate to match with tested
connection (AISC SEISMIC 9.5, 10.5, 11.5).

Design of Doubler Plates

One aspect of the design of a steel framing system is an evaluation of the shear forces
that exist in the region of the beam-column intersection known as the panel zone.

Shear stresses seldom control the design of a beam or column member. However, in a
Moment-Resisting frame, the shear stress in the beam-column joint can be critical,
especially in framing systems when the column is subjected to major direction bending
and the joint shear forces are resisted by the web of the column. In minor direction
bending, the joint shear is carried by the column flanges, in which case the shear
stresses are seldom critical, and this condition is therefore not investigated by the
program.

Shear stresses in the panel zone, due to major direction bending in the column, may
require additional plates to be welded onto the column web, depending on the loading
and the geometry of the steel beams that frame into the column, either along the
column major direction or at an angle so that the beams have components along the
column major direction. See Figure 2-3 of Chapter 2. The program investigates such
situations and reports the thickness of any required doubler plates. Only columns with |
Shapes are investigated for doubler plate requirements. Also doubler plate
requirements are evaluated for moment frames (OMF, IMF, SMF) only. No check is
made for braced frames (OCBF, SCBF, EBF).

The program calculates the required thickness of doubler plates using the following
algorithms. The shear force in the panel zone, is given by

v :i M,, cosé, Ry

p c’
n=1 dn _tfn
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The available strength of the web panel zone for the limit state of shear yielding is
determined as ¢R, (LFRD) or R, /<2 (ASD), as appropriate. Assuming that the effect

of panel zone deformation on frame stability has not been considered in analysis, the
nominal strength, R, is determined as follows:

R, =0.6F d.t for P. <0.4P,, and (LRFD J10-9)

y-cp?

R, =0.6Fdt, {1.4—%} for P. > 0.4P.,. (LRFD J10-10)

C

By using V, =¢R, (LRFD) or V, =R,/Q(ASD), as appropriate, the required

column panel zone thickness t is found as follows.

For LRFD:
Vv
] :”—/(I), for P. <0.4P,
O.6FydC
\Y
t, = »/9 5 for P. >0.4P..
O.6Fydc{1.4—']
R
For ASD:
Qv,
t,=——r, for P. <0.4P,
O.6FydC
QV,
t, = for P, >0.4P,

p 1
0.6F,d, [1.4—Prj
P

c

The extra thickness, or the required thickness of the doubler plate is given as follows:

typ, =1, -1,

where
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Fy = Column and doubler plate yield stress

t, = Required column panel zone thickness

t,, = Flange thickness of n-th beam

ty, = Required doubler plate thickness

t, = Column flange thickness

t, = Column web thickness

Vp = Required panel zone shear capacity k.

V. = Column shear in column above

n, = Number of beams connecting to column

d, = Overall depth of n-th beam connecting to column
0, = Angle between n-th beam and column major direction
d. = Overall depth of column

M,, = Factored beam moment from corresponding loading combination
R, = Nominal shear strength of panel

P = Required axial strength, P, (LRFD) or P, (ASD)

P, = Column axial yield strength, F A

P. = P, (LRFD)or 0.6F, (ASD)

® = 0.9 (LRFD)

Q

1.67 (ASD)

The largest calculated value of t, , calculated for any of the load combinations based

dp’
on the factored beam moments and factored column axial loads, is reported.
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Doubler plate requirements for seismic design are evaluated for SMF only. No further
check/design is performed for other types of frames.

= For SMF, the panel zone doubler plate requirements that are reported will develop at
least the beam moments equal to the expected plastic moment capacity of the beam

(RyMp), or beam moments due to specified load combinations involving seismic
load (AISC SEISMIC 9.3a). For seismic design, Vp is calculated using the equation

given previously, except that M oo 1S taken as RF,Zs;.

The capacity of the panel zone in resisting this shear is taken as:

3b, t2
, for P, <0.75P, (AISC J10-11)
d,d.t

cp

V, =0.60F,d.t,| 1+

3b, t?
V, =0.60F,d.t, [ 1+-—— 19-120 , for P >0.75P,  (AISC J10-12)
dyd.t, P

c
giving the required panel zone thickness as

V 3, t2
= /% 30 < if P <0.75P,
" 06Fd, d,d,

(AISC SEISMIC 9.3a, AISC J10-11)

Y, 3o, t2
t = o/ & -9 if P, >0.75P,.

p b
0.6Fydc(1.9—1.2p'] .
P

C

(AISC SEISMIC 9.3a, AISC J10-12)

In the preceding expression, the term Vp/d)v is replaced by Q\V, if the ASD

provision is followed. The required doubler plate thickness is calculated as

tpy = T, — T

p

where,
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= 1.0 (LRFD) (AISC J10.6, SEISMIC 9.3a)
Q = 150 (ASD) (AISC J10.6, SEISMIC 9.3a)
by = width of column flange
t; = thickness of column flange
t = required column web thickness

d, = depth of deepest beam framing into the major direction of the

column
All other terms were explained previously.

= For SMF, the program checks the following panel zone column web thickness
requirement:

(d, -2ty )+(d, —2t,,)
90 '

t> (AISC SEISMIC 9.3b)

Here, t is taken as . +tdp when the doubler plate is plug welded to prevent local
buckling. In such cases, tdpis increased if necessary to meet this criterion. If the
doubler plate is not plug welded to the web, t is taken as t,. and also as t,, for
checking both the plates. If t,. cannot satisfy the criteria, then a failure condition is
declared. If T, does not satisfy this criterion, then its value is increased to meet the

criteria. If the check is not satisfied, it is noted in the output.

4.10.3 Weak Beam Strong Column Measure

Only for Special Moment Frames (SMF) with seismic design category (SDC) A to F,
the code requires that the sum of column flexure strengths at a joint should be more
than the sum of beam flexure strengths (AISC SEISMIC 9.6). The column flexure
strength should reflect the presence of axial force present in the column. The beam
flexural strength should reflect potential increase in capacity for strain hardening. To
facilitate the review of the strong column weak beam criterion, the program will report
a beam-column plastic moment capacity ratio for every joint in the structure.
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For the major direction of any column (top end), the beam-to-column-strength ratio is

obtained as
Ny
> My, cos6,
R —nt 0 (AISC SEISMIC 9.6)
" M pcax + M pcbx

For the minor direction of any column, the beam-to-column-strength ratio is obtained

as
My
D My, sin6,
R =nt (AISC SEISMIC 9.6)
™ M pcay +M pcby
where,
Rmaj = Plastic moment capacity ratios, in the major directions of the
column
Ruin = Plastic moment capacity ratios, in the minor directions of the
column
M, = Plastic moment capacity of n-th beam connecting to column
0, = Angle between the n-th beam and the column major direc-
tion
M ., =Major and minor plastic moment capacities, reduced for axial
force effects, of column above story level
M ., = Major and minor plastic moment capacities, reduced for axial
force effects, of column below story level
n, = Number of beams connecting to the column

The plastic moment capacities of the columns are reduced for axial force effects and
are taken as
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M, =Z | F |-

pc c yc

* I FC
M =Z|| £ |-
15

J (LRFD) (AISC SEISMIC 9.6)

P

uc

A

9

} (ASD) (AISC SEISMIC 9.6)

The plastic moment capacities of the beams are amplified for potential increase in
capacity for strain hardening as

M?, =1.1R F,Z, f., (LFRD) (AISC SEISMIC 9.6)

y' yb=b "mv

pb y' yb=b "mv>

M* {%)R F,Z.f ., (ASD) (AISC SEISMIC 9.6)

where,

Z, = Plastic modulus of beam

Z. = Plastic modulus of column

F,, = Yield stress of beam material

F,. = Yield stress of column material

P. = Axial compression force in column for given load combination

Ag = Gross area of column

f = The moment amplification factor. It is taken as the ratio of beam

mv
moment at the centerline of column to the moment of the column face.
This factor takes care of the M, (LRFD) or M, (ASD) of the code

(AISC SEISMIC 9.6). f_, is taken as follows:
d
f., = 1+— where,

mv
b

d. = Depth of column section, and

C
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L, = clear span length of the beam.

For the preceding calculations, the section of the column above is taken to be the same
as the section of the column below, assuming that the column splice will be located
some distance above the story level.

Evaluation of Beam Connection Shears

For each steel beam in the structure, the program will report the maximum major
shears at each end of the beam for the design of the beam shear connections. The beam
connection shears reported are the maxima of the factored shears obtained from the
loading combinations.

For special seismic design, the beam connection shears are not taken less than the
following special values for different types of framing. The special seismic
requirements additionally checked by the program are dependent on the type of
framing used and the Seismic Design Category.

= For SMF, the beam connection shear is taken as the maximum of those from regular
load combinations and those required for the development of full plastic moment
capacity of the beam. The connection shear for the development of the full plastic
moment capacity of beam is as follows:

CM,,
V, = = +V,, +V,, (LRFD), (AISC SEISMIC 9.2a(3))
h
CM
V, =(0.7) 3 +Vp, +V. (ASD), (AISC SEISMIC 9.2a(3))
where,

Vv = Shear force corresponding to END | or END J or beam
C = 0 if beam ends are pinned, or for cantilever beam

= 1if one end of the beam is pinned

= 2if no ends of the beam are pinned
M,, = Plastic moment capacity of beam=11R M,

Joint Design



Chapter 4 Special Seismic Provisions

L, = Clear length of the beam

Vo, = Absolute maximum of the calculated beam shears at the

corresponding beam ends from the factored dead load only

V., = Absolute maximum of the calculated beam shears at the

corresponding beam ends from the factored live load only

= For IMF, the beam connection shear is taken as the minimum of the two values: (a)
maximum shear from the load combinations and (b) maximum shear based on beam
moment capacity of the beam (AISC SEISMIC 10.2a(2)).

The maximum shear from the load combinations is determined from all of the
regular load combinations and also from the amplified seismic load combinations
(AISC SEISMIC 10.2a(2), ASCE 14.4.3). For LRFD or ASD provisions, appropriate
load combinations are considered. The load combination for amplified seismic load
combinations are also described previously in the "Design Loading Combinations"
section.

The maximum shear based on beam moment capacity is calculated for any load
combination involving seismic load by replacing the seismic effect on shear force
with the capacity shear as follows:

CM
V =

u

® 4V, +V, (LFRD), (AISC SEISMIC 10.2a(2))

h

CM
V, =(0.7) 1 P 4V, +V, (ASD). (AISC SEISMIC 10.2a(2))
h

All parameters in the preceding equation have been described previously in this
section.

= For OMF, the beam connection shear is taken as the minimum of the two values: (a)
maximum shear from the load combinations and (b) maximum shear based on beam
moment capacity of the beam (AISC SEISMIC 11.2a(4)).

The maximum shear from the load combinations is determined from all of the
regular load combinations and also from the amplified seismic load combinations
(AISC SEISMIC 11.2a(4), ASCE 14.42.3). For LRFD or ASD provisions,
appropriate load combinations are considered. The load combination for amplified
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seismic load combinations also are described previously in the "Design Loading
Combinations™ section.

The maximum shear based on beam moment capacity is calculated for any load
combination involving seismic load by replacing the seismic effect on shear force
with the capacity shear as follows:

CM
V, = 1 ® +V,, +V, (LFRD), (AISC SEISMIC 11.2a(4))
h
CM,,
Vv, =(0.7) C = +V,, +V,, (ASD). (AISC SEISMIC 11.2a(4))

h

All parameters in the preceding equation have been described previously in this
section. The moment connection is assumed to be FR.

= For SCBF the beam connection shear is taken as the maximum of those from
regular load combination and those from amplified seismic load combinations.

= For OCBF and OBFI, the beam connection shear is taken as the maximum of those
from regular load combinations and those from amplified seismic load
combinations.

= For EBF, the beam connection shear is taken as the minimum of the two values:
(a) maximum shear from the load combinations and (b) maximum shear based on
link beam shear capacity (AISC SEISMIC 15.7, 11.2a(4)).

The maximum shear from the load combinations is determined from all of the
regular load combinations and also from the amplified seismic load combinations
(AISC SEISMIC 15.7, 11.2a(4), ASCE 14.2.3). For LRFD or ASD, appropriate load
combinations are considered. The load combinations for amplified seismic load
combinations also were described previously in the "Design Loading Combination"
section of this chapter.

The maximum beam connection shear based on link beam shear capacity is taken as
the beam connection shear that can be developed when the link beam yields in shear.
The load factor for the seismic component of the load in the combination is
calculated to achieve forces related to yielding of the link beam. For connection
shear determination, the forces are further amplified by 1.1R, (AISC SEISMIC

15.7, 11.2a(4)).
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If the beam-to-column connection is modelled with a pin in the program by releasing
the beam end, it automatically affects the beam connection shear.

4.10.5 Evaluation of Brace Connection Forces

For each steel brace in the structure, the program reports the maximum axial force at
each end of the brace for the design of the brace-to-beam connections. The brace
connection forces reported are the maxima of the factored brace axial forces obtained
from the loading combinations.

For special seismic design, the brace connection forces are not taken less than the
following special values for different types of framing. The special seismic
requirements additionally checked by the program are dependent on the type of
framing used.

Bracer axial forces for seismic designs are evaluated for braced frames (SCBF, 10BF,
OCBF, EBF) only. No special checks are performed for moment frames (OMF, IMF,
SMF).

= For SCBF, the bracing connection force is taken as the minimum of the two values
(AISC SEISMIC 13.3a):

The expected yield strength in tension of the bracing member, determined as
R,F,A, (LFRD) or R/F A, /1.5 (ASD), as appropriate (AISC SEISMIC
13.3a(a)).

The maximum load effect of the amplified seismic load combination (AISC
SEISMIC 13.3a(b)).

Note that the required bracing connection force for the required compressive
strength of the brace based on limit state of buckling that is equal to 1.1R,P,

(LFRD) or (1.],/1.5)RyPn (ASD), as appropriate (AISC SEISMIC 13.3c), is

always less than the corresponding value considered in case (a). So this limit
state is not considered.
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= For OCBF or OCBFI, the bracing connection force is taken as the minimum of the

two values (AISC SEISMIC 14.4):

a. The expected yield strength in tension of the bracing member, deter-
mined as R F,A; (LFRD) or R F A /1.5 (ASD), as appropriate (AISC

SEISMIC 14.4(2)).

b. The maximum load effect of the amplified seismic load combination
(AISC SEISMIC 14.4 Exception (b)).

For EBF, the required strength of the diagonal brace connection at both ends of the
brace is taken as the maximum of the following two values: (a) the maximum
connection force from the design load combinations, and (b) the maximum brace
connection force based on the link beam shear capacity (AISC SEISMIC 15.6¢, and
15.6a).

The maximum connection force from the load combinations is determined for all the
regular load combinations. The amplified seismic load combinations are not
considered.

The maximum brace connection force based on link beam shear capacity is taken as
the brace connection force that can be developed when the link beam yields in shear.
The load factor for seismic component of the load in the combination is calculate to
achieve forces related to yielding of the link beam. For connection force
determination, the forces are further amplified by 1.25R, (AISC SEISMIC 15.6e,

15.6a).
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Chapter 5
Design Output

The program has the capacity to create design output in four major ways —
graphical display, file output, tabular display, and member specific detailed de-
sign information. The graphical display includes input and output design in-
formation for members visible in the active window; the display can be sent
directly to a printer or saved to a file. The file output includes both summary and
detail design data that can be saved in RTF, HTML and plain text formats. The
tabular display output includes both summary and detail design data that can be
displayed or saved in many formats, including Excel, Access, RTF, HTML and
plain text. The member specific detailed design information shows the details of
the calculation.

The following sections describe some of the typical graphical display, file out-
put, tabular display output, and member specific detailed design information.
Some of the design information is very specific to the chosen steel design code.
This manual addresses "AISC 360-05/IBC 2006" design code related output
information only.

Graphical Display of Design Information

The graphical display of design output includes input and output design infor-
mation for all steel frame members that are visible in the active window. The
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graphical output can be produced in color or in gray-scaled screen display. The
active screen display can be sent directly to the printer or saved to a file in sev-
eral formats.

Design input data displayed includes the following items for the "AISC
360-05/1BC 2006" code, as shown in Figure 5-1:

= Design sections
= Design framing type
= Live load reduction factors

= Unbraced length ratios, L factors, for major and minor direction of bending,
and for lateral-torsional buckling

= Effective length factor for non-sway condition, K; factors, for major and
minor directions of bending

= Effective length factor for sway condition, K, factors, for major and minor
directions of bending

= Effective length factors, K,, for lateral-torsional buckling
= C,, factors for major and minor directions of bending
= C, factors for major and minor directions of bending
= B, factors for major and minor directions of bending

= B, factors for major and minor directions of bending

Graphical Display of Design Information
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Display Steel Design Results (AISC360-05/IBC:

" Dezign Output | j

£ [Diezsign Input

(Design Hior
Dezign Framing Type
Live Load Red Factors
0K  |Unbraced Length B atios
Effective Length Factars, K1
]

CHmrbiim | mnmble O mbmrn

Figure 5-1 Choice of design input data for display on the model
in the active window

= ), factors
* Yield stress, F,

= Nominal axial capacities
= Nominal bending capacities

= Nominal shear capacities

Output design data plotted on the model includes the following items for the
"ACI 360-05/IBC 2006" code as shown in Figure 5-2:

= P-M stress ratio values with members color-coded based on the ratio
= Shear stress ratio

= Continuity plate and doubler plate thickness

Beam/column capacity ratios
= Beam connection shear force

= Brace connection axial force
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L2006

et el

Display Steel Design Results (AISC360-05/16

£ Diesign Output IF'-M R atio Calors & Values j

" Design Input P-M Ratio Colors/no Yalues

Cont. Plate Area/Doubler Plate Thick,
Beam/Column Capacity R atios =
Pt Colars/Beam Shear Force

0K  |P-M Colors/Brace Asial Force

Figure 5-2 Choice of design output data for display on the model
in the active window

Use the Design menu > Steel Frame Design > Display Design Info command
in SAP2000/ETABS and the Advanced > Frame Design > Steel > Display
Design Information command in CSiBridge to plot design input and output
values directly on the model. The Display Steel Design Results form shown in
Figures 5-1 and 5-2 will display. Choose the Design Output or Design Input
option. One item can be selected from the drop-down list. For example, the P-M
interaction ratios can be displayed by choosing the Design Output option and
selecting P-M Ratio Colors & Values from the drop-down list. Click the OK
button to display the longitudinal reinforcing in the active window.

The graphics can be displayed in 3D or 2D mode. The standard view transfor-
mations are available for all steel design information displays. Several buttons
on the toolbar can be used to switch between 3D and 2D views. Alternatively,
click the View menu and the Set 3D View or Set 2D View commands.

The onscreen graphical display can be sent to printer using any of the following
commands. Use the File menu > Print Graphics command in
SAP2000/ETABS and the Orb > Print > Print Graphics command in
CSiBridge to print the active window. To capture the graphical display in a file
for printing through another application, use the File menu > Capture En-
hanced Metafile command in SAP2000/ETABS and the Orb > Pictures >
Metafile command in CSiBridge to create an .emf file, or use the File menu >
Capture Picture command in SAP2000/ETAB and the Orb > Pictures com-
mands in CSiBridge to create a bitmap (.bmp) file. Create a screen capture of the
active window using the Alt+ Print Screen keyboard keys in SAP2000/ETABS

Graphical Display of Design Information
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or create a screen capture of the entire window using the Ctrl + Print Screen
keyboard keys. Then use the Ctrl+V keyboard keys to paste the saved image
into Paint or other graphical program.

By default the graphical displays are in color. It may be advantageous to view or
present the display in gray-scale graphics or using a white background. Use the
Options menu > Color command in SAP2000/ETABS and the Orb > Settings
> Colors command in CSiBridge to set these options.

Tabular Display of Design Information

In addition to model definition and analysis results, the design information for
all steel frame members or for only selected members can be displayed in tabular
spreadsheet format. Currently, the program generates design summary data,
PMM design details and shear design details. The tabular spreadsheet output can
be displayed by selecting the Display menu > Show Tables command in
SAP2000/ETABS and Home > Display > Show Tables command in CSiBridge
to access the Choose Tables for Display form, an example of which is shown in
Figure 5-3. That form can be used to choose which tables or sets of tables are to
be displayed.

The names of the tables are displayed in a tree structure, which can be collapsed
or expanded by clicking on an item in the tree. Click on the small check boxes
preceding the items to select those tables for display. If a branch of the tree is
selected, all of the tables under that branch are selected. The selected set of ta-
bles can be saved as a Named Set using the Save Named Set button. This named
set can be used in the future for quick selection. If one or more frame members
are selected on the structural model before accessing the Choose Tables for
Display form, the Selection Only check box will be checked when the form
displays and, the program will display information for the selected members
only; uncheck the check box to display information for all applicable "unse-
lected" members in the model. If the Show Unformatted check box is checked,
the numbers will be displayed unformatted, instead of being displayed using a
limited number of decimal digits. The unformatted option provides higher pre-
cision output that can then be copied into other programs.

Tabular Display of Design Information 5-5
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Choose Tables for Display

Edlit

EAmEMODEL DEFIMITION [0 of 48 tables zelected)
&[] System Data
E!D Property Definitions
#-0 Load Definitions
#-0] Dther Definitions
Bal] Analysis Case Definitions
Bil] Connectivity Data
#-0] Joint Assignments
#-0] Frame Assignments
ED Options/Preferences Data
&[] Miscellaneous D ata
-0 AMALYSIS RESULTS (0 of 12 tables selected)
ED Joint Dutput

—Load Cazes [Model Def.]

Select Load Cases... |

28 of 28 Selected

—Analyziz Cazes [Fesults)

Select Analysis Cases... |

2 of 183 Selected

Modify/Show Options. .. |

— Optionz
= Selention Hrly
™ Show Unformatted

#-[] Element Output
&-[] Structure Output
-[{ DESIGH DATA [3 of 3 tables selected)
&-& Steel Frame
EIE Steel Summary D ata
. & Table: Steel Design 1 - Summary D ata - A1SC350-05/IBC2006 - Mamed Sets

EIE Steel Detail Data Save Mamed Set... |
"B Table: Steel Design 2 - PMM Details - AISC360-05/1BC2006 =
[ Table: Stesl Design 3 - Shear Details - A1SC360-05/1BC2005 Show HeredSet |

[elete Named Set.. |

Cancel |

T able Formats File... I Current Table Formats Fils: Program Default

Figure 5-3 Choice of design data tables for tabular display

Use the other buttons in the form to tailor the data display. For example, click the
Select Load Patterns button to specify which load patterns are to be included in
the display of model definition data; click the Select Load Case and Modi-
fy/Show Options to specify which load cases are to be included and how
analysis results are displayed.

After selecting all of the tables for steel frame design and the display options,
click the OK button to display a form showing one of the selected design tables,
with a drop-down list in the upper right-hand corner of the form that can be used
to select other tables for display. A typical design table is shown in Figure 5-4.

5-6 Tabular Display of Design Information
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Steel Design 1 - Summary Data - AISC360-05/IBC2006
File Wiew Format-Filter-Sort  Select  Options
Units: As Moted [Steel Design 1 - Summary Data - AISCIE0-05/AE C2005 ﬂ
Frame DesignSect DesignType Status Ratio RatioType Combo
Text Text Text Text Unitless Text Text
» 1 w480 Column HNo Messages 0.769375 Ph DSTLS
2 Wil =90 Colurmr Mo Messages 0912779 Phdkd DSTLS
3 Wil =90 Colurmr Mo Messages 0.914659 Phdkd DSTLS
4 wil4=90 Calumn MNo Meszages 0.461798 Phikd DSTLS
5 Wil =90 Colurmr Mo Messages 0769375 Phdkd DSTLS
E Wwild=90 Colurnr Mo Messages 0912779 Phdkd DSTLS
7 Wadxhh Beam Mo Messages 0876453 Phdkd DSTLS
8 W2dxEn Beam Mo Messages 0.934805 Phdbd DSTLS
9 Wadxhh Beam Mo Messages 0876453 Phdkd DSTLS
10 W2dxEh Beam Mo Messages 0.934805 Phdbd DSTLE
| »
Record: | 14] 4] 1 b e ot1o Add Tables... | Done

Figure 5-4 A typical tabular display of design data

Use the scroll bars on the bottom and right side of the tables to scroll right and
left or up and down if portions of the data table can not be displayed in the form's
display area. The columns can be resized by clicking the left mouse button on
the separator of the headers, holding down the left mouse button and then
dragging the mouse to the left or right. Reset the column widths to their default
values by selecting the Format-Filter-Sort menu > Reset Default Column
Widths command on the form. The table can be split into two or more tables by
clicking on the small black rectangular area near the bottom-left corner of the
table, holding down the left mouse button, and then dragging the mouse button
to the left or right. Repeat this process to add more splits. Use the split and
horizontal scroll bar to put two columns side by side for easier comparison. The
splits can be removed by selecting the Format-Filter-Sort menu > Remove
Splits command on the form. Alternatively, remove the split by clicking, hold-
ing and dragging the left mouse button to merge the split key to its original lo-
cation.

Select multiple consecutive columns by putting the cursor on the header, holding
down the mouse button, and then dragging the mouse button left or right. Al-
ternatively, depress the Shift key and click the left mouse button to select a range
of columns.

Tabular Display of Design Information 5-7
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Each of the individual fields (columns) can be formatted. Fields with text in-
formation can be set for specific types of alignment (center, left, right) and to
specific widths. In addition to setting the alignment and column widths, fields
with numeric data can be set for the maximum number of characters, zero tol-
erance, number of decimal digits and so forth. The tables can be formatted, fil-
tered and sorted using multiple criteria accessed using the Format-Filter-Sort
menu on the form. Filtering and sorting features can be useful in identifying
critical cases. After specifying the table formatting information, save it to a
format file that can be used in the future by selecting the appropriate feature
available under the Format-Filter-Sort menu.

The current table (i.e., the table in the active window) can be exported to Excel,
Access, .rtf., .html, and plain text formats. In both Excel spreadsheet and Access
database formats, the tables can have many columns, making the tables very
wide. In .rft and .html formats, the tables are split at convenient points to make a
reasonably printable document. In plain text format, the tables can be saved with
or without the splits. To export a table to Excel, for example, select the File
menu > Export Current Table > To Excel command. The program will export
the entire table to an Excel spreadsheet workbook and will automatically open
the file in MS Excel. Similarly, if the table is exported to other formats, the
default editor specific to that format will open the document, provided that the
editor is available in the computer. The table will be saved in that format only if
the relevant editor is not available. Instead of exporting or displaying the cur-
rently displayed table, the entire set of available tables can be exported and
displayed in the afore-mentioned formats by selecting the File menu and the
appropriate submenu command. With these exporting and display features, the
tables can be saved in many required formats and can be printed. Many other
features of the design tables are left for the user to discover by using the pro-
gram.

Detailed Display of Member Specific Information

The program has the capability to display the design details for a specific
member. The information includes member identification, shape name, section
properties, design combination name, design combination forces, and other de-
sign input data to check the design results. The information also includes stress
ratios for P-M-M and other interactions, demand/capacity ratios from shear,

Detailed Display of Member Specific Information
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nominal strengths, design factors such as K, C,,, C,, B,, B,, and so forth. The

design details are displayed in a summary form and also are displayed for a
specific load combination and for a specific station of a frame member.

When the design results are displayed on the model in the active window, the
detailed design information can be accessed by right clicking on the desired
frame member to display the Steel Stress Check Information form. Alterna-
tively, click the Design menu > Steel Frame Design > Interactive Steel
Frame Design command and then right click on the frame member. An example
of that form is shown in Figure 5-5.

Steel Stress Check Information {(AISC360-05,/1BC2006)

Frame 1D I31 Analyzis Section IW'| B35
Design Code  jI5C360-05/1BC2006 Design Section i1 80435
COMED STATION /----MOMENT INTERACTION CHECK----- £ /-MAT-5HR---NIN-5HE- £
1D Loc EATIO = A¥L + B-M4J + B-MIN RATTIO RATIO
DATL154 96.00 0.005(T) = 0,000 + 0.003 + 0,000 0,000 0.00a0 _ﬂ
DATL154 120,00 0.008(T) = 0,000 + 0.007 + 0,000 0,000 0.00a0
DATL154 144,00 0.00e(T) = 0,000 + 0.00&6 + 0,000 0,001 0.00a0
DATL154 165,00 0.003(T) = 0,000 + 0.002 + 0,000 0,002 0.00a
DETL1S4 192.00 0.003({T) = 0.000 + 0.002 + 0,001 o.o0o02 o.0oo0
DSTL1S4 216.00 0.009(T) = 0.000 + 0.007 + 0.001 0.003 o.0oo0
DETL1S4 240,00 0.015(T) = 0.000 + 0.014 + 0,002 0.003 0.000 -
DSTLLSS : 0.057(T) = 0.000 + + 0.006 0.001  0.000
— Modifp/Show Dvenantes Dizplay Details for Selected ltem—————— 1~ Digplay Complete Details
_Overuries | W { _ Deisis | [ Tabular Dl W

Stylezheet: Default

Cancel I T able Format File I

Figure 5-5 A typical member specific steel stress check information summary

The Steel Stress Check Information form identifies the frame members and the
analysis and design section, and includes a display area of mostly de-
mand/capacity ratio data and a set of buttons that access forms that provide
further details about the selected frame member. The display area reports the
load combinations, the stress check stations, the P-M-M interaction ratio along
with its axial and flexural components, and the shear stress ratios. The load
combination is reported by its name, while the station is reported by its location,
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which is measured from the I-end of the column. The number of reported line
items in the text box is equal to the number of design combinations multiplied by
the number of stations. Only one line item is highlighted in blue when the form
first displays. That item highlights the largest demand/capacity ratio from
P-M-M, major and minor shear or any other considered interaction ratio, unless
a line item(s) has design overstress or an error. In that case, the item with the
overstress or error will be selected and highlighted. If many line items are
overstressed or have an error, the last among all such line items will be selected
and highlighted.

The stress check information is always reported for the design section. If the
member is assigned an individual section, the analysis and design section are
always the same. If the member is assigned an Auto Select Section (a list of
sections), the analysis and design section can be different, unless the design has
converged.

The Overwrites and Details buttons near the bottom of the Steel Stress Check
Information form can be used to access the Steel Frame Design Overwrites form,
and the Steel Stress Check Data form, which displays detailed information about
the selected frame element. While the latter form displays information in a
non-editable format, the Overwrites form display the overwrite data in editable
format. This allows the user to enter an interactive mode of design.

= Overwrites button. Click this button to access the Steel Frame Design
Overwrites form. Use that form to make revisions to the steel frame design
overwrites and then immediately review the new design results as a summary
using the Steel Stress Check Information form, or in detail by clicking the
Details button to access the Steel Stress Check Data form. Clicking the OK
button on the Steel Frame Design Overwrites form temporarily saves any
changes. To make the changes permanent, click the OK button on the Steel
Stress Check Information form. To disregard the changes, click the Cancel
button on the Steel Stress Check Information form. An example of an Over-
writes form is shown in Figure 5-6.

Detailed Display of Member Specific Information
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Steel Frame Design Dverwrites for AISC 360-05/IBC 2006 )

Selected Items |

o Prog Determined [Default] Yalues —
Allltems | ‘[

Item Yalue |
1 | Current Design Section Frogram Determined _|
2 | Framing Type Pragram Determined
3 [ Omegal Frogram Determined
4 | Congider Deflection? Mo
5 | Deflection Check Type Pragram Determined
E |DL Limit, L / Programm Determined
7 | Super DL+LL Limnit, L # Program Determined
8 |Live Load Limit, L / Program Determined
9 | Tatal Limit, L/ Program Determined
10 | Total-Camber Limit, L/ Program Determined
11 | DL Limnit, abs Program Determined
12 | Super DL+LL Limit, abs Frogram Determined
13 |Live Load Limit, abs Pragrarn Detarrined
14 | Tatal Limit, abs Program Determined
15 | Tatal--Camber Limit, abs Program Determined
16 | Specified Camber Pragram Determined
17 | Met Areato Total Area B atio Frogram Determined
18 | Live Load Reduction Factar Pragram Determined
19 | Unbraced Length Ratio [Major] Frogram Determined
20 | Unbraced Length Ratio [Minar) Program Determined
21 |Unbraced Lenagth Fatio [LTE] Frogram Determined
22 | Effective Length Factaor [K1 Majar) Pragram Determined
23 | Effective Length Factor [K.1 Minor] Frogram Determined
24 | Effective Length Factar [K.2 Majar) Pragrarm Detamrmined -|
~SetT Feset To Previous Yalues

All lterns | Selected ltems I

— Item Description

||

— Explanation of Colar Coding for Walues
Blue: All selected items are program
determined

Black: Some selected iters are user
defined

Red:  Valus that has changed during

the current session

Cancel I

Figure 5-6 A typical member specific Steel Frame Design Overwrites form

= Details button. Click this button to access the Steel Stress Check Data form.
Use the form to review all of the design details for the highlighted item. An
example of a Steel Stress Check Data form is shown in Figure 5-7. The in-
formation includes the member ID, load combo and station identifications,
steel design sections, section properties, design combination forces, stress ra-
tios for P-M-M and other interactions, stress ratios for shear, nominal
strengths, and design factors such as, C,,, C,, B,, B,, and so forth. Values

that are not applicable are reported as N/A. Similarly, N/C and N/N indicate an
item is “Not Calculated” and “Not Needed.”

Detailed Display of Member Specific Information
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x
File
Urits |Kip, in, F =

AISC 360-05/1BC 2006 STEEL SECTION CHECK

Combo - DSTL1

Units : Kip, in, F

Frame : 28 Design Sect: W8X35

X Mid : -188.8600 Design Type: Beam

¥ Wid : 2u8.888 Frame Type : Special Homent Frame

2 Mid : 288.0680 Sect Class : Compact

Length : 360.000 Hajor Axis : 0.000 degrees counterclockwise from local 3

Loc : 360.0888 RLLF : 1.888 S

Area : 19.3008 SMajor : 57.627 rHajor : 7.837 AVHajor: 5.310

IMajor : 510.0600 SWinor : 5.188 riinor : 1.219 AUHinor: 4.250

IMinor : 15.388 ZHajor : 66.588 E : 29808.8088

Ixy : 6.888 ZHinor : 8.8608 Fy : 58.088

DESIGH MESSAGES

k1l/r >/ 2008 (AISC B7)

STRESS CHECK FORCES & MOMENTS

Location Pu Hu33 Hu22 Uu2 Uu3 Tu
360.000 -06.399 —49 . 482 6.000 8.783 6.000 0.600
PriM DEMAND/CAPACITY RATID
Governing Total P HHa jor MHinor Ratio Status
Equation Ratio Ratio Ratiol Ratio Limit Check
{H1-1b) 8.054 = 8.067 + 0. 846 * 8.0680 8.950 0K
AXTAL FORGE DESIGH
Pu phi=Pnc phi=Pnt
Force, Capacity Capacity
Axial -8.399 26.678 463 .508
HOMENT DESIGH
Hu phixtin cm B1 B2 K L Ch
Homent Capacity Factor Factor Factor Factor Factor Factor
Major HMoment —49 465 10865.592 1.6000 1.000 1.008 1.6800 1.600 2.254
Minor Moment 6.000 362.700 1.000 8.938 1.008 1.6800 1.000
SHEAR DESIGH
Uu phi=Un Stress Status Tu
Force, Capacity Ratio Check Torsion
Major Shear 8.783 159.388 8.885 0K 8.0808
Minor Shear B.pa0 137.788 06.008 0K 06.088
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Figure 5-7 A typical Steel Stress Check Data form

Before clicking the button, highlight an item for the desired design station
and design load combination in the Steel Stress Check Information display
area by clicking on the line. The data subsequently displayed will relate to
the highlighted item. By default, the most critical line item is selected
when the form first displays, as described previously.

To increase or decrease the width of the Steel Stress Check Data form, put
the cursor near the right edge of the form, click the left mouse button, and
drag the mouse cursor towards the left or right. Similarly, the height of the
form can be increased or decreased.

The text in the form can be dragged in any direction by positioning the
cursor in the middle of the form, and then clicking the left mouse button

Detailed Display of Member Specific Information
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and dragging the text in the desired direction. Similarly, the graphical
display of the column section can also be dragged in any direction.

Use the Units drop-down list in the upper right-hand corner of the form to
change the units used to display the data. Data displayed on the form can
be sent directly to the printer by selecting the File menu > Print command
on the form. The program allows limited page setup options using the
Print Setup Command on the File menu on the form.

The Steel Stress Check Information form also includes a Tabular Data button
that when clicked displays member specific design details in a spreadsheet type
format. The tabular display of design information has been described in the
previous section. In that case, the information displayed is specific to the se-
lected member only. The tabular output is shown for all stations and all design
load combinations for the selected member. An example of design details table
that displays after clicking the Tabular Data button is shown in Figure 5-8.

File View Format-Fiter-Sort Sel=ct  Cptions
Units: A5 Noted [Stesl Details 1 - Summany Data - AISCIE0-06ABC2006 =l
Frame DesignSest | DesignType Status Ralio]  RalioType Tombo Location EnMsg WamMsg |
Text Text ext ext Unitless Text Text in Text Text
¥ WiB35 am o Messages 000242 Msjor Shear T o Messages o Messages -
WIBKE cam o Messages 003432| B o Hessages o Messages
W1E35 cam o Messages 008871 [ o Messages o Messages
WiBK35 am o Messages 008059 ? o Messages o Messages
WIBKE cam o Messages 003456 % o Messages o Messages
W1E35 cam o Messages 008652 2 o Messages o Messages
WiBK35 am o Messages 006477 a4 o Messages o Messages
WIBKE cam o Messages 0.0029] 68| o Messages o Messages
WIB35 am o Messages 002508 Maior Shear 9| o Messages o Messages
WIBKE cam o Messages 008459 £ 1 o Messages o Messages
W1E35 cam o Messages 016208 i I o Messages o Messages
WiBK35 am o Messages 002075 Maior Shear o Messages o Messages
WIBKE cam o Messages 002353 B o Messages o Messages
W1E35 cam o Messages 000588 [ o Messages o Messages
WiBK35 am o Messages 007534| ? o Messages o Messages
WIBKE cam o Messages 008105 % o Messages o Messages
W1E35 cam o Messages 007424| 2 o Messages o Messages
WiBK35 am o Messages 008551 a4 o Messages o Messages
WIBKE cam o Messages 002426 68| o Messages o Messages
W1E35 cam o Messages 000215]  Major Shear 9] o Messages o Messages
WiEK35 eam o Messaaes 0007251 P 161 o Messages o Messanes i
4 o[
Record [M] 4] T [bl] of 1534 Add Tables
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Figure 5-8 Member specific design details in tabular format

Output of Design Information

In addition to model definition and analysis results, the design information for
all steel frame members or for selected frames only can be saved in tabular
format. Currently for AISC 360-05/IBC 2006 code, the program saves design
summary data, PMM design details, and shear design details. Save the file
output by selecting the File menu > Print Tables command in SAP2000/ETAB

Output of Design Information ~ 5- 13
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Choose Tables for Printing

Edit

and the Orb > File > Print > Print Tables command in CSiBridge to access the
Choose Tables for Printing form. An example of that form is shown in Figure
5-9. Use the options on the form to choose which table or set of tables to save in
a file or print. This form is very similar to the Choose Tables for Display form,
which has been described earlier in this chapter in the "Tabular Display of De-
sign Information™ section.

Table Formats File... | Current Table Formats File: Program Default

EYRTMODEL DEFINITION [0 of 48 tables selected) —Load Cases (Model Def.)
Eil] System Data Select Load Cases... I
ED Property Definitions 20 of 28 Selected
#-[0 Load Definitions
ED Other Definitions —&nalysis Cases [Fesults)
ED Analysis Case Definitions Select Analysis Cases... I
&[] Connectivity Data 2 of 183 Selected
#-0 Joint Assignments
ED Frame Assignments Modify/S how Options... I
B}--D DOptions/Preferences Data
#-[] Miscellaneous Data — Output Type

=-[0 ANALYSIS RESULTS [0 of 12 tables selected) * RTF File
BSD Joint Dutput  THT File
&0 Element Dutput  TXT File w/o Splits
&-[] Stucture Dutput = HTML File

=-5 DESIGN DATA [3 of 3 tables selected] =
& Steel Frame - Options

EIE Steel Summary Data = Selection Gnly
[ Table: Steel Design 1- Summary Data - 415C360-05/1BC2006 = Firit b Pririter
&-& Steel Detail Data [V Fiint ta File
E Table: Steel Design 2 - PR Detail: - A15C360-05/1BC2006 [ Print Landzcape
B Table: Steel Design 3 - Shear Details - A15C360-05/BC 2008 [~ Filker Criteria
[T Hyperlinked Cantents
—Named Sets
Sawve Named Set... I
Shiow N amed Set..
Delete Mamed Set..

Cancel |
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Figure 5-9 Choice of design tables for saving in a file or printing

The name of the tables are displayed in a tree structure, which can be collapsed
or expanded by clicking on an item in the tree. Click on the small check boxes
preceding the items to select those tables for printing or saving to a file. If a
branch of the tree is selected, all of the tables under that branch are selected.
When all options for printing or saving the data to file have been specified, the
settings can be saved as a Named Set using the Save Named Set button. The
Named Set can be easily recalled in the future, reducing the need to reselect the
options and ensuring that output is consistent from one printing effort to another.

Output of Design Information
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If one or more structural members are selected before the Choose Tables for
Printing form is accessed, the Selection Only check box will be checked, and the
program will save or print the data for the selected members only; uncheck the
check box to save or print the data for all appropriate "unselected" members.

The output can be generated in a variety of formats, including rich text format
(.rft), plain text with and without splits or page breaks (.txt), and hyperlink text
markup language (.htm) by choosing the appropriate option on the right side of
the form.

Printed output can be specified to have a landscaped orientation, in which the
width of the resulting printout on a given page is longer than the height of the
printout.

Filtering criteria can be applied if those criteria were specified using the For-
mat-Filter-Sort menu > Format Table command when the selected data tables
were displayed using the Display menu > Show Tables command in
SAP2000/ETABS and the Home > Display > Show Tables command in
CSiBridge. The output also can be specified to include a hyperlinked contents to
facilitate accessing specific areas of the printout.

There are other buttons on the form that do not affect saving or printing design
information. For example, the Select Load Patterns button affects only sav-
ing/printing model definition data. The Select Load Cases and Modify/Show
Options buttons affect only saving/printing analysis results.

After clicking all the necessary tables for steel frame design and all necessary
options, clicking the OK button will save/print the design tables.

Although the File name > Print Tables command and the Orb > File > Print >
Print Tables command paths are dedicated for saving/printing design infor-
mation, these are not the only paths to do so. Design tables can be saved in
different formats using the Display menu > Show Tables command in
SAP2000/ETABS and the Home > Display > Show Tables command in
CSiBridge.
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5.5  Error Messages and Warnings

Error messages and warnings may be displayed in the steel frame design output.
The messages are numbered. A list of error messages and warnings used in Steel
Frame Design for all the design codes is provide in Appendix F. However, all of
the messages are not applicable to the AISC 360-05/1BC 2006 Code.

5-16  Error Messages and Warnings



Appendix A
P-Delta Effects

Modern design provisions are based on the principle that the member forces are
calculated by a second-order elastic analysis, where the equilibrium is satisfied
on the deformed geometry of the structure. The effects of the loads acting on the
deformed geometry of the structure are known as the second-order or the P-Delta
effects.

The P-Delta effects come from two sources: global lateral translation of the
frame and the local deformation of members within the frame.

Consider the frame object shown in Figure A-1, which is extracted from a story
level of a larger structure. The overall global translation of this frame object is
indicated by 4. The local deformation of the member is shown as s. The total
second order P-Delta effects on this frame object are those caused by both 4
and 6.

The program has an option to consider P-Delta effects in the analysis. When you
consider P-Delta effects in the analysis, the program does a good job of cap-
turing the effect due to the a deformation ( P-4 effect) shown in Figure
B-1, but it does not typically capture the effect of the 5 deformation (P-s
effect), unless, in the model, the frame object is broken into multiple elements
over its length.
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Original position of frame
element shown by vertical

line ’\

'« Final deflected position of the
frame element that includes the

// ' global lateral translation, A, and
» the local deformation of the
Position of frame element

element,

as a result of global lateral

translation, A, shown by
dashed line S

Figure A-1 P-4 and P-s effects

In design codes, required strengths are usually required to be determined using a
second-order analysis that considers both P-4 and P-5 effects. Approximate
second-order analysis procedures based on amplification of responses from
first-order analysis for calculating the required flexural and axial strengths are
common in current design codes and have the following general form:

M.y =BM,, +B,M, (AISC C2-1a)
Pear = Py + B,P, (AISC C2-1b)
where,

Mc.es Popp = Required axial and flexural design capacities

M., P,  =Required axial and flexural capacities from first-order analy-
sis of the member assuming there is no translation of the
frame (i.e., associated with the & deformation in Figure 2-1)

M., P, = Required axial and flexural capacities from first-order analy-

sis of the member as a result of lateral translation of the frame
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only (i.e., associated with the 4 deformation in

Figure A-1)
B, = Unitless amplification factor multiplying M,
B, = Unitless amplification factor multiplying M, B,

Depending on the choice of analysis methods, which is provided by the
ANSI/AISC 360-05 code, a rigorous second order analysis or the amplification
of first order analysis results to estimate the effect of second order effects is
required. The program has the capability of performing both. In the first case, the
required strengths are determined directly from the analysis results without any
amplification factors (i.e., B, and B, are equal to 1). However, these amplifi-

cation factors can always be overwritten by the user on a member-by-member
basis, if desired, using the overwrite option.

To properly capture the P-8 effect in a finite element analysis, each element,
especially column elements, must be broken into multiple finite elements. Alt-
hough a single element per member can capture the P-& effect to some extent, the
program considers that inadequate. For practical reasons, the software internally
divides the column elements into two members. The user must provide addi-
tional subdivisions where a column is expected to have multiple inflection
points.

In general, steel frame design requires consideration of P-Delta effects in the
analysis before the check/design is performed. Although two elements per line
object are generally adequate to capture the P-A effect, it is recommended to use
more than two elements per line object for the cases where both P-A and P-8
effects are to be considered for a member having multiple points of inflection.
However, explicit manual breaking of the member into elements has other
consequences related to member end moments and unbraced segment end mo-
ment. It is recommended that the members be broken internally by the program.
In this way, the member is recognized as one unit, end of the members are
identified properly, and P-A and P-5 effects are captured better.
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Appendix B
Steel Frame Design Preferences

The Steel Frame Design Preferences are basic assignments that apply to all of
the steel frame members. Tables B-1, B-2, and B-3 list Steel Frame Design
Preferences for "AISC 360-05/IBC 2006." Default values are provided for all
preference items. Thus, it is not necessary to specify or change any of the pref-
erences. However, at least review the default values to ensure they are accepta-
ble. Some of the preference items also are available as member specific
overwrite items. The Overwrites are described in Appendix C. Overwritten
values take precedence over the preferences.

Table B-1: Steel Frame Design Preferences

Item Possible Values Default Value Description
Design Code Design codes AISC360-05/  The selected design code. Subsequent design is
available in the IBC 2006 based on this selected code.

current version

Time History Design Envelopes, Envelopes Toggle for design combinations that include a time
Step-by-Step history designed for the envelope of the time history,
or designed step-by-step for the entire time history.
If a single design combination has more than one
time history case in it, that design combination is
designed for the envelopes of the time histories,
regardless of what is specified here.
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Table B-1: Steel Frame Design Preferences

Item Possible Values Default Value Description
Framing Type SMF, IMF, SMF This item is used for ductility considerations in the
OMF, SCBF, design, when seismic provisions are considered.
OCBF, OCBF,
EBF

Seismic Design A/ B ,CD,EF D This item varies with the Seismic Hazard Exposure

Category Group and the Effective Peak Velocity Related
Acceleration.

Design Provision ASD, LRFD LRFD Application provisions for calculation of
allowable/design and required strength of individual
elements. Selection of ASD will enable additional
fields for safety factor overwrites, whereas selection
of LRFD will enable additional fields for resistance
factors.

Analysis Method 7 Values Direct Analysis  Indicates the method used to check/design the steel

Method with members. The design module does not verify the
General 2" Order acceptability of the selected design analysis method;
Analysis and the user is expected to verify acceptability. Also, the
7. Fixed user is expected to set the appropriate stiffness
b modification factors and to supply the combinations
with appropriate notional loads.

Notional Load >0 0.002 The coefficient used to define the notional load as a

Coefficient fraction of a given gravity load pattern.

Ignore Seismic Code? Yes, No No Toggle to consider (No) or not consider (Yes) the
seismic part of the code in design.

Ignore Special Yes, No No Toggle to consider (No) or not consider (Yes)

Seismic Load? special seismic load combinations in design.

Is Doubler Plate Plug Yes, No Yes Toggle to indicate if the doubler-plate is plug welded

Welded? (Yes) or it is not plug welded (No).

HSS Welding Type ERW, SAW ERW Indicates the procedure used for welding the steel
members.

Reduce HSS Yes, No Yes Toggle to consider if the HS (Box or Pipe) thickness

Thickness? is reduced (Yes) or should not be reduced (No).

Consider Yes, No No Toggle to consider the deflection limit (Yes) or to

Deflection? not consider the deflection limit (No).

DL Limit, L/ >0 120 Deflection limit for dead load. Inputting 120 means

that the limit is L/120. Inputting zero means no
check will be made of this item.
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Table B-1: Steel Frame Design Preferences

Item

Possible Values

Default Value

Description

Super DL+LL Limit, LY

>0

120

Deflection limit for superimposed dead plus live
load. Inputting 120 means that the limit is L/120.
Inputting zero means no check will be made of this
item.

Live Load Limit, L/

360

Deflection limit for superimposed live load.
Inputting 360 means that the limit is L/360.
Inputting zero means no check will be made of this
item.

Total Limit, L/

240

Deflection limit for total load. Inputting 240 means
that the limit is L/240. Inputting zero means no
check will be made of this item.

Total-Camber Limit, L/

240

Limit for net deflection. Camber is subtracted from
the total load deflection to get net deflection.
Inputting 240 means that the limit is L/240. Inputting
zero means no check will be made of this item.

Pattern Live Load
Factor

0.75

The live load factor for automatic generation of load
combinations involving pattern live loads and dead
loads.

D/C Ratio Limit

0.95

The demand/capacity ratio limit to be used for
acceptability. D/C ratios that are less than or equal to
this value are considered acceptable. The program
will select members from the auto select list with
D/C ratios less than or equal to this value.

Maximum Number of Auto
Iteration

Sets the number of iterations of the analysis-design
cycle that the program will complete automatically
assuming that the frame members have been
assigned auto select sections. This is currently only
available in ETABS.

Table B-2 Additional Steel Frame Design Preferences LRFD Provision

Item Possible Values Default Value Description
Phi (Bending) <1.0 0.9 Resistance factor for flexure.
Phi (Compression) <1.0 0.9 Resistance factor for compression.
Phi (Tension-Yielding) <1.0 0.9 Resistance factor for yielding in tension.
Phi (Tension-Fracture) <1.0 0.75 Resistance factor for tension rupture.
Phi (Shear) <1.0 0.9 Resistance factor for shear.
Phi (Shear, Short Webbed <10 10 Resistance factor for shear for specific
Rolled I-Shapes) short-webbed rolled I-Shapes.
Phi (Torsion) <1.0 0.9 Resistance factor for torsion.
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Table B-3 Additional Steel Frame Design Preferences for ASD Provision

Item Possible Values Default Value Description
Omega (Bending) >1.0 1.67 Safety factor for flexure.
Omega (Compression) >1.0 1.67 Safety factor for compression.
Omega (Tension-Yielding) >1.0 1.67 Safety factor for yielding in tension.
Omega (Tension-Fracture) >1.0 2.00 Safety factor for tension rupture.
Omega (Shear) >1.0 1.67 Safety factor for shear.
Omega (Shear, Short >1.0 1.50 Safety factor for shear for specific short-webbed
Webbed Rolled I-Shape) rolled 1-Shapes.
Omega (Torsion) >1.0 1.67 Safety factor torsion.
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Appendix C
Steel Frame Design Procedure Overwrites

The structural model may contain frame elements made of several structural
materials: steel, concrete, aluminum, cold-formed steel and other materials.
The program supports separate design procedures for each material type. By
default the program determines the design procedure from the material of the
frame member.

The software allows the user to turn off or turn on design of specific members
by selecting No Design or Default from material. Refer to the program Help for
information about overwriting the design procedure.

Overwrites

The steel frame design Overwrites are basic assignments that apply only to
those elements to which they are assigned. Table C-1 lists Steel Frame Design
Overwrites for "AISC 360-05/IBC 2006." Default values are provided for all
overwrite items. Thus, it is not necessary to specify or change any of the
overwrites. However, at least review the default values to ensure they are
acceptable. When changes are made to overwrite items, the program applies the
changes only to the elements to which they are specifically assigned.
overwritten values take precedence over the preferences (Appendix B).
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Table C-1 Steel Frame Design Overwrites for "AISC 360-05/IBC 2006"

Item Possible Values Default Value Description
Current Design Any defined steel Analvsi : The design section for the selected frame object.
A - ysis section : L f -

Section section When this Overwrite is applied, any previous auto
select section assigned to the frame object is
removed.

Fame Type SMF, IMF, This item is used for ductility considerations in the

OMF, SCBF, From Preferences design.
OCBF, OCBFI,
EBF

Omega O >1.0 Calculated This factor is related to seismic force and ductility.

Consider Yes, No From Preferences Toggle to consider the deflection limit (Yes) or to not

Deflection? consider the deflection limit (No) in design.

Deflection Check Ratio, Both Choose to consider deflection limit as an absolute, as

Type Absolute, a divisor of the beam length, as both, or with no

Both deflection limit.

DL Limit, L/ >0 From Preferences Deflection limit for dead load. Inputting 120 means
that the limit is L/120. Inputting zero means no
check will be made of this item.

Super DL+LL >0 From Preferences Deflection limit for superimposed dead plus live

Limit, L/ load. Inputting 120 means that the limit is L/120.
Inputting zero means no check will be made of this
item.

Live Load Limit, L/ >0 From Preferences Deflection limit for superimposed live load. Inputting
360 means that the limit is L/360. Inputting zero
means no check will be made of this item.

Total Limit, L/ >0 From Preferences Deflection limit for total load. Inputting 240 means
that the limit is L/240. Inputting zero means no check
will be made of this item.

Total-Camber Limit, >0 From Preferences Limit for net deflection. Camber is subtracted from

L/ the total load deflection to get net deflection.
Inputting 240 means that the limit is L/240. Inputting
zero means no check will be made of this item.

DL Limit, abs >0 1. Deflection limit for dead load. Inputting zero means
no check will be made of this item.

Super DL+LL Limit, >0 1. Deflection limit for superimposed dead plus live

abs load. Inputting zero means no check will be made of
this item.

Live Load Limit, abs >0 1. Deflection limit for superimposed live load. Inputting
zero means no check will be made of this item.

Total Limit, abs >0 1. Deflection limit for total load. Inputting zero means

no check will be made of this item.
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Table C-1 Steel Frame Design Overwrites for "AISC 360-05/IBC 2006"

Item

Possible Values

Default Value

Description

Total-Camber Limit,
abs

>0

1.

Deflection limit for net deflection. Camber is
subtracted from the total load deflection to get net
deflection. Inputting a value of 240 means that the
limit is L/240. Inputting zero means no check will be
made of this item.

Specified Camber

The specified amount of camber to be reported in the
design output and to be used in the net deflection
check.

Live Load Reduction
Factor

Calculated

The reducible live load is multiplied by this factor to
obtain the reduced live load for the frame object.
Specifying zero means the value is program
determined.

Net Area to Total
Area Ratio

1.0

The ratio of the net area at the end joint to gross
cross-sectional area of the section. This ratio affects
the design of axial tension members. Specifying zero
means the value is the program default, which is 1.

Unbraced Length
Ratio (Major)

Calculated

Unbraced length factor for buckling about the frame
object major axis; specified as a fraction of the frame
object length. This factor times the frame object
length gives the unbraced length for the object.
Specifying zero means the value is program
determined.

Unbraced Length
Ratio (Minor)

Calculated

Unbraced length factor for buckling about the frame
object minor axis; specified as a fraction of the frame
object length. This factor times the frame object
length gives the unbraced length for the object.
Specifying zero means the value is program
determined.

Unbraced Length
Ratio (LTB)

L22

Unbraced length factor for lateral-torsional buckling
for the frame object; specified as a fraction of the
frame object length. This factor times the frame
object length gives the unbraced length for the
object. Specifying zero means the value is program
determined.

Effective Length
Factor (K1 Major)

1.0

Effective length factor for buckling about the frame
object major axis; specified as a fraction of the frame
object length. This factor times the frame object
length gives the effective length for the object.
Specifying zero means the value is program
determined. For beam design, this factor is always
taken as 1, regardless of any other value specified in
the Overwrites. This factor is used for the B, factor.
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Table C-1 Steel Frame Design Overwrites for "AISC 360-05/IBC 2006"

Item

Possible Values

Default Value

Description

Effective Length
Factor (K1 Minor)

>0

1.0

Effective length factor for buckling about the frame
object minor axis; specified as a fraction of the frame
object length. This factor times the frame object
length gives the effective length for the object.
Specifying zero means the value is program
determined. For beam design, this factor is always
taken as 1, regardless of any other value specified in
the Overwrites. This factor is used for the B, factor.

Effective Length
Factor (K2 Major)

Calculated

Effective length factor for buckling about the frame
object major axis assuming that the frame is braced
at the joints against sidewsway; specified as a
fraction of the frame object length. This factor times
the frame object length gives the effective length for
the object. Specifying zero means the value is
program determined. For beam design, this factor is
always 1, regardless of any other values specified in
the Overwrites. The factor is used for axial
compression capacity.

Effective Length
Factor (K2 Minor)

Calculated

Effective length factor for buckling about the frame
object minor axis assuming that the frame is braced
at the joints against sidewsway; specified as a
fraction of the frame object length. This factor times
the frame object length gives the effective length for
the object. Specifying zero means the value is
program determined. For beam design, this factor is
always 1, regardless of any other values specified in
the Overwrites. The factor is used for axial
compression capacity.

Effective Length
Factor (K LTB)

K2 minor

Effective length factor for lateral-torsional buckling;
specified as a fraction of the frame object length.
This factor times the frame object length gives the
effective length for the object. Specifying zero means
the value is program determined. For beam design,
this factor is taken as 1 by default. The values should
be set by the user.

Moment Coefficient
(Cm Major)

Calculated

Unitless factor; Cm for major axis bending is used in
determining the interaction ratio. Inputting zero
means the value is program determined.

Moment Coefficient
(Cm Minor)

Calculated

Unitless factor; Cm for minor axis bending is used in
determining the interaction ratio. Inputting zero
means the value is program determined.

Bending Coefficient
(Cb)

Calculated

Unitless factor; Cb is used in determining the
interaction ratio. Inputting zero means the value is
program determined.

NonSway Moment
Factor (B1 Major)

Calculated

Unitless moment magnification factor for non-sway
major axis bending moment. Specifying zero means
the value is program determined.

NonSway Moment
Factor (B1 Minor)

Calculated

Unitless moment magnification factor for non-sway
minor axis bending moment. Specifying zero means
the value is program determined.
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Table C-1 Steel Frame Design Overwrites for "AISC 360-05/IBC 2006"

Item

Possible Values

Default Value

Description

Sway Moment

Unitless moment magnification factor for sway

Factor (B2 Major) =0 10 major-axis bending moment. Specifying zero means
the value is program determined. The program
determined value is taken as 1 because it is assumed
that P-Delta effects were specified to be included in
the analysis, and thus no further magnification is
required.

Sway Moment >0 10 Unitless moment magnification factor for sway

Factor (B2 Minor) ' major-axis bending moment. Specifying zero means
the value is program determined. The program
determined value is taken as 1 because it is assumed
that P-Delta effects were specified to be included in
the analysis, and thus no further magnification is
required.

HSS Welding Type ERW, SAW From Preferences Indicates the procedure used to check/design the steel
members.

Reduce HES Yes, No From Preferences Toggle to consider if the HS (Box or Pipe) thickness

Thickness’ is reduced (Yes) or should not be reduced (No).

Yield Stress, Fy >0 From Material Material yield strength used in the design/check.

- Specifying zero means the value is program
determined. The program determined value is taken
from the material property assigned to the frame
object.

Overstrength . The ratio of the expected yield strength to the

Factory, Ry =0 From Material minimum specified yield strength. This ratio is used
in capacity-based design for special seismic cases.
Specifying zero means the value is program
determined.

Compressive >0 Calculated Nominal axial compressive capacity. Specifying

Capacity, Pnc - zero means the value is program determined.

Tensile Capacity, >0 Calculated Nominal axial tensile capacity. Specifying zero

Pnt - means the value is program determined.

Major_Bending >0 Calculated Nom_inal bend_ing_ moment capacity in majc_>r axis

Capacity, Mn3 - bending. Specifying zero means the value is program
determined.

Minor Bending >0 Calculated Nominal bending moment capacity in minor axis

Capacity, Mn2 = bending. Specifying zero means the value is program
determined.

Major Shear >0 Calculated Nominal shear capacity force for major direction

Capacity, Vn2 - shear. Specifying zero means the value is program
determined.

Minor Shear >0 Calculated Nominal shear capacity force for minor direction

Capacity, Vn3

shear. Specifying zero means the value is program
determined.
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Table C-1 Steel Frame Design Overwrites for "AISC 360-05/IBC 2006"

Item

Possible Values

Default Value

Description

D/C Ratio Limit

>0

Calculated

The demand/capacity ratio limit to be used for
acceptability. D/C ratios that are less than or equal to
this value are considered acceptable. Specifying zero
means the value is program determined.
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Appendix D
Interactive Steel Frame Design

The Interactive Steel Frame Design command is a powerful mode that allows
the user to review the design results for any steel frame design and
interactively revise the design assumptions and immediately review the revised
results.

Note that a design must have been run for the interactive design mode to be
available. With the design results displayed, right click on a frame object to
display the Steel Stress Check Information form for the member. Click on the
Overwrites button to display the Design Overwrites form, where the member
section or other design parameters may be changed. Clicking OK on this form
results in an immediate updating of the results displayed on the Steel Stress
Check Information form.
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Appendix E
Analysis Sections vs. Design Sections

Analysis sections are those section properties used to analyze the model when
an analysis is run (refer to the program Help for information about running an
analysis). The design section is whatever section is used in the steel frame
design. It is possible for the last used analysis section and the current design
section to be different. For example, an analysis may be run using a W18X35
beam, and then in the design, it may be found that a W16X31 beam worked. In
that case, the last used analysis section is the W18X35 and the current design
section is the W16X31. Before the design process is complete, verify that the
last used analysis section and the current design section are the same. Refer to
the program Help for information about completing this task.

The program keeps track of the analysis section and the design section
separately. Note the following about analysis and design sections:

= Assigning a frame section property assigns the section as both the analysis
section and the design section.

»= Running an analysis always sets the analysis section to be the same as the
current design section.

= Assigning an Auto Select section list to a frame object initially sets the
analysis and design section to be the section in the list with the median
weight.
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Appendix E - 2

Unlocking a model deletes the design results, but it does not delete or
change the design section.

Altering the Design Combinations in any way deletes the design results,
but does not delete or change the design section.

Altering any of the steel frame design preferences deletes the design
results, but does not delete or change the design section.



Appendix F
Error and Warning Messages

This appendix provides all the possible error message that can be offered by the
Steel Frame Design model of the program. Some of these messages are relevant
to the "AISC 360-05/IBC 2006" design code. Others are relevant to the other
design codes supported by the program. However, the entire list is presented
here for completeness.

Error Description
Number
1 kl/r > 200
2 I/r > 300
3 P > Pe
4 P > 0.85Py
5 P .075Py
6 1/r > 720/sqrt(Fy)
7 1> 96ry
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Error Description
Number
8 h/tw > 380/sqrt(Fy)
9 Section is slender
10 Section is Class 4
11 Section is not plastic
12 Pu > Pe(B1 is undefined)
13 Cf > Ce (U1 is undefined)
14 bf/2tf > 52/sqrt(Fy)
15 1u > 76bf/sqrt(Fy)
16 fe > Fe
17 I/r > 180
18 I/r > 250
19 1/r>120
20 Iir > 140
21 Pu > Phi * Pe (Delta b is undefined)
22 N/C (Not Calculated)
23 Internal Program Error
24 Section is too slender
25 1/r > 1000/sqrt (Fy)
26 Story drift too high
27 bf/2tf > 52/sqrt (Fy)
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Error

Number Description
28 b/t > 100/Sqrt (Fy)
29 d/t > 1300/Fy
30 b/t > 52/sqrt (Fy)
31 Section is not compact
32 tz < (dz+wz)/90
33 b/t > 100/Sqrt (Fy)
34 1/r > 2500/Fy
35 Fy > 50 ksi
36 Link is too long
37 Section is not seismically compact
38 Phi factor less than or equal to zero
39 lo/f > 150*Sqrt (235/fy)
40 lo/f > 300*Sqrt (235/fy)
41 lo/f > 200*Sqrt (235/fy)
42 lo/f > 150*Sqrt (235/fy)
43 lo/f > 120*Sqrt (235/fy)
44 lo/f > 100*Sqrt (235/fy)
45 lo/f > 90*Sqrt (235/fy)
46 lo/f > 80*Sqrt (235/fy)
a7 lo/f > 60*Sqrt (235/fy)
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Error Description
Number
48 tz < (dz+wz)/70
49 1/r >60
50 1/r > 0.086*ry*E/Fy
51 klfr > 4.23*Sqr(e/Ey
52 Link Rotaion is too high
53 Phib factor less than or equal to zero
54 Lambda_y > 120*sqrt(235/fy): Phib is no longer correct
55 0.8 N/Ney > .0 : Column is unstable
56 Beam/Column capacity ratio exceeds limit
57 Capacity ratio exceeds limit
58 Section is seismically slender &
59 tz < (dz+wz)/90
60 Beam/column capacity ratio exceed limit
61 Section is slender
62 Section is unknown
63 Section is not supported for design
64 Section is too slender — Effective area negative
65 Section is too slender — Effective Moment of inertia negative
66 Section is too slender — D/t high
67 kl/r > 150
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Error

Number Description
68 kl/r > 250
69 I/r > 500
70 Unequal legs
71 Nue * N > Ncr
72 1/r > 5.87*ry*E/Fy
73 kl/r > 180 (1S 3.7, Table 3.1)
74 klfr > 250 (1S 3.7, Table 3.1)
75 I/r > 400 (1S 3.7, Table 3.1)
76 Signha_ac, cal > 0.6*fcc (Excessive amplification) (1S 7.1.1)
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